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Preface

IBM® SPSS® Modeler is the IBM Corp. enterprise-strength data mining workbench. SPSS
Modeler helps organizations to improve customer and citizen relationships through an in-depth
understanding of data. Organizations use the insight gained from SPSS Modeler to retain
profitable customers, identify cross-selling opportunities, attract new customers, detect fraud,
reduce risk, and improve government service delivery.

SPSS Modeler’s visual interface invites users to apply their specific business expertise, which
leads to more powerful predictive models and shortens time-to-solution. SPSS Modeler offers
many modeling techniques, such as prediction, classification, segmentation, and association
detection algorithms. Once models are created, IBM® SPSS® Modeler Solution Publisher
enables their delivery enterprise-wide to decision makers or to a database.

About IBM Business Analytics

IBM Business Analytics software delivers complete, consistent and accurate information that
decision-makers trust to improve business performance. A comprehensive portfolio of
intelligenced, predictive analytics, financial performance and strategy management, and [analytic
applications provides clear, immediate and actionable insights into current performance and the
ability to predict future outcomes. Combined with rich industry solutions, proven practices and
professional services, organizations of every size can drive the highest productivity, confidently
automate decisions and deliver better results.

As part of this portfolio, IBM SPSS Predictive Analytics software helps organizations predict
future events and proactively act upon that insight to drive better business outcomes. Commercial,
government and academic customers worldwide rely on IBM SPSS technology as a competitive
advantage in attracting, retaining and growing customers, while reducing fraud and mitigating
risk. By incorporating IBM SPSS software into their daily operations, organizations become
predictive enterprises — able to direct and automate decisions to meet business goals and achieve
measurable competitive advantage. For further information or to reach a representative visit
http://www.ibm.com/spss.

Technical support

Technical support is available to maintenance customers. Customers may contact Technical
Support for assistance in using IBM Corp. products or for installation help for one of the
supported hardware environments. To reach Technical Support, see the IBM Corp. web site
at attp://www.ibm.com/suppori. Be prepared to identify yourself, your organization, and your
support agreement when requesting assistance.
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Chapter

About IBM SPSS Modeler

IBM® SPSS® Modeler is a set of data mining tools that enable you to quickly develop predictive
models using business expertise and deploy them into business operations to improve decision
making. Designed around the industry-standard CRISP-DM model, SPSS Modeler supports the
entire data mining process, from data to better business results.

SPSS Modeler offers a variety of modeling methods taken from machine learning, artificial
intelligence, and statistics. The methods available on the Modeling palette allow you to derive
new information from your data and to develop predictive models. Each method has certain
strengths and is best suited for particular types of problems.

SPSS Modeler can be purchased as a standalone product, or used as a client in
combination with SPSS Modeler Server. A number of additional options are also
available, as summarized in the following sections. For more information, see
http://www.ibm.com/software/analytics/spss/products/modeler/.

IBM SPSS Modeler Products

The IBM® SPSS® Modeler family of products and associated software comprises the following.
IBM SPSS Modeler

IBM SPSS Modeler Server

IBM SPSS Modeler Administration Console

IBM SPSS Modeler Batch

IBM SPSS Modeler Solution Publisher

IBM SPSS Modeler Server adapters for IBM SPSS Collaboration and Deployment Services

IBM SPSS Modeler

SPSS Modeler is a functionally complete version of the product that you install and run on your
personal computer. You can run SPSS Modeler in local mode as a standalone product, or use it
in distributed mode along with IBM® SPSS® Modeler Server for improved performance on
large data sets.

With SPSS Modeler, you can build accurate predictive models quickly and intuitively, without
programming. Using the unique visual interface, you can easily visualize the data mining process.
With the support of the advanced analytics embedded in the product, you can discover previously
hidden patterns and trends in your data. You can model outcomes and understand the factors that
influence them, enabling you to take advantage of business opportunities and mitigate risks.

SPSS Modeler is available in two editions: SPSS Modeler Professional and SPSS Modeler
Premium. For more information, see the topic IBM SPSS Modeler Editions on p. [3|.

© Copyright IBM Corporation 1994, 2012. 1
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IBM SPSS Modeler Server

SPSS Modeler uses a client/server architecture to distribute requests for resource-intensive
operations to powerful server software, resulting in faster performance on larger data sets.

SPSS Modeler Server is a separately-licensed product that runs continually in distributed analysis
mode on a server host in conjunction with one or more IBM® SPSS® Modeler installations.

In this way, SPSS Modeler Server provides superior performance on large data sets because
memory-intensive operations can be done on the server without downloading data to the client
computer. IBM® SPSS® Modeler Server also provides support for SQL optimization and
in-database modeling capabilities, delivering further benefits in performance and automation.

IBM SPSS Modeler Administration Console

The Modeler Administration Console is a graphical application for managing many of the SPSS
Modeler Server configuration options, which are also configurable by means of an options file.
The application provides a console user interface to monitor and configure your SPSS Modeler
Server installations, and is available free-of-charge to current SPSS Modeler Server customers.
The application can be installed only on Windows computers; however, it can administer a server
installed on any supported platform.

IBM SPSS Modeler Batch

While data mining is usually an interactive process, it is also possible to run SPSS Modeler

from a command line, without the need for the graphical user interface. For example, you might
have long-running or repetitive tasks that you want to perform with no user intervention. SPSS
Modeler Batch is a special version of the product that provides support for the complete analytical
capabilities of SPSS Modeler without access to the regular user interface. An SPSS Modeler
Server license is required to use SPSS Modeler Batch.

IBM SPSS Modeler Solution Publisher

SPSS Modeler Solution Publisher is a tool that enables you to create a packaged version of an
SPSS Modeler stream that can be run by an external runtime engine or embedded in an external
application. In this way, you can publish and deploy complete SPSS Modeler streams for use in
environments that do not have SPSS Modeler installed. SPSS Modeler Solution Publisher is
distributed as part of the IBM SPSS Collaboration and Deployment Services - Scoring service,
for which a separate license is required. With this license, you receive SPSS Modeler Solution
Publisher Runtime, which enables you to execute the published streams.

IBM SPSS Modeler Server Adapters for IBM SPSS Collaboration and Deployment

Services

A number of adapters for IBM® SPSS® Collaboration and Deployment Services are available that
enable SPSS Modeler and SPSS Modeler Server to interact with an IBM SPSS Collaboration and
Deployment Services repository. In this way, an SPSS Modeler stream deployed to the repository
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can be shared by multiple users, or accessed from the thin-client application IBM SPSS Modeler
Advantage. You install the adapter on the system that hosts the repository.

IBM SPSS Modeler Editions

SPSS Modeler is available in the following editions.

SPSS Modeler Professional

SPSS Modeler Professional provides all the tools you need to work with most types of structured
data, such as behaviors and interactions tracked in CRM systems, demographics, purchasing
behavior and sales data.

SPSS Modeler Premium

SPSS Modeler Premium is a separately-licensed product that extends SPSS Modeler Professional
to work with specialized data such as that used for entity analytics or social networking, and with
unstructured text data. SPSS Modeler Premium comprises the following components.

IBM® SPSS® Modeler Entity Analytics adds a completely new dimension to IBM® SPSS®
Modeler predictive analytics. Whereas predictive analytics attempts to predict future behavior
from past data, entity analytics focuses on improving the coherence and consistency of current
data by resolving identity conflicts within the records themselves. An identity can be that of an
individual, an organization, an object, or any other entity for which ambiguity might exist. Identity
resolution can be vital in a number of fields, including customer relationship management, fraud
detection, anti-money laundering, and national and international security.

IBM SPSS Modeler Social Network Analysis transforms information about relationships into
fields that characterize the social behavior of individuals and groups. Using data describing

the relationships underlying social networks, IBM® SPSS® Modeler Social Network Analysis
identifies social leaders who influence the behavior of others in the network. In addition, you can
determine which people are most affected by other network participants. By combining these
results with other measures, you can create comprehensive profiles of individuals on which to
base your predictive models. Models that include this social information will perform better than
models that do not.

IBM® SPSS® Modeler Text Analytics uses advanced linguistic technologies and Natural
Language Processing (NLP) to rapidly process a large variety of unstructured text data, extract
and organize the key concepts, and group these concepts into categories. Extracted concepts and
categories can be combined with existing structured data, such as demographics, and applied to
modeling using the full suite of SPSS Modeler data mining tools to yield better and more focused
decisions.
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IBM SPSS Modeler Documentation

Documentation in online help format is available from the Help menu of SPSS Modeler. This
includes documentation for SPSS Modeler, SPSS Modeler Server, and SPSS Modeler Solution
Publisher, as well as the Applications Guide and other supporting materials.

Complete documentation for each product (including installation instructions) is available in PDF
format under the \Documentation folder on each product DVD. Installation documents can also be
downloaded from the web at http://www-01.ibm.com/support/docview.wss ?uid=swg27023172|.

Documentation in both formats is also available from the SPSS Modeler Information Center at

http://publib.boulder.ibm.com/infocenter/spssmodl/v15rOm0/.

SPSS Modeler Professional Documentation

The SPSS Modeler Professional documentation suite (excluding installation instructions) is
as follows.

IBM SPSS Modeler User's Guide. General introduction to using SPSS Modeler, including how
to build data streams, handle missing values, build CLEM expressions, work with projects and
reports, and package streams for deployment to IBM SPSS Collaboration and Deployment
Services, Predictive Applications, or IBM SPSS Modeler Advantage.

IBM SPSS Modeler Source, Process, and Output Nodes. Descriptions of all the nodes used to
read, process, and output data in different formats. Effectively this means all nodes other
than modeling nodes.

IBM SPSS Modeler Modeling Nodes. Descriptions of all the nodes used to create data mining
models. IBM® SPSS® Modeler offers a variety of modeling methods taken from machine
learning, artificial intelligence, and statistics. For more information, see the topic
of Modeling Nodes in Chapter 3 on p. 24.

IBM SPSS Modeler Algorithms Guide. Descriptions of the mathematical foundations of the
modeling methods used in SPSS Modeler. This guide is available in PDF format only.

IBM SPSS Modeler Applications Guide. The examples in this guide provide brief, targeted
introductions to specific modeling methods and techniques. An online version of this guide
is also available from the Help menu. For more information, see the topic
IBM SPSS Modeler Scripting and Automation. Information on automating the system through
scripting, including the properties that can be used to manipulate nodes and streams.

IBM SPSS Modeler Deployment Guide. Information on running SPSS Modeler streams and
scenarios as steps in processing jobs under IBM® SPSS® Collaboration and Deployment
Services Deployment Manager.

IBM SPSS Modeler CLEF Developer’s Guide. CLEF provides the ability to integrate third-party
programs such as data processing routines or modeling algorithms as nodes in SPSS Modeler.

IBM SPSS Modeler In-Database Mining Guide. Information on how to use the power of your
database to improve performance and extend the range of analytical capabilities through
third-party algorithms.
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m IBM SPSS Modeler Server Administration and Performance Guide. Information on how to
configure and administer IBM® SPSS® Modeler Server.

m |BM SPSS Modeler Administration Console User Guide. Information on installing and using the
console user interface for monitoring and configuring SPSS Modeler Server. The console is
implemented as a plug-in to the Deployment Manager application.

m  IBM SPSS Modeler Solution Publisher Guide. SPSS Modeler Solution Publisher is an add-on
component that enables organizations to publish streams for use outside of the standard
SPSS Modeler environment.

m |BM SPSS Modeler CRISP-DM Guide. Step-by-step guide to using the CRISP-DM methodology
for data mining with SPSS Modeler.

m [BM SPSS Modeler Batch User’s Guide. Complete guide to using IBM SPSS Modeler in batch
mode, including details of batch mode execution and command-line arguments. This guide
is available in PDF format only.

SPSS Modeler Premium Documentation

The SPSS Modeler Premium documentation suite (excluding installation instructions) is as
follows.

m  [BM SPSS Modeler Entity Analytics User Guide. Information on using entity analytics with
SPSS Modeler, covering repository installation and configuration, entity analytics nodes,
and administrative tasks.

m [BM SPSS Modeler Social Network Analysis User Guide. A guide to performing social network
analysis with SPSS Modeler, including group analysis and diffusion analysis.

m  SPSS Modeler Text Analytics User's Guide. Information on using text analytics with SPSS
Modeler, covering the text mining nodes, interactive workbench, templates, and other
resources.

m |IBM SPSS Modeler Text Analytics Administration Console User Guide. Information on installing
and using the console user interface for monitoring and configuring IBM® SPSS® Modeler
Server for use with SPSS Modeler Text Analytics . The console is implemented as a plug-in
to the Deployment Manager application.

Application Examples

While the data mining tools in SPSS Modeler can help solve a wide variety of business and
organizational problems, the application examples provide brief, targeted introductions to specific
modeling methods and techniques. The data sets used here are much smaller than the enormous
data stores managed by some data miners, but the concepts and methods involved should be
scalable to real-world applications.

You can access the examples by clicking Application Examples on the Help menu in SPSS
Modeler. The data files and sample streams are installed in the Demos folder under the product
installation directory. For more information, see the topic Demos Folder on p. 6.

Database modeling examples. See the examples in the IBM SPSS Modeler In-Database Mining
Guide.
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Scripting examples. See the examples in the IBM SPSS Modeler Scripting and Automation Guide.

Demos Folder

The data files and sample streams used with the application examples are installed in the Demos
folder under the product installation directory. This folder can also be accessed from the IBM
SPSS Modeler 15 program group on the Windows Start menu, or by clicking Demos on the list of
recent directories in the File Open dialog box.

Figure 1-1
Selecting the Demos folder from the list of recently-used directories

W7 Open &
Lok In: ||_‘|IEIMMOdeIer14.1 n | m o]

‘:) Installation Directany
S Accessibility \) TEREs
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Chapter

Introduction to Modeling

A model is a set of rules, formulas, or equations that can be used to predict an outcome based
on a set of input fields or variables. For example, a financial institution might use a model to
predict whether loan applicants are likely to be good or bad risks, based on information that is
already known about past applicants.

The ability to predict an outcome is the central goal of predictive analytics, and understanding the
modeling process is the key to using IBM® SPSS® Modeler.

Figure 2-1
A simple decision tree model
Credit rating
Mode 0 :
Category % n |
Bad 40944 703

I® Good  59.056 1014
] Total 100.000 1717 ;
“““““““ [T

Inzome level
Adj. P-value=0.000, Chi-square=481 138, di=2

High LD|W Medium
Mode 1 Mode 2 Mode 2
Category. % il Category % n Category . % n
Bad 10,969 &GO Bad 83.378 3N Bad 41,696 332
B Good 89.031 487 B Good 16622 G2 B Good 58.344 4B5
Tatal 31.858 547 Tatal 21724 373 Tatal 46418 7497
T T— T T—

This example uses a decision tree model, which classifies records (and predicts a response)
using a series of decision rules, for example:

IFincome = Medium
AND cards <b
THEN -> 'Good'

While this example uses a CHAID (Chi-squared Automatic Interaction Detection) model, it is
intended as a general introduction, and most of the concepts apply broadly to other modeling
types in SPSS Modeler.

To understand any model, you first need to understand the data that go into it. The data in this
example contain information about the customers of a bank. The following fields are used:

Field name Description

Credit_rating Credit rating: 0=Bad, 1=Good,
9=missing values

Age Age in years

© Copyright IBM Corporation 1994, 2012. 7
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Field name Description

Income Income level: 1=Low, 2=Medium,
3=High

Credit_cards Number of credit cards held: 1=Less
than five, 2=Five or more

Education Level of education: 1=High school,
2=College

Car_loans Number of car loans taken out:

1=None or one, 2=More than two

The bank maintains a database of historical information on customers who have taken out loans
with the bank, including whether or not they repaid the loans (Credit rating = Good) or defaulted
(Credit rating = Bad). Using this existing data, the bank wants to build a model that will enable
them to predict how likely future loan applicants are to default on the loan.

Using a decision tree model, you can analyze the characteristics of the two groups of customers
and predict the likelihood of loan defaults.

This example uses the stream named modelingintro.str, available in the Demos folder under the
streams subfolder. The data file is tree_credit.sav. For more information, see the topic [Demos

in Chapter 1 on p. 0|
Let’s take a look at the stream.

Choose the following from the main menu:
File > Open Stream

Click the gold nugget icon on the toolbar of the Open dialog box and choose the Demos folder.
Double-click the streams folder.

Double-click the file named modelingintro.str.
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Building the Stream

Figure 2-2
Modeling stream

tree_creditsay Type Creditrating

Tahle

Os

Analysis

To build a stream that will create a model, we need at least three elements:

B A source node that reads in data from some external source, in this case an IBM® SPSS®
Statistics data file.

® A source or Type node that specifies field properties, such as measurement level (the type of
data that the field contains), and the role of each field as a target or input in modeling.

B A modeling node that generates a model nugget when the stream is run.

In this example, we’re using a CHAID modeling node. CHAID, or Chi-squared Automatic
Interaction Detection, is a classification method that builds decision trees by using a particular
type of statistics known as chi-square statistics to work out the best places to make the splits
in the decision tree.

If measurement levels are specified in the source node, the separate Type node can be eliminated.
Functionally, the result is the same.

This stream also has Table and Analysis nodes that will be used to view the scoring results after
the model nugget has been created and added to the stream.
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The Statistics File source node reads data in SPSS Statistics format from the tree_credit.sav data
file, which is installed in the Demos folder. (A special variable named $CLEO_DEMOS is used to
reference this folder under the current IBM® SPSS® Modeler installation. This ensures the path
will be valid regardless of the current installation folder or version.)

Figure 2-3
Reading data with a Statistics File source node

O tree_credit.sav

A | B preview | | 2] Refresh
(=) ..:IH 2

FCLEQ _DEMOStres_credt.say

. Fitter | Types = Annotations
Import file;  [FCLEC_DEMOSiree_credit.say Q

Wariable names: Read names and labels @ Read labels as names

Walues: Fead data and lshels @ Read labels as data

|:| Use field format information to determine storage

Cancel Apply Reset

The Type node specifies the measurement level for each field. The measurement level is a

category that indicates the type of data in the field. Our source data file uses three different
measurement levels.
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A Continuous field (such as the Age field) contains continuous numeric values, while a Nominal
field (such as the Credit rating field) has two or more distinct values, for example Bad, Good, or
No credit history. An Ordinal field (such as the Income level field) describes data with multiple
distinct values that have an inherent order—in this case Low, Medium and High.

Figure 2-4

Setting the target and input fields with the Type node

(J Type
=

Types || Format | Annotations

[ h Read Yalues I Clear Yalues I Clear All Yalues ]

Field Measurement Valles Mis=ing Check Rale
@ Credit rating &5 Momiral Ead, Zood. .. * Mone @ Target
& e & Continuous [20.00269... Mane ™ Inpt
@ Income lewvel ;[I ordinal High Lo . Mone A" Inpat
@ Mumber of .. &5 Mamiral "Lesstha. . Mone A" Inpat
@ Edlucation &5 Mamiral "High =ch... Mone A" Inpat
@ Car loans &5 Mamiral "Mone ar .. Mone A" Inpat

@ iew current fields  © Wisw unused field settings

=

For each field, the Type node also specifies a role, to indicate the part that each field plays in
modeling. The role is set to Target for the field Credit rating, which is the field that indicates
whether or not a given customer defaulted on the loan. This is the target, or the field for which we
want to predict the value.

Role is set to Input for the other fields. Input fields are sometimes known as predictors, or fields
whose values are used by the modeling algorithm to predict the value of the target field.

The CHAID modeling node generates the model.

On the Fields tab in the modeling node, the option Use predefined roles is selected, which means

the target and inputs will be used as specified in the Type node. We could change the field roles
at this point, but for this example we’ll use them as they are.
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» Click the Build Options tab.

Figure 2-5
CHAID modeling node, Fields tab
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Analysis Veight:
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Lok [ mun] { carea] =

Here there are several options where we could specify the kind of model we want to build.

We want a brand-new model, so we’ll use the default option Build new model.

We also just want a single, standard decision tree model without any enhancements, so we’ll also
leave the default objective option Build a single tree.



13

Introduction to Modeling

While we can optionally launch an interactive modeling session that allows us to fine-tune the
model, this example simply generates a model using the default mode setting Generate model.

Figure 2-6
CHAID modeling node, Build Options tab

O Creditrating

£

Ohbjective: Standard mocdel

Figldz || Build Options || Madel Options | &nnotations

Select an tem:

Objective What do wou want to do?
Basics @ -

Stapping Rules What is your main ohjective?

Costs @) Build & zingle tree
Enzembles Single Tree
Acvanced Mode: (8 Generate model Launch interactive session

Enhance model accuracy (boosting)
Enhance model stabilty (bagaing)
Create a model for very large detasets (requires Server)

Description

Creates a single, standard model to explain relationships between fields. Standard models are
easier to interpret and can be faster to score than boosted, bagged, or large dataset
enzembles.

Lo ) () )

For this example, we want to keep the tree fairly simple, so we’ll limit the tree growth by raising
the minimum number of cases for parent and child nodes.

On the Build Options tab, select Stopping Rules from the navigator pane on the left.
Select the Use absolute value option.

Set Minimum records in parent branch to 400.
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» Set Minimum records in child branch to 200.

Figure 2-7
Setting the stopping criteria for decision tree building

Q Creditrating w

o @l

bbjec:tive: Standard mockel |

u Ewiildd Options MH
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dinimur records in child branch:

ok J (B mun] { canea ==

We can use all the other default options for this example, so click Run to create the model.
(Alternatively, right-click on the node and choose Run from the context menu, or select the node
and choose Run from the Tools menu.)
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Browsing the Model

When execution completes, the model nugget is added to the Models palette in the upper right
corner of the application window, and is also placed on the stream canvas with a link to the
modeling node from which it was created. To view the model details, right-click on the model
nugget and choose Browse (on the models palette) or Edit (on the canvas).

Figure 2-8
Models palette

Streams | Outputs | Models

Add To Stream »mf
Erowse % it rating
Rename and Annotate

@ Generate Modeling Mode
Save Model
Save hModel Az

% Store Model...
Export L. E—
Acld to Project

< Delete Delete

In the case of the CHAID nugget, the Model tab displays the details in the form of a rule

set—essentially a series of rules that can be used to assign individual records to child nodes
based on the values of different input fields.

Figure 2-9
CHAID model nugget, rule set

O Credit rating

ﬂfb L; File #_') Generate dgiew
cwa.'u!(

Model  wieweer  Summary  Settings  Annotstions

et Gz ) (o) [ [

E- Incorme level in ["High" | [Mode: Good |
. Murmber of credit cards in ["Less than 5] [Mode: Good] = Good
- Murmber of credit cards in ["5 or more” ] [Mode: Good ] = Good
= Incorme level in ["Low® | [Mode: Bad] = Bad
E- Income level in ["Medium"] [Mode: Good ]
murmber of credit cards in ["Less than 8" ] [Mode: Good ] = Good
e Number of credit cards in ["S ormore"] [Mode: Bad] =+ Bad

-

For each decision tree terminal node—meaning those tree nodes that are not split further—a
prediction of Good or Bad is returned. In each case the prediction is determined by the mode, or
most common response, for records that fall within that node.
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To the right of the rule set, the Model tab displays the Predictor Importance chart, which shows
the relative importance of each predictor in estimating the model. From this we can see that

Income level is easily the most significant in this case, and that the only other significant factor
is Number of credit cards.

Figure 2-10
Predictor Importance chart

i g & 1.

Predictor Importance

Target: Credit rating

Mumber of_|
credit cards
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f
Least Important |
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The Viewer tab in the model nugget displays the same model in the form of a tree, with a node
at each decision point. Use the Zoom controls on the toolbar to zoom in on a specific node or
zoom out to see the more of the tree.

Figure 2-11
Viewer tab in the model nugget, with zoom out selected

O Credit rating

|:.. File: @ Generate Jgiew

CHAID

Model | Wiewer | Summary | Settings | Annotations

S EEE AEx B
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Category % n Category % n Category % n
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= Good 39.031 467 = Good 16622 62 = Good 55,344 465
Total 31.868 647 Total 1724 373 Total 46418 707
= | =
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Adj. P-walue=0.000, Chi-square=28 636, df=1 Adj. P-walue=0.000, Chi-square=129.197, df=1
Less than & 5 or more Less than & Sor ||'none
Node 4 Hode 5 Hode 6 Hode 7
Category % n Category % n Category % n Category % n
Bad 2.597 ] Bad 17 020 54 Bad 14234 0 Bad S6.023 193
B Good a7 402 225 B Good 82 011 I62 B Good 85 766 235 B Good 43.977 T30
Total 13454 231 Total 18 404 316 Total 15958 274 Total 30460 523

Looking at the upper part of the tree, the first node (Node 0) gives us a summary for all the records
in the data set. Just over 40% of the cases in the data set are classified as a bad risk. This is quite a
high proportion, so let’s see if the tree can give us any clues as to what factors might be responsible.

We can see that the first split is by Income level. Records where the income level is in the Low
category are assigned to Node 2, and it’s no surprise to see that this category contains the highest
percentage of loan defaulters. Clearly lending to customers in this category carries a high risk.

However, 16% of the customers in this category actually didn’t default, so the prediction won’t
always be correct. No model can feasibly predict every response, but a good model should allow
us to predict the most likely response for each record based on the available data.

In the same way, if we look at the high income customers (Node 1), we see that the vast majority
(89%) are a good risk. But more than 1 in 10 of these customers has also defaulted. Can we refine
our lending criteria to minimize the risk here?
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Notice how the model has divided these customers into two sub-categories (Nodes 4 and 5),
based on the number of credit cards held. For high-income customers, if we lend only to those
with fewer than 5 credit cards, we can increase our success rate from 89% to 97%—an even
more satisfactory outcome.

Figure 2-12
Tree view of high-income customers

High
Mode 1
Category . % n

Bad 10,969 &0
B Good 89.031 487

Tatal 31.858 547
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But what about those customers in the Medium income category (Node 3)? They’re much more
evenly divided between Good and Bad ratings.

Again, the sub-categories (Nodes 6 and 7 in this case) can help us. This time, lending only to
those medium-income customers with fewer than 5 credit cards increases the percentage of Good
ratings from 58% to 85%, a significant improvement.

Figure 2-13
Tree view of medium-income customers
Mediurn
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So, we’ve learnt that every record that is input to this model will be assigned to a specific node,
and assigned a prediction of Good or Bad based on the most common response for that node.

This process of assigning predictions to individual records is known as scoring. By scoring the
same records used to estimate the model, we can evaluate how accurately it performs on the
training data—the data for which we know the outcome. Let’s look at how to do this.

Evaluating the Model

We’ve been browsing the model to understand how scoring works. But to evaluate how accurately
it works, we need to score some records and compare the responses predicted by the model to

the actual results. We’re going to score the same records that were used to estimate the model,
allowing us to compare the observed and predicted responses.

Figure 2-14
Attaching the model nugget to output nodes for model evaluation

tree_creditsaw Type Areditrating
+
g e
mnﬁf Table
Creditrating\ O\
Analysis

» To see the scores or predictions, attach the Table node to the model nugget, double-click the
Table node and click Run.

The table displays the predicted scores in a field named $R-Credit rating, which was created by

the model. We can compare these values to the original Credit rating field that contains the
actual responses.
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By convention, the names of the fields generated during scoring are based on the target field, but
with a standard prefix such as $R- for predictions or $RC- for confidence values. Different models
types use different sets of prefixes. A confidence value is the model’s own estimation, on a scale
from 0.0 to 1.0, of how accurate each predicted value is.

Figure 2-15
Table showing generated scores and confidence values
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As expected, the predicted value matches the actual responses for many records but not all. The
reason for this is that each CHAID terminal node has a mix of responses. The prediction matches
the most common one, but will be wrong for all the others in that node. (Recall the 16% minority
of low-income customers who did not default.)

To avoid this, we could continue splitting the tree into smaller and smaller branches, until every
node was 100% pure—all Good or Bad with no mixed responses. But such a model would be
extremely complicated and would probably not generalize well to other datasets.

To find out exactly how many predictions are correct, we could read through the table and tally
the number of records where the value of the predicted field $R-Credit rating matches the value
of Credit rating. Fortunately, there’s a much easier way—we can use an Analysis node, which

does this automatically.

» Connect the model nugget to the Analysis node.
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» Double-click the Analysis node and click Run.

Figure 2-16

Attaching an Analysis node
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The analysis shows that for 1899 out of 2464 records—over 77%—the value predicted by the

model matched the actual response.

Figure 2-17

Analysis results comparing observed and predicted responses
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This result is limited by the fact that the records being scored are the same ones used to estimate
the model. In a real situation, you could use a Partition node to split the data into separate samples
for training and evaluation.

By using one sample partition to generate the model and another sample to test it, you can get a
much better indication of how well it will generalize to other datasets.

The Analysis node allows us to test the model against records for which we already know the
actual result. The next stage illustrates how we can use the model to score records for which we
don’t know the outcome. For example, this might include people who are not currently customers
of the bank, but who are prospective targets for a promotional mailing.

Scoring Records

Earlier, we scored the same records used to estimate the model in order to evaluate how accurate
the model was. Now we’re going to see how to score a different set of records from the ones used
to create the model. This is the goal of modeling with a target field: Study records for which you
know the outcome, to identify patterns that will allow you to predict outcomes you don’t yet know.

Figure 2-18
Attaching new data for scoring
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You could update the Statistics File source node to point to a different data file, or you could
add a new source node that reads in the data you want to score. Either way, the new dataset
must contain the same input fields used by the model (Age, Income level, Education and so on)
but not the target field Credit rating.

Alternatively, you could add the model nugget to any stream that includes the expected input
fields. Whether read from a file or a database, the source type doesn’t matter as long as the field
names and types match those used by the model.

You could also save the model nugget as a separate file, export the model in PMML format for
use with other applications that support this format, or store the model in an IBM® SPSS®
Collaboration and Deployment Services repository, which offers enterprise-wide deployment,
scoring, and management of models.
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Regardless of the infrastructure used, the model itself works in the same way.

Summary

This example demonstrates the basic steps for creating, evaluating, and scoring a model.

B The modeling node estimates the model by studying records for which the outcome is known,
and creates a model nugget. This is sometimes referred to as training the model.

B The model nugget can be added to any stream with the expected fields to score records. By

scoring the records for which you already know the outcome (such as existing customers),
you can evaluate how well it performs.

B Once you are satisfied that the model performs acceptably well, you can score new data (such
as prospective customers) to predict how they will respond.

B The data used to train or estimate the model may be referred to as the analytical or historical
data; the scoring data may also be referred to as the operational data.
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Modeling Overview

Overview of Modeling Nodes

IBM® SPSS® Modeler offers a variety of modeling methods taken from machine learning,
artificial intelligence, and statistics. The methods available on the Modeling palette allow you
to derive new information from your data and to develop predictive models. Each method has
certain strengths and is best suited for particular types of problems.

The SPSS Modeler Applications Guide provides examples for many of these methods, along
with a general introduction to the modeling process. This guide is available as an online tutorial,
and also in PDF format. For more information, see the topic [Application Examples in Chapter 1
on p. pb.

Modeling methods are divided into three categories:

m Classification
B Association

®  Segmentation

Classification Models

Classification models use the values of one or more input fields to predict the value of one or
more output, or target, fields. Some examples of these techniques are: decision trees (C&R Tree,
QUEST, CHAID and C5.0 algorithms), regression (linear, logistic, generalized linear, and Cox
regression algorithms), neural networks, support vector machines, and Bayesian networks.

Classification models helps organizations to predict a known result, such as whether a customer
will buy or leave or whether a transaction fits a known pattern of fraud. Modeling techniques
include machine learning, rule induction, subgroup identification, statistical methods, and multiple
model generation.

Classification nodes

- The Auto Classifier node creates and compares a number of different models for
i binary outcomes (yes or no, churn or do not churn, and so on), allowing you to
C% choose the best approach for a given analysis. A number of modeling algorithms are

supported, making it possible to select the methods you want to use, the specific
options for each, and the criteria for comparing the results. The node generates a set
of models based on the specified options and ranks the best candidates according to
the criteria you specify. For more information, see the topic [Auto Classifier Node
in Chapter 5 on p. [89.

© Copyright IBM Corporation 1994, 2012. 24
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The Auto Numeric node estimates and compares models for continuous numeric
range outcomes using a number of different methods. The node works in the same
manner as the Auto Classifier node, allowing you to choose the algorithms to use
and to experiment with multiple combinations of options in a single modeling pass.
Supported algorithms include neural networks, C&R Tree, CHAID, linear regression,
generalized linear regression, and support vector machines (SVM). Models can be
compared based on correlation, relative error, or number of variables used. For more
information, see the topic [Auto Numeric Nod¢ in Chapter 5 on p. 8.

The Classification and Regression (C&R) Tree node generates a decision tree that
allows you to predict or classify future observations. The method uses recursive
partitioning to split the training records into segments by minimizing the impurity
at each step, where a node in the tree is considered “pure” if 100% of cases in the
node fall into a specific category of the target field. Target and input fields can be
numeric ranges or categorical (nominal, ordinal, or flags); all splits are binary (only
two subgroups). For more information, see the topic [C&R Tree Node in Chapter 6
on p. [143|

The QUEST node provides a binary classification method for building decision trees,
designed to reduce the processing time required for large C&R Tree analyses while
also reducing the tendency found in classification tree methods to favor inputs that
allow more splits. Input fields can be numeric ranges (continuous), but the target field
must be categorical. All splits are binary. For more information, see the topic QUEST

Node in Chapter 6 on p. 144}

The CHAID node generates decision trees using chi-square statistics to identify
optimal splits. Unlike the C&R Tree and QUEST nodes, CHAID can generate
nonbinary trees, meaning that some splits have more than two branches. Target and
input fields can be numeric range (continuous) or categorical. Exhaustive CHAID is
a modification of CHAID that does a more thorough job of examining all possible
splits but takes longer to compute. For more information, see the topic CHAID Node
in Chapter 6 on p. 44,

The C5.0 node builds either a decision tree or a rule set. The model works by splitting
the sample based on the field that provides the maximum information gain at each
level. The target field must be categorical. Multiple splits into more than two
subgroups are allowed. For more information, see the topic [C5.0 Node in Chapter 6

on p. [160.

The Decision List node identifies subgroups, or segments, that show a higher or
lower likelihood of a given binary outcome relative to the overall population. For
example, you might look for customers who are unlikely to churn or are most likely
to respond favorably to a campaign. You can incorporate your business knowledge
into the model by adding your own custom segments and previewing alternative
models side by side to compare the results. Decision List models consist of a list of
rules in which each rule has a condition and an outcome. Rules are applied in order,
and the first rule that matches determines the outcome. For more information, see the

topic Decision Lisf in Chapter 9 on p. 204

Linear regression models predict a continuous target based on linear relationships
between the target and one or more predictors. For more information, see the

topic [Linear models in Chapter 10 on p. 239.
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The PCA/Factor node provides powerful data-reduction techniques to reduce

the complexity of your data. Principal components analysis (PCA) finds linear
combinations of the input fields that do the best job of capturing the variance in the
entire set of fields, where the components are orthogonal (perpendicular) to each
other. Factor analysis attempts to identify underlying factors that explain the pattern
of correlations within a set of observed fields. For both approaches, the goal is to
find a small number of derived fields that effectively summarizes the information in
the original set of fields. For more information, see the topic PCA/Factor Node| in
Chapter 10 on p. 277.

The Feature Selection node screens input fields for removal based on a set of criteria
(such as the percentage of missing values); it then ranks the importance of remaining
inputs relative to a specified target. For example, given a data set with hundreds of
potential inputs, which are most likely to be useful in modeling patient outcomes?

For more information, see the topic [Feature Selection Node in Chapter 4 on p. [70.

Discriminant analysis makes more stringent assumptions than logistic regression but
can be a valuable alternative or supplement to a logistic regression analysis when
those assumptions are met. For more information, see the topic [Discriminant Node| in
Chapter 10 on p. 285.

Logistic regression is a statistical technique for classifying records based on values
of input fields. It is analogous to linear regression but takes a categorical target field

instead of a numeric range. For more information, see the topic [Logistic Node| in
Chapter 10 on p. 259.

The Generalized Linear model expands the general linear model so that the dependent
variable is linearly related to the factors and covariates through a specified link
function. Moreover, the model allows for the dependent variable to have a non-normal
distribution. It covers the functionality of a wide number of statistical models,
including linear regression, logistic regression, loglinear models for count data, and
interval-censored survival models. For more information, see the topic
in Chapter 10 on p. P94.

A generalized linear mixed model (GLMM) extends the linear model so that the target
can have a non-normal distribution, is linearly related to the factors and covariates via
a specified link function, and so that the observations can be correlated. Generalized
linear mixed models cover a wide variety of models, from simple linear regression to
complex multilevel models for non-normal longitudinal data. For more information,

see the topic GLMM Node in Chapter 10 on p. B07.

The Cox regression node enables you to build a survival model for time-to-event data
in the presence of censored records. The model produces a survival function that
predicts the probability that the event of interest has occurred at a given time (7) for
given values of the input variables. For more information, see the topic [Cox Node in
Chapter 10 on p. 336.

The Support Vector Machine (SVM) node enables you to classify data into one of
two groups without overfitting. SVM works well with wide data sets, such as those
with a very large number of input fields. For more information, see the topic

Node in Chapter 15 on p. #57.
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- The Bayesian Network node enables you to build a probability model by combining
a fg. observed and recorded evidence with real-world knowledge to establish the likelihood
of occurrences. The node focuses on Tree Augmented Naive Bayes (TAN) and
Markov Blanket networks that are primarily used for classification. For more
information, see the topic Bayesian Network Node| in Chapter 7 on p. [I79.

The Self-Learning Response Model (SLRM) node enables you to build a model in
._:-.g which a single new case, or small number of new cases, can be used to reestimate the
" model without having to retrain the model using all data. For more information, see

the topic SLRM Nodg| in Chapter 14 on p. #46,

The Time Series node estimates exponential smoothing, univariate Autoregressive

Integrated Moving Average (ARIMA), and multivariate ARIMA (or transfer function)
models for time series data and produces forecasts of future performance. A Time
Series node must always be preceded by a Time Intervals node. For more information,
see the topic [Time Series Modeling Node in Chapter 13 on p. #24.

The k-Nearest Neighbor (KNN) node associates a new case with the category or value
- of the k objects nearest to it in the predictor space, where k is an integer. Similar
cases are near each other and dissimilar cases are distant from each other. For more
information, see the topic KNN Node in Chapter 16 on p. #62.

Association Models

Association models find patterns in your data where one or more entities (such as events,
purchases, or attributes) are associated with one or more other entities. The models construct rule
sets that define these relationships. Here the fields within the data can act as both inputs and
targets. You could find these associations manually, but association rule algorithms do so much
more quickly, and can explore more complex patterns. Apriori and Carma models are examples of
the use of such algorithms. One other type of association model is a sequence detection model,
which finds sequential patterns in time-structured data.

Association models are most useful when predicting multiple outcomes—for example, customers
who bought product X also bought Y and Z. Association models associate a particular conclusion
(such as the decision to buy something) with a set of conditions. The advantage of association rule
algorithms over the more standard decision tree algorithms (C5.0 and C&RT) is that associations
can exist between any of the attributes. A decision tree algorithm will build rules with only a
single conclusion, whereas association algorithms attempt to find many rules, each of which may
have a different conclusion.
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Association nodes

The Apriori node extracts a set of rules from the data, pulling out the rules with
% the highest information content. Apriori offers five different methods of selecting
rules and uses a sophisticated indexing scheme to process large data sets efficiently.
For large problems, Apriori is generally faster to train; it has no arbitrary limit on
the number of rules that can be retained, and it can handle rules with up to 32
preconditions. Apriori requires that input and output fields all be categorical but
delivers better performance because it is optimized for this type of data. For more

information, see the topic [Apriori Node| in Chapter 12 on p. B79.

The CARMA model extracts a set of rules from the data without requiring you
ﬁﬁﬁ to specify input or target fields. In contrast to Apriori the CARMA node offers
build settings for rule support (support for both antecedent and consequent) rather
than just antecedent support. This means that the rules generated can be used for a
wider variety of applications—for example, to find a list of products or services
(antecedents) whose consequent is the item that you want to promote this holiday
season. For more information, see the topic CARMA Nodé¢ in Chapter 12 on p. 383

The Sequence node discovers association rules in sequential or time-oriented data. A

cacms sequence is a list of item sets that tends to occur in a predictable order. For example, a
s customer who purchases a razor and aftershave lotion may purchase shaving cream

the next time he shops. The Sequence node is based on the CARMA association rules
algorithm, which uses an efficient two-pass method for finding sequences. For more

information, see the topic Sequence Node in Chapter 12 on p. #04.

Segmentation Models

Segmentation models divide the data into segments, or clusters, of records that have similar
patterns of input fields. As they are only interested in the input fields, segmentation models have
no concept of output or target fields. Examples of segmentation models are Kohonen networks,
K-Means clustering, two-step clustering and anomaly detection.

Segmentation models (also known as “clustering models”) are useful in cases where the specific
result is unknown (for example, when identifying new patterns of fraud, or when identifying
groups of interest in your customer base). Clustering models focus on identifying groups of
similar records and labeling the records according to the group to which they belong. This is
done without the benefit of prior knowledge about the groups and their characteristics, and it
distinguishes clustering models from the other modeling techniques in that there is no predefined
output or target field for the model to predict. There are no right or wrong answers for these
models. Their value is determined by their ability to capture interesting groupings in the data and
provide useful descriptions of those groupings. Clustering models are often used to create clusters
or segments that are then used as inputs in subsequent analyses (for example, by segmenting
potential customers into homogeneous subgroups).
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Segmentation nodes
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The Auto Cluster node estimates and compares clustering models, which identify
groups of records that have similar characteristics. The node works in the same
manner as other automated modeling nodes, allowing you to experiment with multiple
combinations of options in a single modeling pass. Models can be compared using
basic measures with which to attempt to filter and rank the usefulness of the cluster
models, and provide a measure based on the importance of particular fields. For more
information, see the topic [Auto Cluster Node| in Chapter 5 on p. 104.

The K-Means node clusters the data set into distinct groups (or clusters). The method
defines a fixed number of clusters, iteratively assigns records to clusters, and adjusts
the cluster centers until further refinement can no longer improve the model. Instead
of trying to predict an outcome, k-means uses a process known as unsupervised
learning to uncover patterns in the set of input fields. For more information, see the

topic [K-Means Node in Chapter 11 on p. 354,

The Kohonen node generates a type of neural network that can be used to cluster the
data set into distinct groups. When the network is fully trained, records that are
similar should be close together on the output map, while records that are different
will be far apart. You can look at the number of observations captured by each unit
in the model nugget to identify the strong units. This may give you a sense of the
appropriate number of clusters. For more information, see the topic Kohonen Node in
Chapter 11 on p. B48.

The TwoStep node uses a two-step clustering method. The first step makes a single
pass through the data to compress the raw input data into a manageable set of
subclusters. The second step uses a hierarchical clustering method to progressively
merge the subclusters into larger and larger clusters. TwoStep has the advantage of
automatically estimating the optimal number of clusters for the training data. It can
handle mixed field types and large data sets efficiently. For more information, see the

topic [TwoStep Cluster Node| in Chapter 11 on p. B58.

The Anomaly Detection node identifies unusual cases, or outliers, that do not conform
to patterns of “normal” data. With this node, it is possible to identify outliers even if
they do not fit any previously known patterns and even if you are not exactly sure
what you are looking for. For more information, see the topic [Anomaly Detection

Node in Chapter 4 on p. [77.

In-Database Mining Models

SPSS Modeler supports integration with data mining and modeling tools that are available from
database vendors, including Oracle Data Miner, IBM DB2 InfoSphere Warehouse, and Microsoft
Analysis Services. You can build, score, and store models inside the database—all from within the
SPSS Modeler application. For full details, see the SPSS Modeler In-Database Mining Guide,
available on the product DVD.

IBM SPSS Statistics Models

If you have a copy of IBM® SPSS® Statistics installed and licensed on your computer, you can
access and run certain SPSS Statistics routines from within SPSS Modeler to build and score

models.
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Further Information

Detailed documentation on the modeling algorithms is also available. For more information, see
the SPSS Modeler Algorithms Guide, available on the product DVD.

Building Split Models

Split modeling enables you to use a single stream to build separate models for each possible value
of a flag, nominal or continuous input field, with the resulting models all being accessible from a
single model nugget. The possible values for the input fields could have very different effects

on the model. With split modeling, you can easily build the best-fitting model for each possible
field value in a single execution of the stream.

Note that interactive modeling sessions cannot use splitting. With interactive modeling you
specify each model individually, so there would be no advantage in using splitting, which builds
multiple models automatically.

Split modeling works by designating a particular input field as a split field. You can do this by
setting the field role to Split in the Type specification:

Figure 3-1

Designating an input field as a split field
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You can designate only fields with a measurement level of Flag, Nominal, Ordinal or Continuous as

split fields.
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You can assign more than one input field as a split field. In this case, however, the number of

models created can be greatly increased. A model is built for each possible combination of the
values of the selected split fields. For example, if three input fields, each having three possible
values, are designated as split fields, this will result in the creation of 27 different models.

Even after you assign one or more fields as split fields, you can still choose whether to create split
models or a single model, by means of a check box setting on the modeling node dialog:

Figure 3-2
Choosing to build split models
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If split fields are defined but the check box is not selected, only a single model is generated.
Likewise if the check box is selected but no split field is defined, splitting is ignored and a single
model is generated.
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When you run the stream, separate models are built behind the scenes for each possible value
of the split field or fields, but only a single model nugget is placed in the models palette and the
stream canvas. A split-model nugget is denoted by the split symbol:

Figure 3-3
Split-model nugget in a stream
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When you browse the split-model nugget, you see a list of all the separate models that have
been built:

Figure 3-4
Split model viewer

E Drug

? ‘ ,}% File {3} Generate
c !
sl Smery oo

Sort by: Creerall accuracy = O Azcending ® Descending

view,

Graph haclel e No. Records Mo, Figls Cwverall ‘

in Spilit Uzed Accuracy (%) &

ol ¥ :
pooall ¥ -

=

100

=

99.035




33

Modeling Overview

You can investigate an individual model from a list by double-clicking its nugget icon in the
viewer. Doing so opens a standard browser window for the individual model. When the nugget is
on the canvas, double-clicking a graph thumbnail opens the full-size graph. For more information,
see the topic Split Model Viewer on p. 61].

Once a model has been created as a split model, you cannot remove the split processing from it,
nor can you undo splitting further downstream from a split-modeling node or nugget.

Example. A national retailer wants to estimate sales by product category at each of its stores
around the country. Using split modeling, they designate the Store field of their input data

as a split field, enabling them to build separate models for each category at each store in a
single operation. They can then use the resulting information to control stock levels much more
accurately than they could with only a single model.

Splitting and Partitioning

Splitting has some features in common with partitioning, but the two are used in very different
ways.

Partitioning divides the dataset randomly into either two or three parts: training, testing and
(optionally) validation, and is used to test the performance of a single model.

Splitting divides the dataset into as many parts as there are possible values for a split field, and is
used to build multiple models.

Partitioning and splitting operate completely independently of each other. You can choose either,
both or neither in a modeling node.

Modeling Nodes Supporting Split Models

A number of modeling nodes can create split models. The exceptions are Auto Cluster, Time
Series, PCA/Factor, Feature Selection, SLRM, the association models (Apriori, Carma and
Sequence), the clustering models (K-Means, Kohonen, Two Step and Anomaly), Statistics Model,
and the nodes used for in-database modeling.

The modeling nodes that support split modeling are:

i 5
FjﬁT C&R Tree . f’ Bayes Net
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Features Affected by Splitting

The use of split models affects a number of IBM® SPSS® Modeler features in various ways. This
section provides guidance on using split models in conjunction with other nodes in a stream.

Record Ops nodes

When using split models in a stream that contains a Sample node, stratify records by the split field
to achieve an even sampling of records. This option is available when you choose Complex as
the sample method.

If the stream contains a Balance node, note that balancing applies to the overall set of input
records, not to the subset of records inside a split.

When aggregating records by means of an Aggregate node, set the split fields to be key fields if
you want to calculate aggregates for each split.

Field Ops nodes
The Type node is where you specify which field or fields to use as split fields.

Note that, while the Ensemble node is used to combine two or more model nuggets, it cannot
be used to reverse the action of splitting, as the split models are contained inside a single model
nugget.
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Modeling nodes

Split models do not support the calculation of predictor importance (the relative importance of
the predictor input fields in estimating the model). Predictor importance settings are ignored
when building split models.

The KNN (nearest neighbor) node supports split models only if it is set to predict a target field.
The alternative setting (only identify nearest neighbors) does not create a model. If the option
“Automatically select k™ is chosen, each of the split models may have a different number of
nearest neighbors. Thus the overall model will have a number of generated columns equal to the
largest number of nearest neighbors found across all the split models. For those split models
where the number of nearest neighbors is less than this maximum, there will be a corresponding
number of columns filled with $null values. For more information, see the topic KNN Nod¢| in
Chapter 16 on p. #62,

Database Modeling nodes

The in-database modeling nodes do not support split models.

Model nuggets
Export to PMML from a split model nugget is not possible, as the nugget contains multiple

models and PMML does not support such a packaging. Export to text or HTML is possible,
however.

Modeling Node Fields Options

All modeling nodes have a Fields tab, where you can specify the fields to be used in building
the model.
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Figure 3-5
Example of a modeling node Fields tab
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Before you can build a model, you need to specify which fields you want to use as targets and as
inputs. With a few exceptions, all modeling nodes will use field information from an upstream
Type node. If you are using a Type node to select input and target fields, you don’t need to change
anything on this tab. (Exceptions include the Sequence node and the Text Extraction node, which
require that field settings be specified in the modeling node.)

Use type node settings. This option tells the node to use field information from an upstream Type
node. This is the default.

Use custom settings. This option tells the node to use field information specified here instead of
that given in any upstream Type node(s). After selecting this option, specify the fields below as
required.

Note: Not all fields are displayed for all nodes.

m  Use transactional format (Apriori, CARMA, MS Association Rules and Oracle Apriori nodes only).
Select this check box if the source data is in transactional format. Records in this format
have two fields, one for an ID and one for content. Each record represents a single transaction
or item, and associated items are linked by having the same ID. Deselect this box if the data is
in tabular format, in which items are represented by separate flags, where each flag field
represents the presence or absence of a specific item and each record represents a complete set
of associated items. For more information, see the topic Tabular versus Transactional Data
in Chapter 12 on p. 378
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m ID. For transactional data, select an ID field from the list. Numeric or symbolic fields can be
used as the ID field. Each unique value of this field should indicate a specific unit of analysis.
For example, in a market basket application, each ID might represent a single customer.

For a Web log analysis application, each ID might represent a computer (by IP address)
or a user (by login data).

m |Ds are contiguous. (Apriori and CARMA nodes only) If your data are presorted so that all
records with the same ID are grouped together in the data stream, select this option to speed
up processing. If your data are not presorted (or you are not sure), leave this option unselected
and the node will sort the data automatically.

Note: If your data are not sorted and you select this option, you may get invalid results
in your model.

m  Content. Specify the content field(s) for the model. These fields contain the items of interest in
association modeling. You can specify multiple flag fields (if data are in tabular format) or
a single nominal field (if data are in transactional format).

m Target. For models that require one or more target fields, select the target field or fields. This
is similar to setting the field role to Target in a Type node.

m  Evaluation. (For Auto Cluster models only.) No target is specified for cluster models; however,
you can select an evaluation field to identify its level of importance. In addition, you can
evaluate how well the clusters differentiate values of this field, which in turn indicates whether
the clusters can be used to predict this field.

® Inputs. Select the input field or fields. This is similar to setting the field role to Input in a
Type node.

m  Partition. This field allows you to specify a field used to partition the data into separate
samples for the training, testing, and validation stages of model building. By using one
sample to generate the model and a different sample to test it, you can get a good indication of
how well the model will generalize to larger datasets that are similar to the current data. If
multiple partition fields have been defined by using Type or Partition nodes, a single partition
field must be selected on the Fields tab in each modeling node that uses partitioning. (If only
one partition is present, it is automatically used whenever partitioning is enabled.) Also
note that to apply the selected partition in your analysis, partitioning must also be enabled
in the Model Options tab for the node. (Deselecting this option makes it possible to disable
partitioning without changing field settings.)

m  Splits. For split models, select the split field or fields. This is similar to setting the field
role to Split in a Type node. You can designate only fields with a measurement level of
Flag, Nominal, Ordinal or Continuous as split fields. Fields chosen as split fields cannot be
used as target, input, partition, frequency or weight fields. For more information, see the
topic Building Split Models on p. B0.

m  Use frequency field. This option allows you to select a field as a frequency weight. Use this if
the records in your training data represent more than one unit each—for example, if you are
using aggregated data. The field values should be the number of units represented by each
record. For more information, see the topic Using Frequency and Weight Fields on p. 38,

Note: If you see the error message Metadata (on input/output fields) not valid, ensure that you have
specified all fields that are required, such as the frequency field.
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Use weight field. This option allows you to select a field as a case weight. Case weights
are used to account for differences in variance across levels of the output field. For more
information, see the topic [Using Frequency and Weight Fields on p. 38.

Consequents. For rule induction nodes (Apriori), select the fields to be used as consequents in
the resulting rule set. (This corresponds to fields with role Target or Both in a Type node.)

Antecedents. For rule induction nodes (Apriori), select the fields to be used as antecedents in
the resulting rule set. (This corresponds to fields with role Input or Both in a Type node.)

Some models have a Fields tab that differs from those described in this section.

For more information, see the topic Sequence Node Fields Options in Chapter 12 on p. 405.

For more information, see the topic CARMA Node Fields Options in Chapter 12 on p. 383.

Using Frequency and Weight Fields

Frequency and weight fields are used to give extra importance to some records over others, for
example, because you know that one section of the population is under-represented in the training
data (weight) or because one record represents a number of identical cases (frequency).

Values for a frequency field should be positive integers. Records with a negative or zero
frequency weight are excluded from the analysis. Non-integer frequency weights are rounded
to the nearest integer.

Case weight values should be positive but need not be integer values. Records with a negative
or zero case weight are excluded from the analysis.

Scoring Frequency and Weight Fields

Frequency and weight fields are used in training models, but are not used in scoring, because the
score for each record is based on its characteristics regardless of how many cases it represents.
For example, suppose you have the following data:

Married Responded
Yes Yes
Yes Yes
Yes Yes
Yes No
No Yes
No No
No No

Based on this, you conclude that three out of four married people respond to the promotion, and
two out of three unmarried people didn’t respond. So you will score any new records accordingly:

Married $-Responded $RP-Responded
Yes Yes 0.75 (three/four)
No No 0.67 (two/three)




39

Modeling Overview

Alternatively, you could store your training data more compactly, using a frequency field:

Married Responded Frequency
Yes Yes 3
Yes No 1
No Yes 1
No No 2

Since this represents exactly the same dataset, you will build the same model and predict
responses based solely on marital status. If you have ten married people in your scoring data, you
will predict Yes for each of them regardless of whether they are presented as ten separate records,
or one with a frequency value of 10. Weight, although generally not an integer, can be thought
of as similarly indicating the importance of a record. This is why frequency and weight fields
are not used when scoring records.

Evaluating and Comparing Models

Some model types support frequency fields, some support weight fields, and some support both.
But in all cases where they apply, they are used only for model building and are not considered
when evaluating models using an Evaluation node or Analysis node, or when ranking models
using most of the methods supported by the Auto Classifier and Auto Numeric nodes.

B When comparing models (using evaluation charts, for example), frequency and weight
values will be ignored. This allows a level comparison between models that use these fields
and models that don’t, but means that for an accurate evaluation, a dataset that accurately
represents the population without relying on a frequency or weight field must be used. In
practical terms, you can do this by making sure that models are evaluated using a testing
sample in which the value of the frequency or weight field is always null or 1. (This restriction
only applies when evaluating models; if frequency or weight values were always 1 for both
training and testing samples, there would be no reason to use these fields in the first place.)

m [f using Auto Classifier, frequency can be taken into account if ranking models based on
Profit, so this method is recommended in that case.

B If necessary, you can split the data into training and testing samples using a Partition node.

Modeling Node Analyze Options

Many modeling nodes include an Analyze tab that allows you to obtain predictor importance
information along with raw and adjusted propensity scores.
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Figure 3-6
Analyze tab in the modeling node
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Model Evaluation

Calculate predictor importance. For models that produce an appropriate measure of importance,
you can display a chart that indicates the relative importance of each predictor in estimating the
model. Typically you will want to focus your modeling efforts on the predictors that matter most,
and consider dropping or ignoring those that matter least. Note that predictor importance may take
longer to calculate for some models, particularly when working with large datasets, and is off by
default for some models as a result. Predictor importance is not available for decision list models.
For more information, see the topic [Predictor Importance on p. 51}

Propensity Scores

Propensity scores can be enabled in the modeling node, and on the Settings tab in the model
nugget. This functionality is available only when the selected target is a flag field. For more
information, see the topic Propensity Scores on p. {1.

Calculate raw propensity scores. Raw propensity scores are derived from the model based on the
training data only. If the model predicts the true value (will respond), then the propensity is the
same as P, where P is the probability of the prediction. If the model predicts the false value,
then the propensity is calculated as (1 — P).



41

Modeling Overview

® If you choose this option when building the model, propensity scores will be enabled in the
model nugget by default. However, you can always choose to enable raw propensity scores in
the model nugget whether or not you select them in the modeling node.

B When scoring the model, raw propensity scores will be added in a field with the letters RP
appended to the standard prefix. For example, if the predictions are in a field named $R-churn,
the name of the propensity score field will be $RRP-churn.

Calculate adjusted propensity scores. Raw propensities are based purely on estimates given by

the model, which may be overfitted, leading to over-optimistic estimates of propensity. Adjusted
propensities attempt to compensate by looking at how the model performs on the test or validation
partitions and adjusting the propensities to give a better estimate accordingly.

m  This setting requires that a valid partition field is present in the stream.

m  Unlike raw confidence scores, adjusted propensity scores must be calculated when building
the model; otherwise, they will not be available when scoring the model nugget.

B When scoring the model, adjusted propensity scores will be added in a field with the letters AP
appended to the standard prefix. For example, if the predictions are in a field named $R-churn,
the name of the propensity score field will be $RAP-churn. Adjusted propensity scores are
not available for logistic regression models.

B When calculating the adjusted propensity scores, the test or validation partition used for the
calculation must not have been balanced. To avoid this, be sure the Only balance training data
option is selected in any upstream Balance nodes. In addition, if a complex sample has been
taken upstream this will invalidate the adjusted propensity scores.

B Adjusted propensity scores are not available for “boosted” tree and rule set models. For more
information, see the topic [Boosted C5.0 Models in Chapter 6 on p. [171.

Based on. For adjusted propensity scores to be computed, a partition field must be present
in the stream. You can specify whether to use the testing or validation partition for this
computation. For best results, the testing or validation partition should include at least as
many records as the partition used to train the original model.

Propensity Scores

For models that return a yes or no prediction, you can request propensity scores in addition to
the standard prediction and confidence values. Propensity scores indicate the likelihood of a
particular outcome or response. For example:

Table 3-1

Propensity scores

Customer Propensity to respond
Joe Smith 35%

Jane Smith 15%

Propensity scores are available only for models with flag targets, and indicate the likelihood of the
True value defined for the field, as specified in a source or Type node.
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Propensity Scores Versus Confidence Scores

Propensity scores differ from confidence scores, which apply to the current prediction, whether yes
or no. In cases where the prediction is no, for example, a high confidence actually means a high
likelihood not to respond. Propensity scores sidestep this limitation to allow easier comparison
across all records. For example, a no prediction with a confidence of 0.85 translates to a raw
propensity of 0.15 (or I minus 0.85).

Table 3-2

Confidence scores

Customer Prediction Confidence
Joe Smith Will respond .35

Jane Smith Won’t respond .85

Obtaining Propensity Scores

B Propensity scores can be enabled on the Analyze tab in the modeling node or on the Settings
tab in the model nugget. This functionality is available only when the selected target is a flag
field. For more information, see the topic Modeling Node Analyze Options on p. 39.

B Propensity scores may also be calculated by the Ensemble node, depending on the ensemble
method used.

Calculating Adjusted Propensity Scores

Adjusted propensity scores are calculated as part of the process of building the model, and will
not be available otherwise. Once the model is built, it is then scored using data from the test or
validation partition, and a new model to deliver adjusted propensity scores is constructed by
analyzing the original model’s performance on that partition. Depending on the type of model,
one of two methods may be used to calculate the adjusted propensity scores.

m  For rule set and tree models, adjusted propensity scores are generated by recalculating the
frequency of each category at each tree node (for tree models) or the support and confidence
of each rule (for rule set models). This results in a new rule set or tree model which is stored
with the original model, to be used whenever adjusted propensity scores are requested. Each
time the original model is applied to new data, the new model can subsequently be applied to
the raw propensity scores to generate the adjusted scores.

m  For other models, records produced by scoring the original model on the test or validation
partition are then binned by their raw propensity score. Next, a neural network model is
trained that defines a non-linear function that maps from the mean raw propensity in each
bin to the mean observed propensity in the same bin. As noted earlier for tree models, the
resulting neural net model is stored with the original model, and can be applied to the raw
propensity scores whenever adjusted propensity scores are requested.

Caution regarding missing values in the testing partition. Handling of missing input values in the
testing/validation partition varies by model (see individual model scoring algorithms for details).
The C5 model cannot compute adjusted propensities when there are missing inputs.
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Model Nuggets

Figure 3-7
Model nugget

A model nugget is a container for a model, that is, the set of rules, formulas or equations that
represent the results of your model building operations in IBM® SPSS® Modeler. The main
purpose of a nugget is for scoring data to generate predictions, or to allow further analysis of
the model properties. Opening a model nugget on the screen enables you to see various details
about the model, such as the relative importance of the input fields in creating the model. To
view the predictions, you need to attach and execute a further process or output node. For more
information, see the topic [Using Model Nuggets in Streams| on p. 63.

Figure 3-8
Model link from modeling node to model nugget
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When you successfully execute a modeling node, a corresponding model nugget is placed on the
stream canvas, where it is represented by a gold, diamond-shaped icon (hence the name “nugget”).
On the stream canvas, the nugget is shown with a connection (solid line) to the nearest suitable
node before the modeling node, and a link (dotted line) to the modeling node itself.

The nugget is also placed in the Models palette in the upper right corner of the SPSS Modeler
window. From either location, nuggets can be selected and browsed to view details of the model.

Nuggets are always placed in the Models palette when a modeling node is successfully executed.
You can set a user option to control whether the nugget is additionally placed on the stream canvas.

The following topics provide information on using model nuggets in SPSS Modeler. For an
in-depth understanding of the algorithms used, see the SPSS Modeler Algorithms Guide, available
in the \Documentation folder on the DVD for IBM® SPSS® Modeler.

Model Links

By default, a nugget is shown on the canvas with a link to the modeling node that created it.

This is especially useful in complex streams with several nuggets, enabling you to identify the
nugget that will be updated by each modeling node. Each link contains a symbol to indicate
whether the model is replaced when the modeling node is executed. For more information, see the
topic Replacing a Model on p. 46.
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Defining and Removing Model Links

You can define and remove links manually on the canvas. When you are defining a new link, the
cursor changes to the link cursor.

Figure 3-9
Link cursor

[%)V
Defining a new link (context menu)
» Right-click on the modeling node from which you want the link to start.

» Choose Define Model Link from the context menu.

» Click the nugget where you want the link to end.

Defining a new link (main menu)
» Click the modeling node from which you want the link to start.

» From the main menu, choose:
Edit > Node > Define Model Link

» Click the nugget where you want the link to end.

Removing an existing link (context menu)
» Right-click on the nugget at the end of the link.

» Choose Remove Model Link from the context menu.

Alternatively:
» Right-click on the symbol in the middle of the link.

» Choose Remove Link from the context menu.

Removing an existing link (main menu)
» Click the modeling node or nugget from which you want to remove the link.

» From the main menu, choose:
Edit > Node > Remove Model Link
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Copying and Pasting Model Links

If you copy a linked nugget, without its modeling node, and paste it into the same stream, the
nugget is pasted with a link to the modeling node. The new link has the same model replacement
status (see Replacing a Model on p. /6) as the original link:

Figure 3-10
Copying and pasting a linked nugget
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If you copy and paste a nugget together with its linked modeling node, the link is retained whether
the objects are pasted into the same stream or a new stream:

Figure 3-11
Copying and pasting a linked nugget
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Note: If you copy a linked nugget, without its modeling node, and paste the nugget into a new

stream (or into a SuperNode that does not contain the modeling node), the link is broken and
only the nugget is pasted.

Model Links and SuperNodes

If you define a SuperNode to include either the modeling node or the model nugget of a linked
model (but not both), the link is broken. Expanding the SuperNode does not restore the link; you
can only do this by undoing creation of the SuperNode.
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Replacing a Model

You can choose whether to replace (that is, update) an existing nugget on re-execution of the
modeling node that created the nugget. If you turn off the replacement option, a new nugget is
created when you re-execute the modeling node.

Note: Replacing a model is different from refreshing a model, which refers to updating a model in
a scenario.

Each link from modeling node to nugget contains a symbol to indicate whether the model is
replaced when the modeling node is re-executed.

Figure 3-12
Model link with model replacement turned on
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The link is initially shown with model replacement turned on, depicted by the small sunburst
symbol in the link. In this state, re-executing the modeling node at one end of the link simply
updates the nugget at the other end.

Figure 3-13
Model link with model replacement turned off
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If model replacement is turned off, the link symbol is replaced by a gray dot. In this state,
re-executing the modeling node at one end of the link adds a new, updated version of the nugget to
the canvas.

In either case, in the Models palette the existing nugget is updated or a new nugget is added,
depending on the setting of the Replace previous model system option. ).

Order of Execution

When you execute a stream with multiple branches containing model nuggets, the stream is first
evaluated to make sure that a branch with model replacement turned on is executed before any
branch that uses the resulting model nugget.

If your requirements are more complex, you can set the order of execution manually through
scripting.
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Changing the Model Replacement Setting

To change the setting for model replacement:
» Right-click on the symbol on the link.

» Choose Turn On(Off) Model Replacement as desired.

Note: The model replacement setting on a model link overrides the setting on the Notifications tab
of the User Options dialog (Tools > Options > User Options).

The Models Palette

The models palette (on the Models tab in the managers window) allows you to use, examine,
and modify model nuggets in various ways.

Figure 3-14
Models palette
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Right-clicking a model nugget in the models palette opens a context menu with the following
options:

Figure 3-15
Model nugget context menu
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m  Add To Stream. Adds the model nugget to the currently active stream. If there is a selected
node in the stream, the model nugget will be connected to the selected node when such a
connection is possible, or otherwise to the nearest possible node. The nugget is displayed with
a link to the modeling node that created the model, if that node is still in the stream.

Browse. Opens the model browser for the nugget.
Rename and Annotate. Allows you to rename the model nugget and/or modify the annotation
for the nugget.

m  Generate Modeling Node. If you have a model nugget that you want to modify or update and
the stream used to create the model is not available, you can use this option to recreate a
modeling node with the same options used to create the original model.

m  Save Model, Save Model As. Saves the model nugget to an external generated model (.gm)
binary file.

m  Store Model. Stores the model nugget in IBM® SPSS® Collaboration and Deployment
Services Repository.

m  Export PMML. Exports the model nugget as predictive model markup language (PMML),
which can be used for scoring new data outside of IBM® SPSS® Modeler. Export PMML is
available for all generated model nodes. Note: A license for IBM® SPSS® Modeler Server is
required in order to use this feature.

m  Add to Project. Saves the model nugget and adds it to the current project. On the Classes tab,
the nugget will be added to the Generated Models folder. On the CRISP-DM tab, it will be
added to the default project phase.

m Delete. Deletes the model nugget from the palette.

Figure 3-16

Models palette context menu
Open Madel...
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% Retrieve Palette. .
Save Palette...

% Store Palette.
Clear Palette
Acdd Palette to Project
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Right-clicking an unoccupied area in the models palette opens a context menu with the following
options:

Open Model. Loads a model nugget previously created in SPSS Modeler.

Retrieve Model. Retrieves a stored model from an IBM SPSS Collaboration and Deployment
Services repository.

Load Palette. Loads a saved models palette from an external file.

Retrieve Palette. Retrieves a stored models palette from an IBM SPSS Collaboration and
Deployment Services repository.
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Save Palette. Saves the entire contents of the models palette to an external generated models
palette (.gen) file.

Store Palette. Stores the entire contents of the models palette in an IBM SPSS Collaboration
and Deployment Services repository.

Clear Palette. Deletes all nuggets from the palette.

Add Palette To Project. Saves the models palette and adds it to the current project. On the
Classes tab, the nugget will be added to the Generated Models folder. On the CRISP-DM tab,
it will be added to the default project phase.

Import PMML. Loads a model from an external file. You can open, browse, and score PMML
models created by IBM® SPSS® Statistics or other applications that support this format. For
more information, see the topic Importing and Exporting Models as PMML on p. [65.

Browsing Model Nuggets

The model nugget browsers allow you to examine and use the results of your models. From the
browser, you can save, print, or export the generated model, examine the model summary, and
view or edit annotations for the model. For some types of model nugget, you can also generate
new nodes, such as Filter nodes or Rule Set nodes. For some models, you can also view model
parameters, such as rules or cluster centers. For some types of models (tree-based models and
cluster models), you can view a graphical representation of the structure of the model. Controls
for using the model nugget browsers are described below.

Menus

File menu. All model nuggets have a File menu, containing some subset of the following options:

Save Node. Saves the model nugget to a node (.nod) file.

Store Node. Stores the model nugget in an IBM SPSS Collaboration and Deployment Services
repository.

Header and Footer. Allows you to edit the page header and footer for printing from the nugget.
Page Setup. Allows you to change the page setup for printing from the nugget.

Print Preview. Displays a preview of how the nugget will look when printed. Select the
information you want to preview from the submenu.

Print. Prints the contents of the nugget. Select the information you want to print from the
submenu.

Print View. Prints the current view or all views.

Export Text. Exports the contents of the nugget to a text file. Select the information you want
to export from the submenu.

Export HTML. Exports the contents of the nugget to an HTML file. Select the information you
want to export from the submenu.
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m  Export PMML. Exports the model as predictive model markup language (PMML), which can be
used with other PMML-compatible software. For more information, see the topic
and Exporting Models as PMML on p. [65.Note: A license for IBM® SPSS® Modeler Server
is required in order to use this feature.

m  Export SQL. Exports the model as structured query language (SQL), which can be edited and
used with other databases.

Note: SQL Export is available only from the following models: C5, C&RT, CHAID, QUEST,
Linear Regression, Logistic Regression, Neural Net, PCA/Factor, and Decision List models.

m  Publish for Server Scoring Adapter. Publishes the model to a database that has a scoring adapter
installed, enabling model scoring to be performed within the database. For more information,
see the topic [Publishing Models for a Scoring Adapter on p. 68|

Generate menu. Most model nuggets also have a Generate menu, allowing you to generate new
nodes based on the model nugget. The options available from this menu will depend on the type
of model you are browsing. See the specific model nugget type for details about what you can
generate from a particular model.

View menu. On the Model tab of a nugget, this menu enables you to display or hide the various
visualization toolbars that are available in the current mode. To make the full set of toolbars
available, select Edit Mode (the paintbrush icon) from the General toolbar.

Preview button. Some model nuggets have a Preview button, which enables you to see a sample of
the model data, including the extra fields created by the modeling process. The default number of
rows displayed is 10; however, you can change this in the stream properties.

Add to Current Project button. Saves the model nugget and adds it to the current project. On the
Classes tab, the nugget will be added to the Generated Models folder. On the CRISP-DM tab,
it will be added to the default project phase.

Model Nugget Summary / Information

The Summary tab or Information view for a model nugget displays information about the fields,
build settings, and model estimation process. Results are presented in a tree view that can be
expanded or collapsed by clicking specific items.

Analysis. Displays information about the model. Specific details vary by model type, and are
covered in the section for each model nugget. In addition, if you have executed an Analysis node
attached to this modeling node, information from that analysis will also be displayed in this section.

Fields. Lists the fields used as the target and the inputs in building the model. For split models,
also lists the fields that determined the splits.

Build Settings / Options. Contains information about the settings used in building the model.

Training Summary. Shows the type of model, the stream used to create it, the user who created it,
when it was built, and the elapsed time for building the model.
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Predictor Importance

Typically, you will want to focus your modeling efforts on the predictor fields that matter most
and consider dropping or ignoring those that matter least. The predictor importance chart helps
you do this by indicating the relative importance of each predictor in estimating the model. Since
the values are relative, the sum of the values for all predictors on the display is 1.0. Predictor
importance does not relate to model accuracy. It just relates to the importance of each predictor in
making a prediction, not whether or not the prediction is accurate.

Figure 3-17
Predictor importance chart
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Predictor importance is available for models that produce an appropriate statistical measure of
importance, including neural networks, decision trees (C&R Tree, C5.0, CHAID, and QUEST),
Bayesian networks, discriminant, SVM, and SLRM models, linear and logistic regression,
generalized linear, and nearest neighbor (KNN) models. For most of these models, predictor
importance can be enabled on the Analyze tab in the modeling node. For more information, see
the topic Modeling Node Analyze Options on p. 39. For KNN models, see Neighbors on p. #67.
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Note: Predictor importance is not supported for split models. Predictor importance settings are
ignored when building split models. For more information, see the topic [Building Split Models

on p. B0.

Calculating predictor importance may take significantly longer than model building, particularly
when using large datasets. It takes longer to calculate for SVM and logistic regression than for
other models, and is disabled for these models by default. If using a dataset with a large number of
predictors, initial screening using a Feature Selection node may give faster results (see below).

B Predictor importance is calculated from the test partition, if available. Otherwise the training
data is used.

®  For SLRM models, predictor importance is available but is computed by the SLRM algorithm.
For more information, see the topic SLRM Model Nuggets in Chapter 14 on p. #51.

You can use IBM® SPSS® Modeler’s graph tools to interact, edit, and save the graph.

Optionally, you can generate a Filter node based on the information in the predictor importance
chart. For more information, see the topic [Filtering Variables Based on Importance on p. [52.

Predictor Importance and Feature Selection

The predictor importance chart displayed in a model nugget may seem to give results similar to
the Feature Selection node in some cases. While feature selection ranks each input field based on
the strength of its relationship to the specified target, independent of other inputs, the predictor
importance chart indicates the relative importance of each input for this particular model. Thus
feature selection will be more conservative in screening inputs. For example, if job title and job
category are both strongly related to salary, then feature selection would indicate that both are
important. But in modeling, interactions and correlations are also taken into consideration. Thus
you might find that only one of two inputs is used if both duplicate much of the same information.
In practice, feature selection is most useful for preliminary screening, particularly when dealing
with large datasets with large numbers of variables, and predictor importance is more useful in
fine-tuning the model.

Filtering Variables Based on Importance

Optionally, you can generate a Filter node based on the information in the predictor importance
chart.

Mark the predictors you want to include on the chart, if applicable, and from the menus choose:
Generate > Filter Node (Predictor Importance)

OR
> Field Selection (Predictor Importance)
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Figure 3-18
Filtering predictors based on importance
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Top number of variables. Includes or excludes the most important predictors up to the specified
number.

Importance greater than. Includes or excludes all predictors with relative importance greater than
the specified value.

Models for Ensembles

The model for an ensemble provides information about the component models in the ensemble
and the performance of the ensemble as a whole.

Figure 3-19
Model Summary view
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The main (view-independent) toolbar allows you to choose whether to use the ensemble or a
reference model for scoring. If the ensemble is used for scoring you can also select the combining
rule. These changes do not require model re-execution; however, these choices are saved to

the model (nugget) for scoring and/or downstream model evaluation. They also affect PMML
exported from the ensemble viewer.

Combining Rule. When scoring an ensemble, this is the rule used to combine the predicted values
from the base models to compute the ensemble score value.

m  Ensemble predicted values for categorical targets can be combined using voting, highest
probability, or highest mean probability. Voting selects the category that has the highest
probability most often across the base models. Highest probability selects the category that
achieves the single highest probability across all base models. Highest mean probability
selects the category with the highest value when the category probabilities are averaged
across base models.

®  Ensemble predicted values for continuous targets can be combined using the mean or median
of the predicted values from the base models.

The default is taken from the specifications made during model building. Changing the combining
rule recomputes the model accuracy and updates all views of model accuracy. The Predictor
Importance chart also updates. This control is disabled if the reference model is selected for
scoring.

Show All Combining rules. When selected , results for all available combining rules are shown in
the model quality chart. The Component Model Accuracy chart is also updated to show reference
lines for each voting method.
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Model Summary

Figure 3-20
Model Summary view
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The Model Summary view is a snapshot, at-a-glance summary of the ensemble quality and
diversity.

Quality. The chart displays the accuracy of the final model, compared to a reference model and

a naive model. Accuracy is presented in larger is better format; the “best” model will have the
highest accuracy. For a categorical target, accuracy is simply the percentage of records for which
the predicted value matches the observed value. For a continuous target, accuracy is 1 minus the
ratio of the mean absolute error in prediction (the average of the absolute values of the predicted
values minus the observed values) to the range of predicted values (the maximum predicted
value minus the minimum predicted value).

For bagging ensembles, the reference model is a standard model built on the whole training
partition. For boosted ensembles, the reference model is the first component model.
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The naive model represents the accuracy if no model were built, and assigns all records to the
modal category. The naive model is not computed for continuous targets.

Diversity. The chart displays the “diversity of opinion” among the component models used to build
the ensemble, presented in larger is more diverse format. It is a measure of how much predictions
vary across the base models. Diversity is not available for boosted ensemble models, nor is it
shown for continuous targets.

Predictor Importance

Figure 3-21
Predictor Importance view
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Typically, you will want to focus your modeling efforts on the predictor fields that matter most
and consider dropping or ignoring those that matter least. The predictor importance chart helps
you do this by indicating the relative importance of each predictor in estimating the model. Since
the values are relative, the sum of the values for all predictors on the display is 1.0. Predictor
importance does not relate to model accuracy. It just relates to the importance of each predictor in
making a prediction, not whether or not the prediction is accurate.

Predictor importance is not available for all ensemble models. The predictor set may vary
across component models, but importance can be computed for predictors used in at least one
component model.
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Predictor Frequency

Figure 3-22
Predictor Frequency view
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The predictor set can vary across component models due to the choice of modeling method or
predictor selection. The Predictor Frequency plot is a dot plot that shows the distribution of
predictors across component models in the ensemble. Each dot represents one or more component
models containing the predictor. Predictors are plotted on the y-axis, and are sorted in descending
order of frequency; thus the topmost predictor is the one that is used in the greatest number of
component models and the bottommost one is the one that was used in the fewest. The top 10
predictors are shown.

Predictors that appear most frequently are typically the most important. This plot is not useful for
methods in which the predictor set cannot vary across component models.
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Component Model Accuracy

Figure 3-23
Component Model Accuracy view
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The chart is a dot plot of predictive accuracy for component models. Each dot represents one or
more component models with the level of accuracy plotted on the y-axis. Hover over any dot to
obtain information on the corresponding individual component model.

Reference lines. The plot displays color coded lines for the ensemble as well as the reference
model and naive models. A checkmark appears next to the line corresponding to the model
that will be used for scoring.

Interactivity. The chart updates if you change the combining rule.

Boosted ensembles. A line chart is displayed for boosted ensembles.
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Figure 3-24
Ensemble Accuracy view, boosted ensemble
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Component Model Details

Figure 3-25
Component Model Details view
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The table displays information on component models, listed by row. By default, component
models are sorted in ascending model number order. You can sort the rows in ascending or
descending order by the values of any column.

Model. A number representing the sequential order in which the component model was created.
Accuracy. Overall accuracy formatted as a percentage.

Method. The modeling method.

Predictors. The number of predictors used in the component model.

Model Size. Model size depends on the modeling method: for trees, it is the number of nodes in
the tree; for linear models, it is the number of coefficients; for neural networks, it is the number of
synapses.

Records. The weighted number of input records in the training sample.
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Automatic Data Preparation

Figure 3-26
Automatic Data Preparation view
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If the ariginal field name is X, then the transformed field name is
¥_transformed. The original field is excluded from the analysis and the
transformed field is included instead.

This view shows information about which fields were excluded and how transformed fields were
derived in the automatic data preparation (ADP) step. For each field that was transformed or
excluded, the table lists the field name, its role in the analysis, and the action taken by the ADP
step. Fields are sorted by ascending alphabetical order of field names.

The action Trim outliers, if shown, indicates that values of continuous predictors that lie beyond a
cutoff value (3 standard deviations from the mean) have been set to the cutoff value.

Model Nuggets for Split Models

The model nugget for a split model provides access to all the separate models created by the splits.

A split-model nugget contains:
B alist of all the split models created, together with a set of statistics about each model

B information about the overall model

From the list of split models, you can open up individual models to examine them further.

Split Model Viewer

The Model tab lists all the models contained in the nugget, and provides statistics in various forms
about the split models. It has two general forms, depending on the modeling node, as follows.
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Figure 3-27
Split model viewer
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Sort by. Use this list to choose the order in which the models are listed. You can sort the list based
on the values of any of the display columns, in ascending or descending order. Alternatively,
click on a column heading to sort the list by that column. Default is descending order of overall
accuracy.

Show/hide columns menu. Click this button to display a menu from where you can choose
individual columns to show or hide.

View. If you are using partitioning, you can choose to view the results for either the training
data or the testing data.

For each split, the details shown are as follows:

Graph. A thumbnail indicating the data distribution for this model. When the nugget is on the
canvas, double-click the thumbnail to open the full-size graph.

Model. An icon of the model type. Double-click the icon to open the model nugget for this
particular split.

Split fields. The fields designated in the modeling node as split fields, with their various possible
values.

No. Records in Split. The number of records involved in this particular split.

No. Fields Used. Ranks split models based on the number of input fields used.
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Overall Accuracy (%). The percentage of records that is correctly predicted by the split model
relative to the total number of records in that split.

Figure 3-28
Split model viewer

Split Groups
ed s Accuraq% ?‘S';,T]‘;ngrseé Records™
Did not complete high school B8.3% 62 372
High schoal degree B6.5% 42 198
Some college 72.3% 42 87
College degree 59.2% 12 38
Post-undergraduate degree

Maodels could not be built for one or more split groups.

Split. The column heading shows the field(s) used to create splits, and the cells are the split values.
Double-click on any split to open a Model Viewer for the model built for that split.

Accuracy. Overall accuracy formatted as a percentage.

Model Size. Model size depends on the modeling method: for trees, it is the number of nodes in
the tree; for linear models, it is the number of coefficients; for neural networks, it is the number of
synapses.

Records. The weighted number of input records in the training sample.

Using Model Nuggets in Streams

Model nuggets are placed in streams to enable you to score new data and generate new nodes.
Scoring data allows you to use the information gained from model building to create predictions
for new records. To see the results of scoring, you need to attach a terminal node (that is, a
processing or output node) to the nugget and execute the terminal node.

For some models, model nuggets can also give you additional information about the quality of the
prediction, such as confidence values or distances from cluster centers. Generating new nodes
allows you to easily create new nodes based on the structure of the generated model. For example,
most models that perform input field selection allow you to generate Filter nodes that will pass
only input fields that the model identified as important.

To Use a Model Nugget for Scoring Data

» Connect the model nugget to a data source or stream that will pass data to it.
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Figure 3-29
Using a model nugget for scoring
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» Add or connect one or more processing or output nodes (such as a Table or Analysis node) to the
model nugget.

» Execute one of the nodes downstream from the model nugget.

Note: You cannot use the Unrefined Rule node for scoring data. To score data based on an
association rule model, use the Unrefined Rule node to generate a Rule Set nugget, and use the
Rule Set nugget for scoring. For more information, see the topic Generating a Rule Set from ar
Association Model Nugget in Chapter 12 on p. 398.

To Use a Model Nugget for Generating Processing Nodes
» On the palette, browse the model, or, on the stream canvas, edit the model.

» Select the desired node type from the Generate menu of the model nugget browser window. The
options available will vary, depending on the type of model nugget. See the specific model nugget
type for details about what you can generate from a particular model.

Regenerating a Modeling Node

If you have a model nugget that you want to modify or update and the stream used to create
the model is not available, you can regenerate a modeling node with the same options used to
create the original model.

» To rebuild a model, right-click on the model in the models palette and choose Generate Modeling
Node.

» Alternatively, when browsing any model, choose Generate Modeling Node from the Generate menu.
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The regenerated modeling node should be functionally identical to the one used to create the
original model in most cases.

m  For Decision Tree models, additional settings specified during the interactive session may also
be stored with the node, and the Use tree directives option will be enabled in the regenerated
modeling node.

m  For Decision List models, the Use saved interactive session information option will be enabled.
For more information, see the topic [Decision List Model Options|in Chapter 9 on p. 209,

m  For Time Series models, the Continue estimation using existing model(s) option is enabled,
allowing you to regenerate the previous model with current data. For more information, see
the topic Time Series Model Options in Chapter 13 on p. #27.

Importing and Exporting Models as PMML

PMML, or predictive model markup language, is an XML format for describing data mining

and statistical models, including inputs to the models, transformations used to prepare data for
data mining, and the parameters that define the models themselves. IBM® SPSS® Modeler can
import and export PMML, making it possible to share models with other applications that support
this format, such as IBM® SPSS® Statistics.

For more information about PMML, see the Data Mining Group website (http://www.dmg.org).
To Export a Model

PMML export is supported for most of the model types generated in SPSS Modeler. For more
information, see the topic Model Types Supporting PMML on p. 67,

» Right-click a model nugget on the models palette. (Alternatively, double-click a model nugget on
the canvas and select the File menu.)

» On the menu, click Export PMML.

Figure 3-30
Exporting a model in PMML format
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» In the Export (or Save) dialog box, specify a target directory and a unique name for the model.
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Note: You can change options for PMML export in the User Options dialog box. On the main
menu, click:
Tools > Options > User Options

and click the PMML tab.

To Import a Model Saved as PMML

Models exported as PMML from SPSS Modeler or another application can be imported into the
models palette. For more information, see the topic Model Types Supporting PMML on p. [67.

» In the models palette, right-click the palette and select Import PMML from the menu.

Figure 3-31
Importing a model in PMML format
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» Select the file to import and specify options for variable labels as required.

» Click Open.
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Figure 3-32
Selecting the XML file for a model saved using PMML
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Modeling Overview

Use variable labels if present in medel. The PMML may specify both variable names and variable
labels (such as Referrer ID for RefID) for variables in the data dictionary. Select this option to use

variable labels if they are present in the originally exported PMML.

If you have selected the variable label option but there are no variable labels in the PMML, the

variable names are used as normal.

Model Types Supporting PMML

PMML Export

SPSS Modeler models. The following models created in IBM® SPSS® Modeler can be exported
as PMML 4.0:

B C&R Tree

m QUEST

m CHAID

m Linear Regression

m  Neural Net
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C5.0

Logistic Regression
Genlin

SVM

Bayes Net
Apriori

Carma
K-Means
Kohonen
TwoStep

KNN

Statistics Model

The following model created in SPSS Modeler can be exported as PMML 3.2:

® Decision List

Database native models. For models generated using database-native algorithms, PMML export is
available for IBM InfoSphere Warehouse models only. Models created using Analysis Services
from Microsoft or Oracle Data Miner cannot be exported. Also note that IBM models exported as
PMML cannot be imported back into SPSS Modeler.

PMML Import

SPSS Modeler can import and score PMML models generated by current versions of all IBM®
SPSS® Statistics products, including models exported from SPSS Modeler as well as model or
transformation PMML generated by SPSS Statistics 17.0 or later. Essentially, this means any
PMML that the scoring engine can score, with the following exceptions:

m  Apriori, CARMA, Anomaly Detection, and Sequence models cannot be imported.

B PMML models may not be browsed after importing into SPSS Modeler even though they can
be used in scoring. (Note that this includes models that were exported from SPSS Modeler
to begin with. To avoid this limitation, export the model as a generated model file [* gm]
rather than PMML.)

IBM InfoSphere Warehouse models exported as PMML cannot be imported.

Limited validation occurs on import, but full validation is performed on attempting to score the
model. Thus it is possible for import to succeed but scoring to fail or produce incorrect results.

Publishing Models for a Scoring Adapter

You can publish models to a database server that has a scoring adapter installed. A scoring
adapter enables model scoring to be performed within the database by using the user-defined
function (UDF) capabilities of the database. Performing scoring in the database avoids the need
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to extract the data before scoring. Publishing to a scoring adapter also generates some example
SQL to execute the UDF.

To publish to a scoring adapter
» Double-click the model nugget to open it.

» From the model nugget menu, choose:
File > Publish for Server Scoring Adapter

» Fill in the relevant fields on the dialog box and click OK.
Database connection. The connection details for the database you want to use for the model.

Publish ID. (DB2 for z/OS databases only) An identifier for the model. If you rebuild the same
model and use the same publish ID, the generated SQL remains the same, so it is possible to
rebuild a model without having to change the application that uses the SQL previously generated.
(For other databases the generated SQL is unique to the model.)

Generate Example SOL. If selected, generates the example SQL into the file specified in the File field.

Unrefined Models

An unrefined model contains information extracted from the data but is not designed for
generating predictions directly. This means that it cannot be added to streams. Unrefined models
are displayed as “diamonds in the rough” on the generated models palette.

Figure 3-33

Unrefined model icon
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v

To see information about the unrefined rule model, right-click the model and choose Browse from
the context menu. Like other models generated in IBM® SPSS® Modeler, the various tabs
provide summary and rule information about the model created.

Generating nodes. The Generate menu enables you to create new nodes based on the rules.

m  Select Node. Generates a Select node to select records to which the currently selected rule
applies. This option is disabled if no rule is selected.

m  Rule set. Generates a Rule Set node to predict values for a single target field. For more
information, see the topic Generating a Rule Set from an Association Model Nuggef in
Chapter 12 on p. 98|
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Screening Fields and Records

Several modeling nodes can be used during the preliminary stages of an analysis in order to locate
fields and records that are most likely to be of interest in modeling. You can use the Feature
Selection node to screen and rank fields by importance and the Anomaly Detection node to locate
unusual records that do not conform to the known patterns of “normal” data.

The Feature Selection node screens input fields for removal based on a set of criteria
(such as the percentage of missing values); it then ranks the importance of remaining
inputs relative to a specified target. For example, given a data set with hundreds of
potential inputs, which are most likely to be useful in modeling patient outcomes?
For more information, see the topic [Feature Selection Node| on p. [70.

(an |
=]

# The Anomaly Detection node identifies unusual cases, or outliers, that do not conform
to patterns of “normal” data. With this node, it is possible to identify outliers even if
% they do not fit any previously known patterns and even if you are not exactly sure

what you are looking for. For more information, see the topic [Anomaly Detection

Node on p. [77)

Note that anomaly detection identifies unusual records or cases through cluster analysis based on
the set of fields selected in the model without regard for any specific target (dependent) field and
regardless of whether those fields are relevant to the pattern you are trying to predict. For this
reason, you may want to use anomaly detection in combination with feature selection or another
technique for screening and ranking fields. For example, you can use feature selection to identify
the most important fields relative to a specific target and then use anomaly detection to locate the
records that are the most unusual with respect to those fields. (An alternative approach would be
to build a decision tree model and then examine any misclassified records as potential anomalies.
However, this method would be more difficult to replicate or automate on a large scale.)

Feature Selection Node

Data mining problems may involve hundreds, or even thousands, of fields that can potentially be
used as inputs. As a result, a great deal of time and effort may be spent examining which fields or
variables to include in the model. To narrow down the choices, the Feature Selection algorithm
can be used to identify the fields that are most important for a given analysis. For example, if
you are trying to predict patient outcomes based on a number of factors, which factors are the
most likely to be important?

Feature selection consists of three steps:

®m  Screening. Removes unimportant and problematic inputs and records, or cases such as input
fields with too many missing values or with too much or too little variation to be useful.

© Copyright IBM Corporation 1994, 2012. 70
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m  Ranking. Sorts remaining inputs and assigns ranks based on importance.

m  Selecting. Identifies the subset of features to use in subsequent models—for example, by
preserving only the most important inputs and filtering or excluding all others.

In an age where many organizations are overloaded with too much data, the benefits of feature
selection in simplifying and speeding the modeling process can be substantial. By focusing
attention quickly on the fields that matter most, you can reduce the amount of computation
required; more easily locate small but important relationships that might otherwise be overlooked;
and, ultimately, obtain simpler, more accurate, and more easily explainable models. By reducing
the number of fields used in the model, you may find that you can reduce scoring times as well as
the amount of data collected in future iterations.

Example. A telephone company has a data warehouse containing information about responses to a
special promotion by 5,000 of the company’s customers. The data includes a large number of
fields containing customers’ ages, employment, income, and telephone usage statistics. Three
target fields show whether or not the customer responded to each of three offers. The company
wants to use this data to help predict which customers are most likely to respond to similar
offers in the future.

Requirements. A single target field (one with its role set to Target), along with multiple input fields
that you want to screen or rank relative to the target. Both target and input fields can have a
measurement level of Continuous (numeric range) or Categorical.

Feature Selection Model Settings

The settings on the Model tab include standard model options along with settings that allow you to
fine-tune the criteria for screening input fields.

Figure 4-1
Feature Selection Model tab
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Model name. You can generate the model name automatically based on the target or ID field (or
model type in cases where no such field is specified) or specify a custom name.

Screening Input Fields

Screening involves removing inputs or cases that do not add any useful information with respect
to the input/target relationship. Screening options are based on attributes of the field in question
without respect to predictive power relative to the selected target field. Screened fields are
excluded from the computations used to rank inputs and optionally can be filtered or removed
from the data used in modeling.

Fields can be screened based on the following criteria:

®  Maximum percentage of missing values. Screens fields with too many missing values, expressed
as a percentage of the total number of records. Fields with a large percentage of missing
values provide little predictive information.

®  Maximum percentage of records in a single category. Screens fields that have too many records
falling into the same category relative to the total number of records. For example, if 95% of
the customers in the database drive the same type of car, including this information is not
useful in distinguishing one customer from the next. Any fields that exceed the specified
maximum are screened. This option applies to categorical fields only.

®  Maximum number of categories as a percentage of records. Screens fields with too many
categories relative to the total number of records. If a high percentage of the categories
contains only a single case, the field may be of limited use. For example, if every customer
wears a different hat, this information is unlikely to be useful in modeling patterns of behavior.
This option applies to categorical fields only.

®  Minimum coefficient of variation. Screens fields with a coefficient of variance less than or equal
to the specified minimum. This measure is the ratio of the input field standard deviation to the
mean of the input field. If this value is near zero, there is not much variability in the values for
the variable. This option applies to continuous (numeric range) fields only.

®  Minimum standard deviation. Screens fields with standard deviation less than or equal to the
specified minimum. This option applies to continuous (numeric range) fields only.

Records with missing data. Records or cases that have missing values for the target field, or missing
values for all inputs, are automatically excluded from all computations used in the rankings.

Feature Selection Options

The Options tab allows you to specify the default settings for selecting or excluding input fields in
the model nugget. You can then add the model to a stream to select a subset of fields for use in
subsequent model-building efforts. Alternatively, you can override these settings by selecting

or deselecting additional fields in the model browser after generating the model. However, the
default settings make it possible to apply the model nugget without further changes, which may
be particularly useful for scripting purposes.

For more information, see the topic [Feature Selection Model Results on p. [74|.
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Feature Selection Options tab
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The following options are available:

Screening Models

All fields ranked. Selects fields based on their ranking as important, marginal, or unimportant.
You can edit the label for each ranking as well as the cutoff values used to assign records to

one rank or another.

Top number of fields. Selects the top n fields based on importance.

Importance greater than. Selects all fields with importance greater than the specified value.

The target field is always preserved regardless of the selection.

Importance Ranking Options

All categorical. When all inputs and the target are categorical, importance can be ranked based on

any of four measures:

m  Pearson chi-square. Tests for independence of the target and the input without indicating the

strength or direction of any existing relationship.

m Likelihood-ratio chi-square. Similar to Pearson’s chi-square but also tests for target-input

independence.

m  Cramer's V. A measure of association based on Pearson’s chi-square statistic. Values range
from 0, which indicates no association, to 1, which indicates perfect association.

m Lambda. A measure of association reflecting the proportional reduction in error when the
variable is used to predict the target value. A value of 1 indicates that the input field perfectly
predicts the target, while a value of 0 means the input provides no useful information about

the target.
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Some categorical. When some—but not all—inputs are categorical and the target is also
categorical, importance can be ranked based on either the Pearson or likelihood-ratio chi-square.
(Cramer’s V and lambda are not available unless all inputs are categorical.)

Categorical versus continuous. When ranking a categorical input against a continuous target or
vice versa (one or the other is categorical but not both), the F statistic is used.

Both continuous. When ranking a continuous input against a continuous target, the 7 statistic
based on the correlation coefficient is used.

Feature Selection Model Nuggets

Feature Selection model nuggets display the importance of each input relative to a selected target,
as ranked by the Feature Selection node. Any fields that were screened out prior to the ranking are
also listed. For more information, see the topic Feature Selection Node| on p. (70|

When you run a stream containing a Feature Selection model nugget, the model acts as a filter
that preserves only selected inputs, as indicated by the current selection on the Model tab. For
example, you could select all fields ranked as important (one of the default options) or manually
select a subset of fields on the Model tab. The target field is also preserved regardless of the
selection. All other fields are excluded.

Filtering is based on the field name only; for example, if you select age and income, any field
that matches either of these names will be preserved. The model does not update field rankings
based on new data; it simply filters fields based on the selected names. For this reason, care
should be used in applying the model to new or updated data. When in doubt, regenerating
the model is recommended.

Feature Selection Model Results

The Model tab for a Feature Selection model nugget displays the rank and importance of all
inputs in the upper pane and allows you to select fields for filtering by using the check boxes
in the column on the left. When you run the stream, only the checked fields are preserved.
The other fields are discarded. The default selections are based on the options specified in the
model-building node, but you can select or deselect additional fields as needed.

The lower pane lists inputs that have been excluded from the rankings based on the percentage
of missing values or on other criteria specified in the modeling node. As with the ranked fields,
you can choose to include or discard these fields by using the check boxes in the column on the
left. For more information, see the topic [Feature Selection Model Settings on p. [71.
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Figure 4-3
Feature Selection model results

E] response_01

>

L:’i File ’@ Generate

MUC{E'; Summary | Annotstions

T o 1

Rank Field Measurement Impaortance Walue
m 1 {} e f Continuous Important 1.0 e
m 2 {} ownpc ‘i‘) Mominal Important 1.0
[+ 343 edcat Il Ordiral Important 1.0
[+ 4 {3 internet @0 Momiral Important 1.0
m B {} eGuip ‘i‘) Mominal Important 1.0
m [ {} oW NS e ‘i‘) Mominal Important 1.0
m 7 {{r} eGuipmon f Continuous Important 1.0
B g {:} confer &) Mominal Important 10
[+ 93 ehil @0 Momiral Important 1.0
[+ 1003 callwait @0 Momiral Important 1.0
B 1 {:} forward &) Mominal Important 10
B 12 {%*}tollmon f Continuous Important 10
[+ 133 mutling @0 Momiral Important 1.0
B 14 {:} oy o &) Mominal Important 10
[+ 153 calid @0 Momiral Important 1.0
B 16 {3}} equipten f Continuous Important 10
[+ 17 /{3 tolifree @0 Momiral Important 1.0
@ 15 {i}}tolrten & Continuous Important 10
@ 19 {} churn &) Mominal Important 10 ||
A 0N srnnsadeat _ll Ceclinst [l st 10 il

Selected fields: 34 Total fields available: 125
‘ B-085 [F==095 [=]<03

9 Screened Fields

Field Measurement Reazan
[T <3 owrwer @it Mominsl Single categary too latge
[ 3 ownty g Mominsl Single categary too latge
[[] {3 ownovd gt Mominsl Single categary too latge
[ < owncd @b Mominsl Single categary too latge
[F {{#} Invireten f Cortinuous Too many missing values
[F {{#} Inwvirem. .. f Cortinuous Too many missing values
[T | Inecwin... 4 Cortinuaus Coefficient of varistion below threshold

m  To sort the list by rank, field name, importance, or any of the other displayed columns, click
on the column header. Or, to use the toolbar, select the desired item from the Sort By list, and
use the up and down arrows to change the direction of the sort.

B You can use the toolbar to check or uncheck all fields and to access the Check Fields dialog
box, which allows you to select fields by rank or importance. You can also press the Shift
and Ctrl keys while clicking on fields to extend the selection and use the spacebar to toggle
on or off a group of selected fields. For more information, see the topic Selecting Fields

by Importance on p. [76.

B The threshold values for ranking inputs as important, marginal, or unimportant are displayed
in the legend below the table. These values are specified in the modeling node. For more
information, see the topic [Feature Selection Options on p. [72.
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Selecting Fields by Importance

When scoring data using a Feature Selection model nugget, all fields selected from the list of
ranked or screened fields—as indicated by the check boxes in the column on the left—will be
preserved. Other fields will be discarded. To change the selection, you can use the toolbar to
access the Check Fields dialog box, which allows you to select fields by rank or importance.
Figure 4-4

Check fields dialog box

4 Check fields

©) Al fields marked

Impartant
|E| Marginal
|E| lz‘ Unimpartant

) [<]
@ Top number of fields E

(@) Importance greater than:

Lo J

All fields marked. Selects all fields marked as important, marginal, or unimportant.
Top number of fields. Allows you to select the top » fields based on importance.

Importance greater than. Selects all fields with importance greater than the specified threshold.

Generating a Filter from a Feature Selection Model

Based on the results of a Feature Selection model, you can generate one or more Filter nodes that
include or exclude subsets of fields based on importance relative to the specified target. While the
model nugget can also be used as a filter, this gives you the flexibility to experiment with different
subsets of fields without copying or modifying the model. The target field is always preserved by
the filter regardless of whether include or exclude is selected.

Figure 4-5
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Include/Exclude. You can choose to include or exclude fields—for example, to include the top 10
fields or exclude all fields marked as unimportant.

Selected fields. Includes or excludes all fields currently selected in the table.
All fields marked. Selects all fields marked as important, marginal, or unimportant.
Top number of fields. Allows you to select the top n fields based on importance.

Importance greater than. Selects all fields with importance greater than the specified threshold.

Anomaly Detection Node

Anomaly detection models are used to identify outliers, or unusual cases, in the data. Unlike
other modeling methods that store rules about unusual cases, anomaly detection models store
information on what normal behavior looks like. This makes it possible to identify outliers even if
they do not conform to any known pattern, and it can be particularly useful in applications, such
as fraud detection, where new patterns may constantly be emerging. Anomaly detection is an
unsupervised method, which means that it does not require a training dataset containing known
cases of fraud to use as a starting point.

While traditional methods of identifying outliers generally look at one or two variables at a
time, anomaly detection can examine large numbers of fields to identify clusters or peer groups
into which similar records fall. Each record can then be compared to others in its peer group to
identify possible anomalies. The further away a case is from the normal center, the more likely it
is to be unusual. For example, the algorithm might lump records into three distinct clusters and
flag those that fall far from the center of any one cluster.

Figure 4-6
Using clustering to identify potential anomalies
Record A
X
XX X
Xy X
X2 x xX
XXX X
X x XX X
XX Xy X X X
X X x X
X X X
¥ X
x x X Record B
X
X X
- x Xy
3 23y
XX X
> WXy
KX
X
Record C

K-Axis



78

Chapter 4

Each record is assigned an anomaly index, which is the ratio of the group deviation index to its
average over the cluster that the case belongs to. The larger the value of this index, the more
deviation the case has than the average. Under the usual circumstance, cases with anomaly index
values less than 1 or even 1.5 would not be considered as anomalies, because the deviation is just
about the same or a bit more than the average. However, cases with an index value greater than 2
could be good anomaly candidates because the deviation is at least twice the average.

Anomaly detection is an exploratory method designed for quick detection of unusual cases
or records that should be candidates for further analysis. These should be regarded as suspected
anomalies, which, on closer examination, may or may not turn out to be real. You may find that
a record is perfectly valid but choose to screen it from the data for purposes of model building.
Alternatively, if the algorithm repeatedly turns up false anomalies, this may point to an error or
artifact in the data collection process.

Note that anomaly detection identifies unusual records or cases through cluster analysis based
on the set of fields selected in the model without regard for any specific target (dependent) field
and regardless of whether those fields are relevant to the pattern you are trying to predict. For this
reason, you may want to use anomaly detection in combination with feature selection or another
technique for screening and ranking fields. For example, you can use feature selection to identify
the most important fields relative to a specific target and then use anomaly detection to locate the
records that are the most unusual with respect to those fields. (An alternative approach would be
to build a decision tree model and then examine any misclassified records as potential anomalies.
However, this method would be more difficult to replicate or automate on a large scale.)

Example. In screening agricultural development grants for possible cases of fraud, anomaly
detection can be used to discover deviations from the norm, highlighting those records that are
abnormal and worthy of further investigation. You are particularly interested in grant applications
that seem to claim too much (or too little) money for the type and size of farm.

Requirements. One or more input fields. Note that only fields with a role set to Input using a source
or Type node can be used as inputs. Target fields (role set to Target or Both) are ignored.

Strengths. By flagging cases that do not conform to a known set of rules rather than those that do,
Anomaly Detection models can identify unusual cases even when they don’t follow previously
known patterns. When used in combination with feature selection, anomaly detection makes it
possible to screen large amounts of data to identify the records of greatest interest relatively
quickly.
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Anomaly Detection Model Options

Figure 4-7
Anomaly Detection Model tab
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Model name. You can generate the model name automatically based on the target or ID field (or
model type in cases where no such field is specified) or specify a custom name.

Determine cutoff value for anomaly based on. Specifies the method used to determine the cutoff
value for flagging anomalies. The following options are available:

®  Minimum anomaly index level. Specifies the minimum cutoff value for flagging anomalies.
Records that meet or exceed this threshold are flagged.

m  Percentage of most anomalous records in the training data. Automatically sets the threshold at a
level that flags the specified percentage of records in the training data. The resulting cutoff is
included as a parameter in the model. Note that this option determines how the cutoff value is
set, not the actual percentage of records to be flagged during scoring. Actual scoring results
may vary depending on the data.

®  Number of most anomalous records in the training data. Automatically sets the threshold at a
level that flags the specified number of records in the training data. The resulting threshold is
included as a parameter in the model. Note that this option determines how the cutoff value is
set, not the specific number of records to be flagged during scoring. Actual scoring results
may vary depending on the data.

Note: Regardless of how the cutoff value is determined, it does not affect the underlying anomaly
index value reported for each record. It simply specifies the threshold for flagging records as
anomalous when estimating or scoring the model. If you later want to examine a larger or smaller
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number of records, you can use a Select node to identify a subset of records based on the anomaly
index value ($0-Anomalyindex > X).

Number of anomaly fields to report. Specifies the number of fields to report as an indication of why
a particular record is flagged as an anomaly. The most anomalous fields are reported, defined as
those that show the greatest deviation from the field norm for the cluster to which the record is
assigned.

Anomaly Detection Expert Options

To specify options for missing values and other settings, set the mode to Expert on the Expert tab.

Figure 4-8
Anomaly Detection Expert tab
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Adjustment coefficient. Value used to balance the relative weight given to continuous (numeric
range) and categorical fields in calculating the distance. Larger values increase the influence of
continuous fields. This must be a nonzero value.

Automatically calculate number of peer groups. Anomaly detection can be used to rapidly analyze a
large number of possible solutions to choose the optimal number of peer groups for the training
data. You can broaden or narrow the range by setting the minimum and maximum number of
peer groups. Larger values will allow the system to explore a broader range of possible solutions;
however, the cost is increased processing time.
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Specify number of peer groups. If you know how many clusters to include in your model, select
this option and enter the number of peer groups. Selecting this option will generally result
in improved performance.

Noise level and ratio. These settings determine how outliers are treated during two-stage clustering.
In the first stage, a cluster feature (CF) tree is used to condense the data from a very large number
of individual records to a manageable number of clusters. The tree is built based on similarity
measures, and when a node of the tree gets too many records in it, it splits into child nodes. In
the second stage, hierarchical clustering commences on the terminal nodes of the CF tree. Noise
handling is turned on in the first data pass, and it is off in the second data pass. The cases in the
noise cluster from the first data pass are assigned to the regular clusters in the second data pass.

®  Noise level. Specify a value between 0 and 0.5. This setting is relevant only if the CF tree
fills during the growth phase, meaning that it cannot accept any more cases in a leaf node
and that no leaf node can be split.

If the CF tree fills and the noise level is set to 0, the threshold will be increased and the CF
tree regrown with all cases. After final clustering, values that cannot be assigned to a cluster
are labeled outliers. The outlier cluster is given an identification number of —1. The outlier
cluster is not included in the count of the number of clusters; that is, if you specify n clusters
and noise handling, the algorithm will output z clusters and one noise cluster. In practical
terms, increasing this value gives the algorithm more latitude to fit unusual records into the
tree rather than assign them to a separate outlier cluster.

If the CF tree fills and the noise level is greater than 0, the CF tree will be regrown after
placing any data in sparse leaves into their own noise leaf. A leaf is considered sparse if the
ratio of the number of cases in the sparse leaf to the number of cases in the largest leaf is less
than the noise level. After the tree is grown, the outliers will be placed in the CF tree if
possible. If not, the outliers are discarded for the second phase of clustering.

®  Noise ratio. Specifies the portion of memory allocated for the component that should be used
for noise buffering. This value ranges between 0.0 and 0.5. If inserting a specific case into
a leaf of the tree would yield tightness less than the threshold, the leaf is not split. If the
tightness exceeds the threshold, the leaf is split, adding another small cluster to the CF tree.
In practical terms, increasing this setting may cause the algorithm to gravitate more quickly
toward a simpler tree.

Impute missing values. For continuous fields, substitutes the field mean in place of any missing
values. For categorical fields, missing categories are combined and treated as a valid category. If
this option is deselected, any records with missing values are excluded from the analysis.

Anomaly Detection Model Nuggets

Anomaly Detection model nuggets contain all of the information captured by the Anomaly
Detection model as well as information about the training data and estimation process.
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When you run a stream containing an Anomaly Detection model nugget, a number of new fields
are added to the stream, as determined by the selections made on the Settings tab in the model
nugget. For more information, see the topic [Anomaly Detection Model Settings on p. 4. New
field names are based on the model name, prefaced by $0, as summarized in the following table:

30-Anomaly Flag field indicating whether or not the record is
anomalous.

30-Anomalylndex The anomaly index value for the record.

$0-PeerGroup Specifies the peer group to which the record is
assigned.

30-Field-n Name of the nth most anomalous field in terms of
deviation from the cluster norm.

$0-Fieldlmpact-n Variable deviation index for the field. This value
measures the deviation from the field norm for the
cluster to which the record is assigned.

Optionally, you can suppress scores for non-anomalous records to make the results easier to read.

Figure 4-9
Scoring results with non-anomalous records suppressed
[ Table (19 fields, 10 records) [Z]@}
|@ File | Edit ) Generate i B ﬂ
Table | Annotations
id  |$o-snomaly |$O-snomalyindex | $0-PeerGroup | $OField1 | O-Fieldmpact-1 $O-Field-2 | $0-Fisldimpact-2 |
1 633 T 1600 2 claittvalue 0.355 fartmincome 0.275
2 647 T 1.403 2 farminco... 0.334 clairmvalue 0161
3 654 T 1.495 2 rainfall 0.322 maincrop 0181
4 i70E T 1358 1 rainfall 0230 region 02139
5 idf04 T 1.427 2 farminco... 0287 maincrop 0,190
] 739 T 1 654 2 claittvalue 0.404 fartmincome 0.233
7 a2 T 1.770 2 clairrvalue 0.351 fartmincome 0.155
5 i1 T 1.3586 1 maincrop  0.236 raintal 0163
g oS3 T 1641 1 region 0.1&1 landguality 0,160
10 iSa3 T 1.350 2 region 0187 maincrop 0169
T —— [*]

Anomaly Detection Model Details

The Model tab for a generated Anomaly Detection model displays information about the peer
groups in the model.
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Figure 4-10
Anomaly Detection model nugget details
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Screening Models

Note that the peer group sizes and statistics reported are estimates based on the training data and

may differ slightly from actual scoring results even if run on the same data.

Anomaly Detection Model Summary

The Summary tab for an Anomaly Detection model nugget displays information about the fields,
build settings, and estimation process. The number of peer groups is also shown, along with the

cutoff value used to flag records as anomalous.
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Figure 4-11
Anomaly Detection model nugget summary
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Anomaly Detection Model Settings

The Settings tab allows you to specify options for scoring the model nugget.
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Figure 4-12
Scoring options for an Anomaly Detection model nugget
Ed Anomaly
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Indicate anomalous records with. Specifies how anomalous records are treated in the output.

m  Flag and index. Creates a flag field that is set to True for all records that exceed the cutoff value
included in the model. The anomaly index is also reported for each record in a separate field.
For more information, see the topic [Anomaly Detection Model Optiong on p. [79.

m  Flag only. Creates a flag field but without reporting the anomaly index for each record.

m Index only. Reports the anomaly index without creating a flag field.

Number of anomaly fields to report. Specifies the number of fields to report as an indication of why
a particular record is flagged as an anomaly. The most anomalous fields are reported, defined as
those that show the greatest deviation from the field norm for the cluster to which the record is
assigned.

Discard records. Select this option to discard all non-anomalous records from the stream, making
it easier to focus on potential anomalies in any downstream nodes. Alternatively, you can choose
to discard all anomalous records in order to limit the subsequent analysis to those records that are
not flagged as potential anomalies based on the model.

Note: Due to slight differences in rounding, the actual number of records flagged during scoring
may not be identical to those flagged while training the model even if run on the same data.
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The automated modeling nodes estimate and compare a number of different modeling methods,
allowing you to try out a variety of approaches in a single modeling run. You can select the
modeling algorithms to use, and the specific options for each, including combinations that would
otherwise be mutually-exclusive. For example, rather than choose between the quick, dynamic,
or prune methods for a Neural Net, you can try them all. The node explores every possible
combination of options, ranks each candidate model based on the measure you specify, and saves
the best for use in scoring or further analysis.

You can choose from three automated modeling nodes, depending on the needs of your analysis:

-

Cﬁii

The Auto Classifier node creates and compares a number of different models for
binary outcomes (yes or no, churn or do not churn, and so on), allowing you to
choose the best approach for a given analysis. A number of modeling algorithms are
supported, making it possible to select the methods you want to use, the specific
options for each, and the criteria for comparing the results. The node generates a set
of models based on the specified options and ranks the best candidates according to
the criteria you specify. For more information, see the topic [Auto Classifier Node

onp. §9.

The Auto Numeric node estimates and compares models for continuous numeric
range outcomes using a number of different methods. The node works in the same
manner as the Auto Classifier node, allowing you to choose the algorithms to use
and to experiment with multiple combinations of options in a single modeling pass.
Supported algorithms include neural networks, C&R Tree, CHAID, linear regression,
generalized linear regression, and support vector machines (SVM). Models can be
compared based on correlation, relative error, or number of variables used. For more
information, see the topic [Auto Numeric Nodef on p. P8.

The Auto Cluster node estimates and compares clustering models, which identify
groups of records that have similar characteristics. The node works in the same
manner as other automated modeling nodes, allowing you to experiment with multiple
combinations of options in a single modeling pass. Models can be compared using
basic measures with which to attempt to filter and rank the usefulness of the cluster
models, and provide a measure based on the importance of particular fields. For more

information, see the topic [Auto Cluster Node on p. [104].

The best models are saved in a single composite model nugget, allowing you to browse and
compare them, and to choose which models to use in scoring.

®  For binary, nominal, and numeric targets only you can select multiple scoring models and

combine the scores in a single model ensemble. By combining predictions from multiple
models, limitations in individual models may be avoided, often resulting in a higher overall

accuracy than can be gained from any one of the models.

®  Optionally, you can choose to drill down into the results and generate modeling nodes or

model nuggets for any of the individual models you want to use or explore further.

© Copyright IBM Corporation 1994, 2012. 86
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Models and Execution Time

Depending on the dataset and the number of models, automated modeling nodes may take hours
or even longer to execute. When selecting options, pay attention to the number of models being
produced. When practical, you may want to schedule modeling runs during nights or weekends
when system resources are less likely to be in demand.

®m If necessary, a Partition or Sample node can be used to reduce the number of records included
in the initial training pass. Once you have narrowed the choices to a few candidate models,
the full dataset can be restored.

®  To reduce the number of input fields, use Feature Selection. For more information, see the
topic Feature Selection Node| in Chapter 4 on p. [70. Alternatively, you can use your initial
modeling runs to identify fields and options that are worth exploring further. For example, if
your best-performing models all seem to use the same three fields, this is a strong indication
that those fields are worth keeping.

®  Optionally, you can limit the amount of time spent estimating any one model and specify the
evaluation measures used to screen and rank models.

Automated Modeling Node Algorithm Settings

For each model type, you can use the default settings, or you can choose options for each model
type. The specific options are similar to those available in the separate modeling nodes, with the
difference that rather than choosing one setting or another, you can choose as many as you want
to apply in most cases. For example, if comparing Neural Net models, you can choose several
different training methods, and try each method with and without a random seed. All possible
combinations of the selected options will be used, making it very easy to generate many different
models in a single pass. Use care, however, as choosing multiple settings can cause the number
of models to multiply very quickly.
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Figure 5-1
Choosing algorithm settings for automated modeling
| @] Algorithm settings - Generalized Linear
Parameter | Options |
Model type Main effects only
Offset “ariahle
Offzet field
Inciude irtercept in model true o=
Default
trie
falze
Eith
Simple || Expert
[ Ok ] [Cancel] [ Helg ]
To choose options for each model type
» On the automated modeling node, select the Expert tab.
» Click in the Model parameters column for the model type.
» From the drop-down menu, choose Specify.
» On the Algorithm settings dialog, select options from the Options column.

Note: Further options are available on the Expert tab of the Algorithm settings dialog.

Automated Modeling Node Stopping Rules

Stopping rules specified for automated modeling nodes relate to the overall node execution, not
the stopping of individual models built by the node.
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Figure 5-2
Stopping rules

Ed Stopping rules
[ Restrict overal execution time to 20 izl‘ hours

|| Stop az soon az valid models are produced

Restrict overall execution time. (Neural Network, K-Means, Kohonen, TwoStep, SVM, KNN,
Bayes Net and C&R Tree models only) Stops execution after a specified number of hours. All
models generated up to that point will be included in the model nugget, but no further models
will be produced.

Stop as soon as valid models are produced. Stops execution when a model passes all criteria
specified on the Discard tab (for the Auto Classifier or Auto Cluster node) or the Model tab (for the
Auto Numeric node). For more information, see the topic [Auto Classifier Node Discard Options|
on p. 96.For more information, see the topic [Auto Cluster Node Discard Options on p. [I109.

Auto Classifier Node

The Auto Classifier node estimates and compares models for either nominal (set) or binary
(yes/no) targets, using a number of different methods, allowing you to try out a variety of
approaches in a single modeling run. You can select the algorithms to use, and experiment
with multiple combinations of options. For example, rather than choose between the quick,
dynamic, or prune methods for a Neural Net, you can try them all. The node explores every
possible combination of options, ranks each candidate model based on the measure you specify,
and saves the best models for use in scoring or further analysis.For more information, see the
topic [Automated Modeling Nodes on p. 86,
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Figure 5-3
Auto Classifier modeling results
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Example. A retail company has historical data tracking the offers made to specific customers in
past campaigns. The company now wants to achieve more profitable results by matching the
right offer to each customer.

Requirements. A target field with a measurement level of either Nominal or Flag (with the role
set to Target), and at least one input field (with the role set to Input). For a flag field, the True
value defined for the target is assumed to represent a hit when calculating profits, lift, and related
statistics. Input fields can have a measurement level of Continuous or Categorical, with the
limitation that some inputs may not be appropriate for some model types. For example, ordinal
fields used as inputs in C&R Tree, CHAID, and QUEST models must have numeric storage (not
string), and will be ignored by these models if specified otherwise. Similarly, continuous input
fields can be binned in some cases. The requirements are the same as when using the individual
modeling nodes; for example a Bayes Net model works the same whether generated from the
Bayes Net node or the Auto Classifier node.

Frequency and weight fields. Frequency and weight are used to give extra importance to some
records over others because, for example, the user knows that the build dataset under-represents a
section of the parent population (Weight) or because one record represents a number of identical
cases (Frequency). If specified, a frequency field can be used by C&R Tree, CHAID, QUEST,
Decision List, and Bayes Net models. A weight field can be used by C&RT, CHAID, and C5.0
models. Other model types will ignore these fields and build the models anyway. Frequency

and weight fields are used only for model building, and are not considered when evaluating or
scoring models. For more information, see the topic Using Frequency and Weight Fields in
Chapter 3 on p. (8.
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Supported Model Types

Supported model types include Neural Net, C&R Tree, QUEST, CHAID, C5.0, Logistic
Regression, Decision List, Bayes Net, Discriminant, Nearest Neighbor, and SVM. For more
information, see the topic [Auto Classifier Node Expert Options on p. 93.

Auto Classifier Node Model Options

The Model tab of the Auto Classifier node allows you to specify the number of models to be
created, along with the criteria used to compare models.

Figure 5-4
Auto Classifier node: Model tab
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Model name. You can generate the model name automatically based on the target or ID field (or
model type in cases where no such field is specified) or specify a custom name.

Use partitioned data. If a partition field is defined, this option ensures that data from only the
training partition is used to build the model.

Create split models. Builds a separate model for each possible value of input fields that are specified
as split fields. For more information, see the topic [Building Split Models in Chapter 3 on p. 30|
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Rank models by. Specifies the criteria used to compare and rank models. Options include overall
accuracy, area under the ROC curve, profit, lift, and number of fields. Note that all of these
measures will be available in the summary report regardless of which is selected here.

Note: For a nominal (set) target, ranking is restricted to either Overall Accuracy or Number of Fields.

When calculating profits, lift, and related statistics, the True value defined for the target field is
assumed to represent a hit.

Rank models using. If a partition is in use, you can specify whether ranks are based on the training
dataset or the testing set. With large datasets, use of a partition for preliminary screening of
models may greatly improve performance.

Number of models to use. Specifies the maximum number of models to be listed in the model
nugget produced by the node. The top-ranking models are listed according to the specified ranking
criterion. Note that increasing this limit may slow performance. The maximum allowable value
is 100.

Calculate predictor importance. For models that produce an appropriate measure of importance,
you can display a chart that indicates the relative importance of each predictor in estimating the
model. Typically you will want to focus your modeling efforts on the predictors that matter most,
and consider dropping or ignoring those that matter least. Note that predictor importance may
extend the time needed to calculate some models, and is not recommended if you simply want a
broad comparison across many different models. It is more useful once you have narrowed your
analysis to a handful of models that you want to explore in greater detail. For more information,
see the topic [Predictor Importance] in Chapter 3 on p. 51].

Profit Criteria.Note. Only for flag targets. Profit equals the revenue for each record minus the cost
for the record. Profits for a quantile are simply the sum of profits for all records in the quantile.
Profits are assumed to apply only to hits, but costs apply to all records.

m  Costs. Specify the cost associated with each record. You can select Fixed or Variable costs.
For fixed costs, specify the cost value. For variable costs, click the Field Chooser button
to select a field as the cost field.

m  Revenue. Specify the revenue associated with each record that represents a hit. You can select
Fixed or Variable costs. For fixed revenue, specify the revenue value. For variable revenue,
click the Field Chooser button to select a field as the revenue field.

m  Weight. If the records in your data represent more than one unit, you can use frequency
weights to adjust the results. Specify the weight associated with each record, using Fixed or
Variable weights. For fixed weights, specify the weight value (the number of units per record).
For variable weights, click the Field Chooser button to select a field as the weight field.
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Lift Criteria.Note. Only for flag targets. Specifies the percentile to use for lift calculations. Note
that you can also change this value when comparing the results. For more information, see the
topic [Automated Model Nuggets on p. [I10.

Auto Classifier Node Expert Options

The Expert tab of the Auto Classifier node allows you to apply a partition (if available), select the
algorithms to use, and specify stopping rules.

Figure 5-5
Auto Classifier node: Expert tab
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Models used. Use the check boxes in the column on the left to select the model types (algorithms)
to include in the comparison. The more types you select, the more models will be created and the

longer the processing time will be.

Model type. Lists the available algorithms (see below).

Model parameters. For each model type, you can use the default settings or select Specify to choose
options for each model type. The specific options are similar to those available in the separate
modeling nodes, with the difference that multiple options or combinations can be selected. For
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example, if comparing Neural Net models, rather than choosing one of the six training methods,
you can choose all of them to train six models in a single pass.

Number of models. Lists the number of models produced for each algorithm based on current
settings. When combining options, the number of models can quickly add up, so paying close
attention to this number is strongly recommended, particularly when using large datasets.

Restrict maximum time spent building a single model. (K-Means, Kohonen, TwoStep, SVM, KNN,
Bayes Net and Decision List models only) Sets a maximum time limit for any one model. For
example, if a particular model requires an unexpectedly long time to train because of some
complex interaction, you probably don’t want it to hold up your entire modeling run.

Note: If the target is a nominal (set) field, the Decision List option is unavailable.

Supported Algorithms

The Neural Net node uses a simplified model of the way the human brain processes

ﬁ information. It works by simulating a large number of interconnected simple
processing units that resemble abstract versions of neurons. Neural networks are
powerful general function estimators and require minimal statistical or mathematical
knowledge to train or apply.

The C5.0 node builds either a decision tree or a rule set. The model works by splitting
;ﬁk the sample based on the field that provides the maximum information gain at each
5.0 level. The target field must be categorical. Multiple splits into more than two
subgroups are allowed. For more information, see the topic [C5.0 Node in Chapter 6

on p. [160.

The Classification and Regression (C&R) Tree node generates a decision tree that
’j:ET allows you to predict or classify future observations. The method uses recursive
partitioning to split the training records into segments by minimizing the impurity
at each step, where a node in the tree is considered “pure” if 100% of cases in the
node fall into a specific category of the target field. Target and input fields can be
numeric ranges or categorical (nominal, ordinal, or flags); all splits are binary (only
two subgroups). For more information, see the topic C&R Tree Node in Chapter 6

on p. [143|

The QUEST node provides a binary classification method for building decision trees,
designed to reduce the processing time required for large C&R Tree analyses while
Ces] also reducing the tendency found in classification tree methods to favor inputs that
allow more splits. Input fields can be numeric ranges (continuous), but the target field
must be categorical. All splits are binary. For more information, see the topic

Node in Chapter 6 on p. [144,

The CHAID node generates decision trees using chi-square statistics to identify
m optimal splits. Unlike the C&R Tree and QUEST nodes, CHAID can generate
nonbinary trees, meaning that some splits have more than two branches. Target and
input fields can be numeric range (continuous) or categorical. Exhaustive CHAID is
a modification of CHAID that does a more thorough job of examining all possible
splits but takes longer to compute. For more information, see the topic CHAID Node
in Chapter 6 on p. [144]



95

Automated Modeling Nodes

Logistic regression is a statistical technique for classifying records based on values

L{ of input fields. It is analogous to linear regression but takes a categorical target field
instead of a numeric range. For more information, see the topic [Logistic Node| in
Chapter 10 on p. 259.

The Decision List node identifies subgroups, or segments, that show a higher or
lower likelihood of a given binary outcome relative to the overall population. For
example, you might look for customers who are unlikely to churn or are most likely
to respond favorably to a campaign. You can incorporate your business knowledge
into the model by adding your own custom segments and previewing alternative
models side by side to compare the results. Decision List models consist of a list of
rules in which each rule has a condition and an outcome. Rules are applied in order,
and the first rule that matches determines the outcome. For more information, see the

topic [Decision Lisf in Chapter 9 on p. 204

»

- The Bayesian Network node enables you to build a probability model by combining
L fu observed and recorded evidence with real-world knowledge to establish the likelihood
of occurrences. The node focuses on Tree Augmented Naive Bayes (TAN) and
Markov Blanket networks that are primarily used for classification. For more

information, see the topic Bayesian Network Node|in Chapter 7 on p. [I79.

Discriminant analysis makes more stringent assumptions than logistic regression but
can be a valuable alternative or supplement to a logistic regression analysis when
those assumptions are met. For more information, see the topic Discriminant Node| in
Chapter 10 on p. 285.

The k-Nearest Neighbor (KNN) node associates a new case with the category or value

‘-.. of the k objects nearest to it in the predictor space, where k is an integer. Similar
ot cases are near each other and dissimilar cases are distant from each other. For more
information, see the topic KNN Node in Chapter 16 on p. §62.
= The Support Vector Machine (SVM) node enables you to classify data into one of
.‘f‘\:. two groups without overfitting. SVM works well with wide data sets, such as those
o

with a very large number of input fields. For more information, see the topic [SVM
Node in Chapter 15 on p. f57.

Misclassification Costs

In some contexts, certain kinds of errors are more costly than others. For example, it may be more
costly to classify a high-risk credit applicant as low risk (one kind of error) than it is to classify a
low-risk applicant as high risk (a different kind of error). Misclassification costs allow you to
specify the relative importance of different kinds of prediction errors.

Misclassification costs are basically weights applied to specific outcomes. These weights are
factored into the model and may actually change the prediction (as a way of protecting against
costly mistakes).

With the exception of C5.0 models, misclassification costs are not applied when scoring a model
and are not taken into account when ranking or comparing models using an Auto Classifier node,
evaluation chart, or Analysis node. A model that includes costs may not produce fewer errors
than one that doesn’t and may not rank any higher in terms of overall accuracy, but it is likely to
perform better in practical terms because it has a built-in bias in favor of less expensive errors.
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The cost matrix shows the cost for each possible combination of predicted category and actual
category. By default, all misclassification costs are set to 1.0. To enter custom cost values, select
Use misclassification costs and enter your custom values into the cost matrix.

To change a misclassification cost, select the cell corresponding to the desired combination
of predicted and actual values, delete the existing contents of the cell, and enter the desired
cost for the cell. Costs are not automatically symmetrical. For example, if you set the cost of
misclassifying A as B to be 2.0, the cost of misclassifying B as A will still have the default value
of 1.0 unless you explicitly change it as well.

Auto Classifier Node Discard Options

The Discard tab of the Auto Classifier node allows you to automatically discard models that do
not meet certain criteria. These models will not be listed in the summary report.

Figure 5-6
Auto Classifier node: Discard tab
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You can specify a minimum threshold for overall accuracy and a maximum threshold for the
number of variables used in the model. In addition, for flag targets, you can specify a minimum
threshold for lift, profit, and area under the curve; lift and profit are determined as specified on the
Model tab. For more information, see the topic JAuto Classifier Node Model Options on p. O1.
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Optionally, you can configure the node to stop execution the first time a model is generated
that meets all specified criteria. For more information, see the topic [Automated Modeling Node

Stopping Rules on p. 88|

Auto Classifier Node Settings Options

The Settings tab of the Auto Classifier node allows you to pre-configure the score-time options
that are available on the nugget.

Figure 5-7
Auto Classifier node: Settings tab
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Ensemble method. For targets you can select from the following Ensemble methods:

m  Voting

®  Confidence-weighted voting

m  Raw propensity-weighted voting (flag targets only)
m  Highest confidence wins

B Average raw propensity (flag targets only).

If voting is tied, select value using. For voting methods, you can specify how ties are resolved:

® Random selection. One of the tied values is chosen at random.
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m Highest confidence. The tied value that was predicted with the highest confidence wins. Note

that this is not necessarily the same as the highest confidence of all predicted values.

m  Raw propensity. (Flag targets only) The tied value that was predicted with the largest absolute
propensity, where the absolute propensity is calculated as:

abs(0.5 - propensity) * 2

Auto Numeric Node

The Auto Numeric node estimates and compares models for continuous numeric range outcomes
using a number of different methods, allowing you to try out a variety of approaches in a single
modeling run. You can select the algorithms to use, and experiment with multiple combinations of
options. For example, you could predict housing values using neural net, linear regression, C&RT,
and CHAID models to see which performs best, and you could try out different combinations

of stepwise, forward, and backward regression methods. The node explores every possible
combination of options, ranks each candidate model based on the measure you specify, and saves
the best for use in scoring or further analysis. For more information, see the topic [Automated

Modeling Nodes on p. 86|

Figure 5-8
Auto Numeric results
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Example. A municipality wants to more accurately estimate real estate taxes and to adjust values
for specific properties as needed without having to inspect every property. Using the Auto
Numeric node, the analyst can generate and compare a number of models that predict property
values based on building type, neighborhood, size, and other known factors.
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Requirements. A single target field (with the role set to Target), and at least one input field (with
the role set to Input). The target must be a continuous (numeric range) field, such as age or
income. Input fields can be continuous or categorical, with the limitation that some inputs may
not be appropriate for some model types. For example, C&R Tree models can use categorical
string fields as inputs, while linear regression models cannot use these fields and will ignore
them if specified. The requirements are the same as when using the individual modeling nodes.
For example, a CHAID model works the same whether generated from the CHAID node or the
Auto Numeric node.

Frequency and weight fields. Frequency and weight are used to give extra importance to some
records over others because, for example, the user knows that the build dataset under-represents

a section of the parent population (Weight) or because one record represents a number of
identical cases (Frequency). If specified, a frequency field can be used by C&R Tree and CHAID
algorithms. A weight field can be used by C&RT, CHAID, Regression, and GenLin algorithms.
Other model types will ignore these fields and build the models anyway. Frequency and weight
fields are used only for model building and are not considered when evaluating or scoring models.
For more information, see the topic Using Frequency and Weight Fields in Chapter 3 on p. 38.

Supported Model Types

Supported model types include Neural Net, C&R Tree, CHAID, Regression, GenLin, Nearest
Neighbor, and SVM. For more information, see the topic JAuto Numeric Node Expert Options

on p. [I01}.

Auto Numeric Node Model Options

The Model tab of the Auto Numeric node allows you to specify the number of models to be saved,
along with the criteria used to compare models.
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Figure 5-9
Auto Numeric node: Model tab
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Model name. You can generate the model name automatically based on the target or ID field (or
model type in cases where no such field is specified) or specify a custom name.

Use partitioned data. If a partition field is defined, this option ensures that data from only the
training partition is used to build the model.

Create split models. Builds a separate model for each possible value of input fields that are specified
as split fields. For more information, see the topic Building Split Models in Chapter 3 on p. 30,

Rank models by. Specifies the criteria used to compare models.

® Correlation. The Pearson Correlation between the observed value for each record and the

value predicted by the model. The correlation is a measure of linear association between two
variables, with values closer to 1 indicating a stronger relationship. (Correlation values range
between —1, for a perfect negative relationship, and +1 for a perfect positive relationship. A
value of 0 indicates no linear relationship, while a model with a negative correlation would
rank lowest of all.)

®  Number of fields. The number of fields used as predictors in the model. Choosing models that
use fewer fields may streamline data preparation and improve performance in some cases.
m  Relative error. The relative error is the ratio of the variance of the observed values from those

predicted by the model to the variance of the observed values from the mean. In practical
terms, it compares how well the model performs relative to a null or intercept model that
simply returns the mean value of the target field as the prediction. For a good model, this
value should be less than 1, indicating that the model is more accurate than the null model. A
model with a relative error greater than 1 is less accurate than the null model and is therefore
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not useful. For linear regression models, the relative error is equal to the square of the
correlation and adds no new information. For nonlinear models, the relative error is unrelated
to the correlation and provides an additional measure for assessing model performance.

Rank models using. If a partition is in use, you can specify whether ranks are based on the training
partition or the testing partition. With large datasets, use of a partition for preliminary screening
of models may greatly improve performance.

Number of models to use. Specifies the maximum number of models to be shown in the model
nugget produced by the node. The top-ranking models are listed according to the specified ranking
criterion. Increasing this limit will allow you to compare results for more models but may slow
performance. The maximum allowable value is 100.

Calculate predictor importance. For models that produce an appropriate measure of importance,
you can display a chart that indicates the relative importance of each predictor in estimating the
model. Typically you will want to focus your modeling efforts on the predictors that matter most,
and consider dropping or ignoring those that matter least. Note that predictor importance may
extend the time needed to calculate some models, and is not recommended if you simply want a
broad comparison across many different models. It is more useful once you have narrowed your
analysis to a handful of models that you want to explore in greater detail. For more information,
see the topic [Predictor Importance] in Chapter 3 on p. 51].

Do not keep models if. Specifies threshold values for correlation, relative error, and number of
fields used. Models that fail to meet any of these criteria will be discarded and will not be listed in
the summary report.

m  Correlation less than. The minimum correlation (in terms of absolute value) for a model to be
included in the summary report.

®  Number of fields used is greater than. The maximum number of fields to be used by any model
to be included.

m Relative error is greater than. The maximum relative error for any model to be included.

Optionally, you can configure the node to stop execution the first time a model is generated that
meets all specified criteria. For more information, see the topic [Automated Modeling Node

Stopping Rules on p. 88|

Auto Numeric Node Expert Options

The Expert tab of the Auto Numeric node allows you to select the algorithms and options to
use and to specify stopping rules.
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Figure 5-10
Auto Numeric node: Expert tab
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Models used. Use the check boxes in the column on the left to select the model types (algorithms)
to include in the comparison. The more types you select, the more models will be created and the
longer the processing time will be.

Model type. Lists the available algorithms (see below).

Model parameters. For each model type, you can use the default settings or select Specify to choose
options for each model type. The specific options are similar to those available in the separate
modeling nodes, with the difference that multiple options or combinations can be selected. For
example, if comparing Neural Net models, rather than choosing one of the six training methods,
you can choose all of them to train six models in a single pass.

Number of models. Lists the number of models produced for each algorithm based on current
settings. When combining options, the number of models can quickly add up, so paying close
attention to this number is strongly recommended, particularly when using large datasets.

Restrict maximum time spent building a single model. (K-Means, Kohonen, TwoStep, SVM, KNN,
Bayes Net and Decision List models only) Sets a maximum time limit for any one model. For
example, if a particular model requires an unexpectedly long time to train because of some
complex interaction, you probably don’t want it to hold up your entire modeling run.
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Supported Algorithms

&

The Neural Net node uses a simplified model of the way the human brain processes
information. It works by simulating a large number of interconnected simple
processing units that resemble abstract versions of neurons. Neural networks are
powerful general function estimators and require minimal statistical or mathematical
knowledge to train or apply.

The Classification and Regression (C&R) Tree node generates a decision tree that
allows you to predict or classify future observations. The method uses recursive
partitioning to split the training records into segments by minimizing the impurity
at each step, where a node in the tree is considered “pure” if 100% of cases in the
node fall into a specific category of the target field. Target and input fields can be
numeric ranges or categorical (nominal, ordinal, or flags); all splits are binary (only
two subgroups). For more information, see the topic [C&R Tree Node in Chapter 6

on p. [143|

The CHAID node generates decision trees using chi-square statistics to identify
optimal splits. Unlike the C&R Tree and QUEST nodes, CHAID can generate
nonbinary trees, meaning that some splits have more than two branches. Target and
input fields can be numeric range (continuous) or categorical. Exhaustive CHAID is
a modification of CHAID that does a more thorough job of examining all possible
splits but takes longer to compute. For more information, see the topic (CHAID Node
in Chapter 6 on p. 44,

Linear regression is a common statistical technique for summarizing data and making
predictions by fitting a straight line or surface that minimizes the discrepancies
between predicted and actual output values.

The Generalized Linear model expands the general linear model so that the dependent
variable is linearly related to the factors and covariates through a specified link
function. Moreover, the model allows for the dependent variable to have a non-normal
distribution. It covers the functionality of a wide number of statistical models,
including linear regression, logistic regression, loglinear models for count data, and
interval-censored survival models. For more information, see the topic
in Chapter 10 on p. P94.

The k-Nearest Neighbor (KNN) node associates a new case with the category or value
of the k objects nearest to it in the predictor space, where k is an integer. Similar
cases are near each other and dissimilar cases are distant from each other. For more
information, see the topic KNN Node in Chapter 16 on p. §62.

The Support Vector Machine (SVM) node enables you to classify data into one of
two groups without overfitting. SVM works well with wide data sets, such as those
with a very large number of input fields. For more information, see the topic

Node in Chapter 15 on p. #57.

Linear regression models predict a continuous target based on linear relationships
between the target and one or more predictors. For more information, see the

topic [Linear models in Chapter 10 on p. 239.
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Auto Numeric Node Settings Options

The Settings tab of the Auto Numeric node allows you to pre-configure the score-time options that
are available on the nugget.

Figure 5-11

Auto Numeric node: Settings tab
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Calculate standard error. For a continuous (numeric range) target, a standard error calculation is
run by default to calculate the difference between the measured or estimated values and the true
values; and to show how close those estimates matched.

Auto Cluster Node

The Auto Cluster node estimates and compares clustering models that identify groups of records
with similar characteristics. The node works in the same manner as other automated modeling
nodes, allowing you to experiment with multiple combinations of options in a single modeling
pass. Models can be compared using basic measures with which to attempt to filter and rank the

usefulness of the cluster models, and provide a measure based on the importance of particular
fields.

Clustering models are often used to identify groups that can be used as inputs in subsequent
analyses. For example you may want to target groups of customers based on demographic
characteristics such as income, or based on the services they have bought in the past. This can be
done without prior knowledge about the groups and their characteristics — you may not know
how many groups to look for, or what features to use in defining them. Clustering models are



105

Automated Modeling Nodes

often referred to as unsupervised learning models, since they do not use a target field, and do
not return a specific prediction that can be evaluated as true or false. The value of a clustering
model is determined by its ability to capture interesting groupings in the data and provide useful
descriptions of those groupings. For more information, see the topic Clustering Models in
Chapter 11 on p. 347.

Figure 5-12
Auto Cluster results
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Requirements. One or more fields that define characteristics of interest. Cluster models do not use
target fields in the same manner as other models, because they do not make specific predictions
that can be assessed as true or false. Instead they are used to identify groups of cases that may be
related. For example you cannot use a cluster model to predict whether a given customer will
churn or respond to an offer. But you can use a cluster model to assign customers to groups based
on their tendency to do those things. Weight and frequency fields are not used.

Evaluation fields. While no target is used, you can optionally specify one or more evaluation
fields to be used in comparing models. The usefulness of a cluster model may be evaluated by
measuring how well (or badly) the clusters differentiate these fields.

Supported Model Types

Supported model types include TwoStep, K-Means, and Kohonen.

Auto Cluster Node Model Options

The Model tab of the Auto Cluster node allows you to specify the number of models to be saved,
along with the criteria used to compare models.
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Figure 5-13
Auto Cluster node: Model tab
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Model name. You can generate the model name automatically based on the target or ID field (or
model type in cases where no such field is specified) or specify a custom name.

Use partitioned data. If a partition field is defined, this option ensures that data from only the
training partition is used to build the model.
Rank models by. Specifies the criteria used to compare and rank models.

m  Silhouette. An index measuring both cluster cohesion and separation. See Silhouette Ranking
Measure below for more information.

Number of clusters. The number of clusters in the model.
Size of smallest cluster. The smallest cluster size.
Size of largest cluster. The largest cluster size.

Smallest / largest cluster. The ratio of the size of the smallest cluster to the largest cluster.

Importance. The importance of the Evaluation field on the Fields tab. Note that this can only be
calculated if an Evaluation field has been specified.

Rank models using. If a partition is in use, you can specify whether ranks are based on the training
dataset or the testing set. With large datasets, use of a partition for preliminary screening of
models may greatly improve performance.
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Number of models to keep. Specifies the maximum number of models to be listed in the nugget
produced by the node. The top-ranking models are listed according to the specified ranking
criterion. Note that increasing this limit may slow performance. The maximum allowable value
is 100.

Silhouette Ranking Measure

The default ranking measure, Silhouette, has a default value of O because a value of less than 0
(i.e. negative) indicates that the average distance between a case and points in its assigned cluster
is greater than the minimum average distance to points in another cluster. Therefore, models with
a negative Silhouette can safely be discarded.

The ranking measure is actually a modified silhouette coefficient, which combines the concepts of
cluster cohesion (favoring models which contain tightly cohesive clusters) and cluster separation
(favoring models which contain highly separated clusters). The average Silhouette coefficient is
simply the average over all cases of the following calculation for each individual case:

(B-A)/ max(A, B)

where A is the distance from the case to the centroid of the cluster which the case belongs to; and
B is the minimal distance from the case to the centroid of every other cluster.

The Silhouette coefficient (and its average) range between -1 (indicating a very poor model) and 1
(indicating an excellent model). The average can be conducted on the level of total cases (which
produces total Silhouette) or the level of clusters (which produces cluster Silhouette). Distances
may be calculated using Euclidean distances.

Auto Cluster Node Expert Options

The Expert tab of the Auto Cluster node allows you to apply a partition (if available), select the
algorithms to use, and specify stopping rules.
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Figure 5-14
Auto Cluster node: Expert tab
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Models used. Use the check boxes in the column on the left to select the model types (algorithms)
to include in the comparison. The more types you select, the more models will be created and the
longer the processing time will be.

Model type. Lists the available algorithms (see below).

Model parameters. For each model type, you can use the default settings or select Specify to choose
options for each model type. The specific options are similar to those available in the separate
modeling nodes, with the difference that multiple options or combinations can be selected. For
example, if comparing Neural Net models, rather than choosing one of the six training methods,
you can choose all of them to train six models in a single pass.

Number of models. Lists the number of models produced for each algorithm based on current
settings. When combining options, the number of models can quickly add up, so paying close
attention to this number is strongly recommended, particularly when using large datasets.

Restrict maximum time spent building a single model. (K-Means, Kohonen, TwoStep, SVM, KNN,
Bayes Net and Decision List models only) Sets a maximum time limit for any one model. For
example, if a particular model requires an unexpectedly long time to train because of some
complex interaction, you probably don’t want it to hold up your entire modeling run.
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Supported Algorithms

The K-Means node clusters the data set into distinct groups (or clusters). The method
(% defines a fixed number of clusters, iteratively assigns records to clusters, and adjusts
the cluster centers until further refinement can no longer improve the model. Instead
of trying to predict an outcome, k-means uses a process known as unsupervised
learning to uncover patterns in the set of input fields. For more information, see the

topic K-Means Node in Chapter 11 on p. B54.

The Kohonen node generates a type of neural network that can be used to cluster the
data set into distinct groups. When the network is fully trained, records that are
similar should be close together on the output map, while records that are different
will be far apart. You can look at the number of observations captured by each unit
in the model nugget to identify the strong units. This may give you a sense of the
appropriate number of clusters. For more information, see the topic Kohonen Node in
Chapter 11 on p. B48.

Ex
-

The TwoStep node uses a two-step clustering method. The first step makes a single
pass through the data to compress the raw input data into a manageable set of
subclusters. The second step uses a hierarchical clustering method to progressively
merge the subclusters into larger and larger clusters. TwoStep has the advantage of
automatically estimating the optimal number of clusters for the training data. It can
handle mixed field types and large data sets efficiently. For more information, see the

topic TwoStep Cluster Nod¢ in Chapter 11 on p. B58.

Auto Cluster Node Discard Options

The Discard tab of the Auto Cluster node allows you to automatically discard models that do not
meet certain criteria. These models will not be listed on the model nugget.
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Figure 5-15
Auto Cluster node: Discard tab
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You can specify the minimum silhouette value, cluster numbers, cluster sizes, and the importance
of the evaluation field used in the model. Silhouette and the number and size of clusters are
determined as specified in the modeling node. For more information, see the topic
Node Model Options on p. [105.

Optionally, you can configure the node to stop execution the first time a model is generated
that meets all specified criteria. For more information, see the topic [Automated Modeling Node

Stopping Rules on p. 88|

Automated Model Nuggets

When an automated modeling node is executed, the node estimates candidate models for every
possible combination of options, ranks each candidate model based on the measure you specify,
and saves the best models in a composite automated model nugget. This model nugget actually
contains a set of one or more models generated by the node, which can be individually browsed or
selected for use in scoring. The model type and build time are listed for each model, along with a
number of other measures as appropriate for the type of model. You can sort the table on any of
these columns to quickly identify the most interesting models.
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Figure 5-16
Auto Numeric results
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m  To browse any of the individual model nuggets, double-click the nugget icon. From there you
can then generate a modeling node for that model to the stream canvas, or a copy of the
model nugget to the models palette.

®  Thumbnail graphs give a quick visual assessment for each model type, as summarized below.
You can double-click on a thumbnail to generate a full-sized graph. The full-sized plot
shows up to 1000 points and will be based on a sample if the dataset contains more. (For
scatterplots only, the graph is regenerated each time it is displayed, so any changes in the
upstream data—such as updating of a random sample or partition if Set Random Seed is not
selected—may be reflected each time the scatterplot is redrawn.)

m  Use the toolbar to show or hide specific columns on the Model tab or to change the column
used to sort the table. (You can also change the sort by clicking on the column headers.)

Use the Delete button to permanently remove any unused models.
To reorder columns, click on a column header and drag the column to the desired location.

If a partition is in use, you can choose to view results for the training or testing partition
as applicable.

The specific columns depend on the type of models being compared, as detailed below.

Binary Targets

®  For binary models, the thumbnail graph shows the distribution of actual values, overlaid with
the predicted values, to give a quick visual indication of how many records were correctly
predicted in each category.
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®  Ranking criteria match the options in the Auto Classifier modeling node. For more
information, see the topic [Auto Classifier Node Model Options on p. [91].

For the maximum profit, the percentile in which the maximum occurs is also reported.

For cumulative lift, you can change the selected percentile using the toolbar.

Nominal Targets

®  For nominal (set) models, the thumbnail graph shows the distribution of actual values,
overlaid with the predicted values, to give a quick visual indication of how many records
were correctly predicted in each category.

B Ranking criteria match the options in the Auto Classifier modeling node. For more
information, see the topic [Auto Classifier Node Model Options on p. [91].

Continuous Targets

®  For continuous (numeric range) models, the graph plots predicted against observed values
for each model, providing a quick visual indication of the correlation between them. For
a good model, points should tend to cluster along the diagonal rather than be scattered
randomly across the graph.

B Ranking criteria match the options in the Auto Numeric modeling node. For more information,
see the topic [Auto Numeric Node Model Options on p. [99.

Cluster Targets

m  For cluster models, the graph plots counts against clusters for each model, providing a quick
visual indication of cluster distribution.

B Ranking criteria match the options in the Auto Cluster modeling node. For more information,
see the topic [Auto Cluster Node Model Options| on p. [105].

Selecting Models for Scoring

The Use? column enables you to select the models to use in scoring.

®  For binary, nominal, and numeric targets, you can select multiple scoring models and combine
the scores in the single, ensembled model nugget. By combining predictions from multiple
models, limitations in individual models may be avoided, often resulting in a higher overall
accuracy than can be gained from any one of the models.

m  For cluster models, only one scoring model can be selected at a time. By default, the top
ranked one is selected first.

Generating Nodes and Models

You can generate a copy of the composite automated model nugget, or the automated modeling
node from which it was built. For example, this may be useful if you do not have the original
stream from which the automated model nugget was built. Alternatively, you can generate a
nugget or modeling node for any of the individual models listed in the automated model nugget.
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Automated Modeling Nugget

From the Generate menu, select Model to Palette to add the automated model nugget to the Models
palette. The generated model can be saved or used as is without rerunning the stream.

Alternatively, you can select Generate Modeling Node from the Generate menu to add the modeling
node to the stream canvas. This node can be used to reestimate the selected models without
repeating the entire modeling run.

Individual Modeling Nugget

In the Model menu, double-click on the individual nugget you require. A copy of that nugget
opens in a new dialog.

From the Generate menu in the new dialog, select Model to Palette to add the individual modeling
nugget to the Models palette.

Alternatively, you can select Generate Modeling Node from the Generate menu in the new dialog to
add the individual modeling node to the stream canvas.

Generating Evaluation Charts

For binary models only, you can generate evaluation charts that offer a visual way to assess and
compare the performance of each model. Evaluation charts are not available for models generated
by the Auto Numeric or Auto Cluster nodes.

Figure 5-17
Response chart (cumulative) with best line and baseline
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» Under the Use? column in the Auto Classifier automated model nugget, select the models that
you want to evaluate.
» From the Generate menu, choose Evaluation Chart(s).

Figure 5-18
Generating an evaluation chart
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» Select the chart type and other options as desired.

Evaluation Graphs

On the Model tab of the automated model nugget you can drill down to display individual graphs
for each of the models shown. For Auto Classifier and Auto Numeric nuggets, the Graph tab
displays both a graph and predictor importance that reflect the results of all the models combined.
For more information, see the topic [Predictor Importance in Chapter 3 on p. [51].

For Auto Classifier a distribution graph is shown, whereas a multiplot (also known as a scatterplot)
is shown for Auto Numeric.
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Figure 5-19

Automated Modeling Nodes

Auto Numeric - Multiplot graph for the ensembled models within the automated model nugget
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Decision Tree Models

Decision tree models allow you to develop classification systems that predict or classify future
observations based on a set of decision rules. If you have data divided into classes that interest
you (for example, high- versus low-risk loans, subscribers versus nonsubscribers, voters versus
nonvoters, or types of bacteria), you can use your data to build rules that you can use to classify
old or new cases with maximum accuracy. For example, you might build a tree that classifies
credit risk or purchase intent based on age and other factors.

Figure 6-1
Interactive Tree window
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This approach, sometimes known as rule induction, has several advantages. First, the reasoning
process behind the model is clearly evident when browsing the tree. This is in contrast to other
“black box”” modeling techniques in which the internal logic can be difficult to work out.

© Copyright IBM Corporation 1994, 2012. 116
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Figure 6-2
Simple decision tree for buying a car

Road tested?

no -~ . yes
) Mileage
DON'T BUY high - . low
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BUY
oldﬁ_,r»r" . recent
DON'T BUY BUY

Second, the process will automatically include in its rule only the attributes that really matter in
making a decision. Attributes that do not contribute to the accuracy of the tree are ignored. This
can yield very useful information about the data and can be used to reduce the data to relevant
fields before training another learning technique, such as a neural net.

Decision tree model nuggets can be converted into a collection of if-then rules (a rule set),
which in many cases show the information in a more comprehensible form. The decision-tree
presentation is useful when you want to see how attributes in the data can split, or partition, the
population into subsets relevant to the problem. The rule set presentation is useful if you want to
see how particular groups of items relate to a specific conclusion. For example, the following
rule gives us a profile for a group of cars that is worth buying:

IF tested = 'yes'
AND mileage = 'low'
THEN -> 'BUY".

Tree-Building Algorithms

Four algorithms are available for performing classification and segmentation analysis. These
algorithms all perform basically the same thing—they examine all of the fields of your dataset to
find the one that gives the best classification or prediction by splitting the data into subgroups.
The process is applied recursively, splitting subgroups into smaller and smaller units until the
tree is finished (as defined by certain stopping criteria). The target and input fields used in tree
building can be continuous (numeric range) or categorical, depending on the algorithm used.
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If a continuous target is used, a regression tree is generated; if a categorical target is used, a
classification tree is generated.

The Classification and Regression (C&R) Tree node generates a decision tree that
F)CﬁT allows you to predict or classify future observations. The method uses recursive
partitioning to split the training records into segments by minimizing the impurity
at each step, where a node in the tree is considered “pure” if 100% of cases in the
node fall into a specific category of the target field. Target and input fields can be
numeric ranges or categorical (nominal, ordinal, or flags); all splits are binary (only
two subgroups). For more information, see the topic C&R Tree Node on p. [143.

The CHAID node generates decision trees using chi-square statistics to identify
optimal splits. Unlike the C&R Tree and QUEST nodes, CHAID can generate
nonbinary trees, meaning that some splits have more than two branches. Target and
input fields can be numeric range (continuous) or categorical. Exhaustive CHAID is
a modification of CHAID that does a more thorough job of examining all possible
splits but takes longer to compute. For more information, see the topic [CHAID Node

on p. [144

£

The QUEST node provides a binary classification method for building decision trees,
designed to reduce the processing time required for large C&R Tree analyses while
also reducing the tendency found in classification tree methods to favor inputs that
allow more splits. Input fields can be numeric ranges (continuous), but the target field
must be categorical. All splits are binary. For more information, see the topic

Node on p. 144

=

The C5.0 node builds either a decision tree or a rule set. The model works by splitting
Eﬁk the sample based on the field that provides the maximum information gain at each
5.0 level. The target field must be categorical. Multiple splits into more than two
subgroups are allowed. For more information, see the topic [C5.0 Node| on p. [160.

General Uses of Tree-Based Analysis

The following are some general uses of tree-based analysis:
Segmentation. Identify persons who are likely to be members of a particular class.

Stratification. Assign cases into one of several categories, such as high-, medium-, and low-risk
groups.

Prediction. Create rules and use them to predict future events. Prediction can also mean attempts
to relate predictive attributes to values of a continuous variable.

Data reduction and variable screening. Select a useful subset of predictors from a large set of
variables for use in building a formal parametric model.

Interaction identification. Identify relationships that pertain only to specific subgroups and specify
these in a formal parametric model.

Category merging and banding continuous variables. Recode group predictor categories and
continuous variables with minimal loss of information.
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The Interactive Tree Builder

You can generate a tree model automatically, allowing the algorithm to choose the best split at
each level, or you can use the interactive tree builder to take control, applying your business
knowledge to refine or simplify the tree before saving the model nugget.

» Create a stream and add one of the decision tree nodes C&R Tree, CHAID, or QUEST.
Note: Interactive tree building is not supported for C5.0 trees.

» Open the node and, on the Fields tab, select target and predictor fields and specify additional model
options as needed. For specific instructions, see the documentation for each tree-building node.

» On the Objectives panel of the Build Options tab, select Launch interactive session.

» Click Run to launch the tree builder.

Figure 6-3
Interactive Tree Builder window
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The current tree is displayed, starting with the root node. You can edit and prune the tree
level-by-level and access gains, risks, and related information before generating one or more
models.

Comments

m  With the C&R Tree, CHAID, and QUEST nodes, any ordinal fields used in the model must
have numeric storage (not string). If necessary, the Reclassify node can be used to convert
them.
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Optionally, you can use a partition field to separate the data into training and test samples.

As an alternative to using the tree builder, you can also generate a model directly from the
modeling node as with other IBM® SPSS® Modeler models. For more information, see the
topic Building a Tree Model Directly] on p. [140.

Growing and Pruning the Tree

The Viewer tab in the tree builder allows you to view the current tree, starting with the root node.

» To grow the tree, from the menus choose:
Tree > Grow Tree

The system builds the tree by recursively splitting each branch until one or more stopping criteria
are met. At each split, the best predictor is automatically selected based on the modeling method
used.

» Alternatively, select Grow Tree One Level to add a single level.
» To add a branch below a specific node, select the node and select Grow Branch.

» To choose the predictor used for a split, select the desired node and select Grow Branch with Custom
Split. For more information, see the topic [Defining Custom Splits on p. 121.

» To prune a branch, select a node and select Remove Branch to clear up the selected node.
» To remove the bottom level from the tree, select Remove One Level.

» For C&R Tree and QUEST trees only, select Grow Tree and Prune to prune based on a
cost-complexity algorithm that adjusts the risk estimate based on the number of terminal nodes,
typically resulting in a simpler tree. For more information, see the topic C&R Tree Node on p. [143.

Reading Split Rules on the Viewer Tab

Figure 6-4
Split rules displayed on the Viewer tab
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When viewing split rules on the Viewer tab, square brackets mean that the adjacent value is
included in the range whereas parentheses indicate that the adjacent value is excluded from the
range. The expression (23,37] therefore means from 23 exclusive to 37 inclusive; that is, from just
above 23 to 37. On the Model tab, the same condition would be displayed as:

Age > 23 and Age <= 37
Interrupting tree growth. To interrupt a tree-growing operation (if it is taking longer than expected,
for example), click the Stop Execution button on the toolbar.

Figure 6-5
Stop Execution button

o

The button is enabled only during tree growth. It stops the current growing operation at its current
point, leaving any nodes that have already been added, without saving changes or closing the
window. The tree builder remains open, allowing you to generate a model, update directives, or
export output in the appropriate format, as needed.

Defining Custom Splits

The Define Split dialog box allows you to select the predictor and specify conditions for each split.

» In the tree builder, select a node on the Viewer tab, and from the menus choose:
Tree > Grow Branch with Custom Split

Figure 6-6
Define Split dialog box
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>

Select the desired predictor from the drop-down list, or click on the Predictors button to view
details of each predictor. For more information, see the topic [Viewing Predictor Details on p. [122.

You can accept the default conditions for each split or select Custom to specify conditions for the
split as appropriate.

m  For continuous (numeric range) predictors, you can use the Edit Range Values fields to specify
the range of values that fall into each new node.

m  For categorical predictors, you can use the Edit Set Values or Edit Ordinal Values fields to

specify the specific values (or range of values in case of an ordinal predictor) that map to
each new node.

Select Grow to regrow the branch using the selected predictor.

The tree can generally be split using any predictor, regardless of stopping rules. The only
exceptions are when the node is pure (meaning that 100% of cases fall into the same target

class, thus there is nothing left to split) or the chosen predictor is constant (there is nothing to
split against).

Missing values into. For CHAID trees only, if missing values are available for a given predictor,
you have the option when defining a custom split to assign them to a specific child node. (With
C&R Tree and QUEST, missing values are handled using surrogates as defined in the algorithm.
For more information, see the topic Split Details and Surrogates on p. [123.)

Viewing Predictor Details

The Select Predictor dialog box displays statistics on available predictors (or “competitors” as
they are sometimes called) that can be used for the current split.

Figure 6-7
Select Predictor dialog box
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®  For CHAID and exhaustive CHAID, the chi-square statistic is listed for each categorical
predictor; if a predictor is a numeric range, the F statistic is shown. The chi-square statistic is
a measure of how independent the target field is from the splitting field. A high chi-square
statistic generally relates to a lower probability, meaning that there is less chance that the two
fields are independent—an indication that the split is a good one. Degrees of freedom are also
included because these take into account the fact that it is easier for a three-way split to have a
large statistic and small probability than it is for a two-way split.

[Cancel][ Help ]

®  For C&R Tree and QUEST, the improvement for each predictor is displayed. The greater the
improvement, the greater the reduction in impurity between the parent and child nodes if that
predictor is used. (A pure node is one in which all cases fall into a single target category;
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the lower the impurity across the tree, the better the model fits the data.) In other words, a
high improvement figure generally indicates a useful split for this type of tree. The impurity

measure used is specified in the tree-building node.

Split Details and Surrogates

You can select any node on the Viewer tab and select the split information button on the right
side of the toolbar to view details about the split for that node. The split rule used is displayed,
along with relevant statistics. For C&R Tree categorical trees, improvement and association are
displayed. The association is a measure of correspondence between a surrogate and the primary
split field, with the “best” surrogate generally being the one that most closely mimics the split field.
For C&R Tree and QUEST, any surrogates used in place of the primary predictor are also listed.

Figure 6-8
Interactive Tree Builder window with split information displayed

'? Interactive Tree of Quest Tree CF

=]

=)

@ File | S Edt & View Tree ) Generste

@ (&l

Yiewvet || Gains || Risks | Annotations

eh @Y e

W aq HWmE HEEF B O

]

MNEVWSCHAN

Categary % nf

{Fooon 51387 227f;

{m1000 28643 215);

Total  100.000 42|

___________ e =1
AGE

&di. Povalue=0.000, F=52 864, dfi=1, diZ=428

== 44142 = 44142
Mode 1 | | MNaode 2 hd
',I'I Rule |Conditi0n1 |Cond'rti0n 2 |Impr0vemerﬂ Azsociation | a
Primary &GE ==44.142 AGE =44 142 .
1 EDUCATE =8 500 EDUCATE ==38.500 0.055
=

,p(pk QUEST Model: Training Data

» To edit the split for the selected node, you can click the icon on the left side of the surrogates panel
to open the Define Split dialog box. (As a shortcut, you can select a surrogate from the list before

clicking the icon to select it as the primary split field.)
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Surrogates. Where applicable, any surrogates for the primary split field are shown for the
selected node. Surrogates are alternate fields used if the primary predictor value is missing for a
given record. The maximum number of surrogates allowed for a given split is specified in the
tree-building node, but the actual number depends on the training data. In general, the more
missing data, the more surrogates are likely to be used. For other decision tree models, this tab
is empty.

Note: To be included in the model, surrogates must be identified during the training phase. If the
training sample has no missing values, then no surrogates will be identified, and any records with
missing values encountered during testing or scoring will automatically fall into the child node
with the largest number of records. If missing values are expected during testing or scoring,

be sure that values are missing from the training sample, as well. Surrogates are not available
for CHAID trees.

Although surrogates are not used for CHAID trees, when defining a custom split you have the
option to assign them to a specific child node. For more information, see the topic Defining

Custom Splits on p. [121].

Customizing the Tree View

The Viewer tab in the tree builder displays the current tree. By default, all branches in the tree are
expanded, but you can expand and collapse branches and customize other settings as needed.
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Left-to-right view with split rule details, node graphs and labels visible

Decision Trees
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Click the minus sign (-) at the bottom right corner of a parent node to hide all of its child nodes.
Click the plus sign (+) at the bottom right corner of a parent node to display its child nodes.

Use the View menu or the toolbar to change the orientation of the tree (top-down, left-to-right,
or right-to-left).

Click the “Display field and value labels” button on the main toolbar to show or hide field
and value labels.

Use the magnifying glass buttons to zoom the view in or out, or click the tree map button on
the right side of the toolbar to view a diagram of the complete tree.

If a partition field is in use, you can swap the tree view between training and testing partitions
(View > Partition). When the testing sample is displayed, the tree can be viewed but not edited.
(The current partition is displayed in the status bar in the lower right corner of the window.)

[7342]
1

Click the split information button (the “i” button on the far right of the toolbar) to view details
on the current split. For more information, see the topic [Split Details and Surrogates|/on p. [123.

Display statistics, graphs, or both within each node (see below).
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Gains

Displaying Statistics and Graphs

Node statistics. For a categorical target field, the table in each node shows the number and
percentage of records in each category and the percentage of the entire sample that the node
represents. For a continuous (numeric range) target field, the table shows the mean, standard
deviation, number of records, and predicted value of the target field.

Node graphs. For a categorical target field, the graph is a bar chart of percentages in each category
of the target field. Preceding each row in the table is a color swatch that corresponds to the color
that represents each of the target field categories in the graphs for the node. For a continuous
(numeric range) target field, the graph shows a histogram of the target field for records in the node.

The Gains tab displays statistics for all terminal nodes in the tree. Gains provide a measure of how
far the mean or proportion at a given node differs from the overall mean. Generally speaking, the
greater this difference, the more useful the tree is as a tool for making decisions. For example, an
index or “lift” value of 148% for a node indicates that records in the node are about one-and-a-half
times as likely to fall under the target category as for the dataset as a whole.

For C&R Tree and QUEST nodes where an overfit prevention set is specified, two sets of statistics
are displayed:

B tree growing set - the training sample with the overfit prevention set removed

m  overfit prevention set

For other C&R Tree and QUEST interactive trees, and for all CHAID interactive trees, only
the tree growing set statistics are displayed.

Figure 6-10
Gains tab
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The Gains tab allows you to:
®  Display node-by-node, cumulative, or quantile statistics.
®  Display gains or profits.

m  Swap the view between tables and charts.
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Select the target category (categorical targets only).

Sort the table in ascending or descending order based on the index percentage. If statistics

for multiple partitions are displayed, sorts are always applied on the training sample rather
than on the testing sample.

In general, selections made in the gains table will be updated in the tree view and vice versa. For
example, if you select a row in the table, the corresponding node will be selected in the tree.

Classification Gains

For classification trees (those with a categorical target variable), the gain index percentage

tells you how much greater the proportion of a given target category at each node differs from
the overall proportion.

Node-by-Node Statistics

In this view, the table displays one row for each terminal node. For example, if the overall
response to your direct mail campaign was 10% but 20% of the records that fall into node

X responded positively, the index percentage for the node would be 200%, indicating that

respondents in this group are twice as likely to buy relative to the overall population.

For C&R Tree and QUEST nodes where an overfit prevention set is specified, two sets of statistics
are displayed:
B tree growing set - the training sample with the overfit prevention set removed

m  overfit prevention set

For other C&R Tree and QUEST interactive trees, and for all CHAID interactive trees, only
the tree growing set statistics are displayed.

Figure 6-11
Node-by-node gain statistics
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Nodes. The ID of the current node (as displayed on the Viewer tab).
Node: n. The total number of records in that node.
Node (%). The percentage of all records in the dataset that fall into this node.

Gain: n. The number of records with the selected target category that fall into this node. In other

words, of all the records in the dataset that fall under the target category, how many are in this
node?
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Gain (%). The percentage of all records in the target category, across the entire dataset, that fall
into this node.

Response (%). The percentage of records in the current node that fall under the target category.
Responses in this context are sometimes referred to as “hits.”

Index (%). The response percentage for the current node expressed as a percentage of the response
percentage for the entire dataset. For example, an index value of 300% indicates that records in
this node are three times as likely to fall under the target category as for the dataset as a whole.

Cumulative Statistics

In the cumulative view, the table displays one node per row, but statistics are cumulative, sorted in
ascending or descending order by index percentage. For example if a descending sort is applied,

the node with the highest index percentage is listed first, and statistics in the rows that follow are
cumulative for that row and above.

Figure 6-12

Cumulative gains sorted in descending order by index percentage
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The cumulative index percentage decreases row-by-row as nodes with lower and lower response
percentages are added. The cumulative index for the final row is always 100% because at this
point the entire dataset is included.

Quantiles

In this view, each row in the table represents a quantile rather than a node. The quantiles are either
quartiles, quintiles (fifths), deciles (tenths), vingtiles (twentieths), or percentiles (hundredths).
Multiple nodes can be listed in a single quantile if more than one node is needed to make up that
percentage (for example, if quartiles are displayed but the top two nodes contain fewer than 50%

of all cases). The rest of the table is cumulative and can be interpreted in the same manner as
the cumulative view.
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Figure 6-13
Gains by quartile listed in descending order by index percentage
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Classification Profits and ROI

For classification trees, gains statistics can also be displayed in terms of profit and ROI (return

on investment). The Define Profits dialog box allows you to specify revenue and expenses for
each category.

» On the Gains tab, click the Profit button (labeled $/$) on the toolbar to access the dialog box.

Figure 6-14
Define Profits dialog box
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» Enter revenue and expense values for each category of the target field.

For example, if it costs you $0.48 to mail an offer to each customer and the revenue from a

positive response is $9.95 for a three-month subscription, then each no response costs you $0.48
and each yes earns you $9.47 (calculated as 9.95-0.48).

In the gains table, profit is calculated as the sum of revenues minus expenditures for each of the
records at a terminal node. ROI is total profit divided by total expenditure at a node.

Comments

B Profit values affect only average profit and ROI values displayed in the gains table, as a
way of viewing statistics in terms more applicable to your bottom line. They do not affect
the basic tree model structure. Profits should not be confused with misclassification costs,
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which are specified in the tree-building node and are factored into the model as a way of
protecting against costly mistakes.

m  Profit specifications are not persisted between one interactive tree-building session and the
next.

Regression Gains

For regression trees, you can choose between node-by-node, cumulative node-by-node, and
quantile views. Average values are shown in the table. Charts are available only for quantiles.

Gains Charts

Charts can be displayed on the Gains tab as an alternative to tables.

» On the Gains tab, select the Quantiles icon (third from left on the toolbar). (Charts are not
available for node-by-node or cumulative statistics.)

» Select the Charts icon.
» Select the displayed units (percentiles, deciles, and so on) from the drop-down list as desired.

» Select Gains, Response, or Lift to change the displayed measure.

Gains Chart

The gains chart plots the values in the Gains (%) column from the table. Gains are defined as
the proportion of hits in each increment relative to the total number of hits in the tree, using the
equation:

(hits in increment / total number of hits) x 100%
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Figure 6-15
Gains chart
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The chart effectively illustrates how widely you need to cast the net to capture a given percentage
of all the hits in the tree. The diagonal line plots the expected response for the entire sample, if the
model were not used. In this case, the response rate would be constant, since one person is just as
likely to respond as another. To double your yield, you would need to ask twice as many people.
The curved line indicates how much you can improve your response by including only those who
rank in the higher percentiles based on gain. For example, including the top 50% might net you
more than 70% of the positive responses. The steeper the curve, the higher the gain.

Lift Chart

The lift chart plots the values in the Index (%) column in the table. This chart compares the
percentage of records in each increment that are hits with the overall percentage of hits in the
training dataset, using the equation:

(hits in increment / records in increment) / (total number of hits / total number of records)



132

Chapter 6

Figure 6-16
Lift chart
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Response Chart

The response chart plots the values in the Response (%) column of the table. The response is a
percentage of records in the increment that are hits, using the equation:

(responses in increment / records in increment) x 100%
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Figure 6-17
Response chart
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Gains-Based Selection

The Gains-Based Selection dialog box allows you to automatically select terminal nodes with
the best (or worst) gains based on a specified rule or threshold. You can then generate a Select
node based on the selection.
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Risks

Figure 6-18
Gains-Based Selection dialog box
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On the Gains tab, select the node-by-node or cumulative view and select the target category on

which you want to base the selection. (Selections are based on the current table display and are
not available for quantiles.)

On the Gains tab, from the menus choose:
Edit > Select Terminal Nodes > Gains-Based Selection

Select only. You can select matching nodes or nonmatching nodes—for example, to select all but
the top 100 records.

Match by gains information. Matches nodes based on gain statistics for the current target category,
including:

®  Nodes where the gain, response, or lift (index) matches a specified threshold—for example,
response greater than or equal to 50%.

The top n nodes based on the gain for the target category.
The top nodes up to a specified number of records.

The top nodes up to a specified percentage of training data.
Click OK to update the selection on the Viewer tab.

To create a new Select node based on the current selection on the Viewer tab, choose Select
Node from the Generate menu. For more information, see the topic Generating Filter and Select

Nodes on p. [139.

Note: Since you are actually selecting nodes rather than records or percentages, a perfect match
with the selection criterion may not always be achieved. The system selects complete nodes up to
the specified level. For example, if you select the top 12 cases and you have 10 in the first node
and two in the second node, only the first node will be selected.

Risks tell you the chances of misclassification at any level. The Risks tab displays a point risk
estimate and (for categorical outputs) a misclassification table.
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Misclassification table for a categorical target
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®  For numeric predictions, the risk is a pooled estimate of the variance at each of the terminal

nodes.

m  For categorical predictions, the risk is the proportion of cases incorrectly classified, adjusted
for any priors or misclassification costs.

Saving Tree Models and Results

You can save or export the results of your interactive tree-building sessions in a number of ways,

including:

®  Generate a model based on the current tree (Generate > Generate model).

m  Save the directives used to grow the current tree. The next time the tree-building node is
executed, the current tree will automatically be regrown, including any custom splits that
you have defined.

®m  Export model, gain, and risk information. For more information, see the topic [Exporting

Model, Gain, and Risk Information on p. [139.

From either the tree builder or a tree model nugget, you can:

B Generate a Filter or Select node based on the current tree. For more information, see the

topic Generating Filter and Select Nodes on p. [139.

m  Generate a Rule Set nugget that represents the tree structure as a set of rules defining the
terminal branches of the tree. For more information, see the topic (Generating a Rule Sef

from a Decision Tree| on p. [139.
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® In addition, for tree model nuggets only, you can export the model in PMML format. For more

information, see the topic The Models Palette in Chapter 3 on p. 47. If the model includes any
custom splits, this information is not preserved in the exported PMML. (The split is preserved,
but the fact that it is custom rather than chosen by the algorithm is not.)

Generate a graph based on a selected part of the current tree. Note: this only works for

a nugget when it is attached to other nodes in a stream. For more information, see the
topic [Generating Graphs on p. [172,

Note: The interactive tree itself cannot be saved. To avoid losing your work, generate a model
and/or update tree directives before closing the tree builder window.

Generating a Model from the Tree Builder

To generate a model based on the current tree, from the tree builder menus choose:

Generate > Model

Figure 6-20
Generating a decision tree model
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You can choose from the following options:

Model name. You can specify a custom name or generate the name automatically based on the

name of the modeling node.

Create node on. You can add the node on the Canvas, GM Palette, or Both.

Include tree directives. To include the directives from the current tree in the generated model,

select this box. This enables you to regenerate the tree, if required. For more information, see
the topic [Tree-Growing Directives on p. [136]

Tree-Growing Directives

For C&R Tree, CHAID, and QUEST models, tree directives specify conditions for growing the
tree, one level at a time. Directives are applied each time the interactive tree builder is launched

from the node.

m Directives are most safely used as a way to regenerate a tree created during a previous

interactive session. For more information, see the topic [Updating Tree Directives on p. [138.
You can also edit directives manually, but this should be done with care.

Directives are highly specific to the structure of the tree they describe. Thus, any change to the

underlying data or modeling options may cause a previously valid set of directives to fail.
For example, if the CHAID algorithm changes a two-way split to a three-way split based on
updated data, any directives based on the previous two-way split would fail.
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Note: If you choose to generate a model directly (without using the tree builder), any tree
directives are ignored.

Editing Directives

To view or edit saved directives, open the tree-building node and select the Objective panel of
the Build Options tab.

Select Launch interactive session to enable the controls, select Use tree directives, and click
Directives.

Figure 6-21
Tree-growing directives
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Directive Syntax

Directives specify conditions for growing the tree, starting with the root node. For example
to grow the tree one level:

Grow Node Index 0 Children 12

Since no predictor is specified, the algorithm chooses the best split.

Note that the first split must always be on the root node (Index 0) and the index values for
both children must be specified (1 and 2 in this case). It is invalid to specify Grow Node Index 2
Children 3 4 unless you first grew the root that created Node 2.

To grow the tree:

Grow Tree

To grow and prune the tree (C&R Tree only):
Grow_And_Prune Tree

To specify a custom split for a continuous predictor:

Grow Node Index 0 Children 12 Spliton
("EDUCATE", Interval ( Negativelnfinity, 12.5)
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Interval ( 12.5, Infinity ))

To split on a nominal predictor with two values:

Grow Node Index 2 Children 3 4 Spliton
("GENDER", Group( "0.0" )Group( "1.0"))

To split on a nominal predictor with multiple values:

Grow Node Index 6 Children 7 8 Spliton
("ORGS", Group( "2.0",'4.0")
Group( "0.0°"1.0""3.0""6.0" )

To split on an ordinal predictor:

Grow Node Index 4 Children 5 6 Spliton
("CHILDS", Interval ( Negativelnfinity, 1.0)
Interval ( 1.0, Infinity ))

Note: When specifying custom splits, field names and values (EDUCATE, GENDER, CHILDS,

etc.) are case sensitive.

Directives for CHAID Trees

Directives for CHAID trees are particularly sensitive to changes in the data or model
because—unlike C&R Tree and QUEST—they are not constrained to use binary splits. For
example, the following syntax looks perfectly valid but would fail if the algorithm splits the root
node into more than two children:

Grow Node Index 0 Children 12
Grow Node Index 1 Children 3 4

With CHAID, it is possible that Node 0 will have 3 or 4 children, which would cause the second
line of syntax to fail.

Using Directives in Scripts

Directives can also be embedded in scripts using triple quotation marks.

Updating Tree Directives

>

To preserve your work from an interactive tree-building session, you can save the directives used
to generate the current tree. Unlike saving a model nugget, which cannot be edited further, this
allows you to regenerate the tree in its current state for further editing.

To update directives, from the tree builder menus choose:
File > Update Directives

Directives are saved in the modeling node used to create the tree (either C&R Tree, QUEST,
or CHAID) and can be used to regenerate the current tree. For more information, see the
topic [Tree-Growing Directives on p. [136|




139

Decision Trees

Exporting Model, Gain, and Risk Information

From the tree builder, you can export model, gain, and risk statistics in text, HTML, or image
formats as appropriate.

» In the tree builder window, select the tab or view that you want to export.

» From the menus choose:
File > Export

» Select Text, HTML, or Graph as appropriate, and select the specific items you want to export from
the submenu.

Where applicable, the export is based on current selections.

Exporting Text or HTML formats. You can export gain or risk statistics for the training or testing
partition (if defined). The export is based on the current selections on the Gains tab—for example,
you can choose node-by-node, cumulative, or quantile statistics.

Exporting graphics. You can export the current tree as displayed on the Viewer tab or export gains
charts for the training or testing partition (if defined). Available formats include .JPEG, .PNG,
and .BMP. For gains, the export is based on current selections on the Gains tab (available only
when a chart is displayed).

Generating Filter and Select Nodes

» In the tree builder window, or when browsing a decision tree model nugget, from the menus
choose:

Generate > Filter Node

or
> Select Node

Filter Node. Generates a node that filters any fields not used by the current tree. This is a quick
way to pare down the dataset to include only those fields that are selected as important by the
algorithm. If there is a Type node upstream from this decision tree node, any fields with the role
Target are passed on by the Filter model nugget.

Select Node. Generates a node that selects all records that fall into the current node. This option
requires that one or more tree branches be selected on the Viewer tab.

The model nugget is placed on the stream canvas.

Generating a Rule Set from a Decision Tree

You can generate a Rule Set model nugget that represents the tree structure as a set of rules
defining the terminal branches of the tree. Rule sets can often retain most of the important
information from a full decision tree but with a less complex model. The most important
difference is that with a rule set, more than one rule may apply for any particular record or no
rules at all may apply. For example, you might see all of the rules that predict a no outcome
followed by all of those that predict yes. If multiple rules apply, each rule gets a weighted “vote”
based on the confidence associated with that rule, and the final prediction is decided by combining
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the weighted votes of all of the rules that apply to the record in question. If no rule applies, a
default prediction is assigned to the record.

Rule sets can be generated only from trees with categorical target fields (no regression trees).

» In the tree builder window, or when browsing a decision tree model nugget, from the menus
choose:

Generate > Rule Set

Figure 6-22
Generate Rule Set dialog box
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Rule set name. Allows you to specify the name of the new Rule Set model nugget.

Create node on. Controls the location of the new Rule Set model nugget. Select Canvas, GM
Palette, or Both.

Minimum instances. Specify the minimum number of instances (number of records to which the

rule applies) to preserve in the Rule Set model nugget. Rules with support less than the specified
value will not be included in the new rule set.

Minimum confidence. Specify the minimum confidence for rules to be preserved in the Rule

Set model nugget. Rules with confidence less than the specified value will not be included
in the new rule set.

Building a Tree Model Directly

As an alternative to using the interactive tree builder, you can build a decision tree model directly
from the node when the stream is run. This is consistent with most other model-building nodes.

For C5.0 tree models, which are not supported by the interactive tree builder, this is the only
method that can be used.

» Create a stream and add one of the decision tree nodes—C&R Tree, CHAID, QUEST, or C5.0.
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Figure 6-23
Building a C5.0 tree directly
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» For C&R Tree, QUEST or CHAID, on the Objective panel of the Build Options tab, choose one of
the main objectives. If you choose Build a single tree, ensure that Mode is set to Generate model.

For C5.0, on the Model tab, set Output type to Decision tree.

» Select target and predictor fields and specify additional model options, as needed. For specific
instructions, see the documentation for each tree-building node.

» Run the stream to generate the model.

Comments
B When generating trees using this method, tree-growing directives are ignored.

B Whether interactive or direct, both methods of creating decision trees ultimately generate
similar models. It’s just a question of how much control you want along the way.

Decision Tree Nodes

The Decision Tree nodes in IBM® SPSS® Modeler provide access to the tree-building algorithms
introduced earlier:

B C&R Tree
m QUEST



142

Chapter 6

m CHAID
m C50

For more information, see the topic Decision Tree Models on p. [I16.

The algorithms are similar in that they can all construct a decision tree by recursively splitting the
data into smaller and smaller subgroups. However, there are some important differences.

Input fields. The input fields (predictors) can be any of the following types (measurement levels):
continuous, categorical, flag, nominal or ordinal.

Target fields. Only one target field can be specified. For C&R Tree and CHAID, the target can
be continuous, categorical, flag, nominal or ordinal. For QUEST it can be categorical, flag or
nominal. For C5.0 the target can be flag, nominal or ordinal.

Type of split. C&R Tree and QUEST support only binary splits (that is, each node of the tree can
be split into no more than two branches). By contrast, CHAID and C5.0 support splitting into
more than two branches at a time.

Method used for splitting. The algorithms differ in the criteria used to decide the splits. When C&R
Tree predicts a categorical output, a dispersion measure is used (by default the Gini coefficient,
though you can change this). For continuous targets, the least squared deviation method is used.
CHAID uses a chi-square test; QUEST uses a chi-square test for categorical predictors, and
analysis of variance for continuous inputs. For C5.0 an information theory measure is used,

the information gain ratio.

Missing value handling. All algorithms allow missing values for the predictor fields, though they
use different methods to handle them. C&R Tree and QUEST use substitute prediction fields,
where needed, to advance a record with missing values through the tree during training. CHAID
makes the missing values a separate category and allows them to be used in tree building. C5.0
uses a fractioning method, which passes a fractional part of a record down each branch of the tree
from a node where the split is based on a field with a missing value.

Pruning. C&R Tree, QUEST and C5.0 offer the option to grow the tree fully and then prune it
back by removing bottom-level splits that do not contribute significantly to the accuracy of the
tree. However, all of the decision tree algorithms allow you to control the minimum subgroup
size, which helps avoid branches with few data records.

Interactive tree building. C&R Tree, QUEST and CHAID provide an option to launch an
interactive session. This allows you to build your tree one level at a time, edit the splits, and prune
the tree before you create the model. C5.0 does not have an interactive option.

Prior probabilities. C&R Tree and QUEST support the specification of prior probabilities for
categories when predicting a categorical target field. Prior probabilities are estimates of the
overall relative frequency for each target category in the population from which the training data
are drawn. In other words, they are the probability estimates that you would make for each
possible target value prior to knowing anything about predictor values. CHAID and C5.0 do not
support specifying prior probabilities.
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Rule sets. For models with categorical target fields, the decision tree nodes provide the option
to create the model in the form of a rule set, which can sometimes be easier to interpret than a
complex decision tree. For C&R Tree, QUEST and CHAID you can generate a rule set from an
interactive session; for C5.0 you can specify this option on the modeling node. In addition,

all decision tree models enable you to generate a rule set from the model nugget. For more
information, see the topic [Generating a Rule Set from a Decision Tree on p. 139,

C&R Tree Node

The Classification and Regression (C&R) Tree node is a tree-based classification and prediction
method. Similar to C5.0, this method uses recursive partitioning to split the training records into
segments with similar output field values. The C&R Tree node starts by examining the input fields
to find the best split, measured by the reduction in an impurity index that results from the split.
The split defines two subgroups, each of which is subsequently split into two more subgroups, and
so on, until one of the stopping criteria is triggered. All splits are binary (only two subgroups).

Pruning

C&R Trees give you the option to first grow the tree and then prune based on a cost-complexity
algorithm that adjusts the risk estimate based on the number of terminal nodes. This method,
which allows the tree to grow large before pruning based on more complex criteria, may result

in smaller trees with better cross-validation properties. Increasing the number of terminal nodes
generally reduces the risk for the current (training) data, but the actual risk may be higher when
the model is generalized to unseen data. In an extreme case, suppose you have a separate terminal
node for each record in the training set. The risk estimate would be 0%, since every record falls
into its own node, but the risk of misclassification for unseen (testing) data would almost certainly
be greater than 0. The cost-complexity measure attempts to compensate for this.

Example. A cable TV company has commissioned a marketing study to determine which
customers would buy a subscription to an interactive news service via cable. Using the data from
the study, you can create a stream in which the target field is the intent to buy the subscription and
the predictor fields include age, sex, education, income category, hours spent watching television
each day, and number of children. By applying a C&R Tree node to the stream, you will be able to
predict and classify the responses to get the highest response rate for your campaign.

Requirements. To train a C&R Tree model, you need one or more Inputfields and exactly one
Target field. Target and input fields can be continuous (numeric range) or categorical. Fields set
to Both or None are ignored. Fields used in the model must have their types fully instantiated,
and any ordinal (ordered set) fields used in the model must have numeric storage (not string). If
necessary, the Reclassify node can be used to convert them.

Strengths. C&R Tree models are quite robust in the presence of problems such as missing data
and large numbers of fields. They usually do not require long training times to estimate. In
addition, C&R Tree models tend to be easier to understand than some other model types—the
rules derived from the model have a very straightforward interpretation. Unlike C5.0, C&R Tree
can accommodate continuous as well as categorical output fields.
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CHAID Node

CHAID, or Chi-squared Automatic Interaction Detection, is a classification method for building
decision trees by using chi-square statistics to identify optimal splits.

CHALID first examines the crosstabulations between each of the input fields and the outcome,
and tests for significance using a chi-square independence test. If more than one of these relations
is statistically significant, CHAID will select the input field that is the most significant (smallest p
value). If an input has more than two categories, these are compared, and categories that show no
differences in the outcome are collapsed together. This is done by successively joining the pair of
categories showing the least significant difference. This category-merging process stops when all
remaining categories differ at the specified testing level. For nominal input fields, any categories
can be merged; for an ordinal set, only contiguous categories can be merged.

Exhaustive CHAID is a modification of CHAID that does a more thorough job of examining all
possible splits for each predictor but takes longer to compute.

Requirements. Target and input fields can be continuous or categorical; nodes can be split into two
or more subgroups at each level. Any ordinal fields used in the model must have numeric storage
(not string). If necessary, the Reclassify node can be used to convert them.

Strengths. Unlike the C&R Tree and QUEST nodes, CHAID can generate nonbinary trees,
meaning that some splits have more than two branches. It therefore tends to create a wider tree
than the binary growing methods. CHAID works for all types of inputs, and it accepts both
case weights and frequency variables.

QUEST Node

QUEST—or Quick, Unbiased, Efficient Statistical Tree—is a binary classification method for
building decision trees. A major motivation in its development was to reduce the processing time
required for large C&R Tree analyses with either many variables or many cases. A second goal of
QUEST was to reduce the tendency found in classification tree methods to favor inputs that allow
more splits, that is, continuous (numeric range) input fields or those with many categories.

m  QUEST uses a sequence of rules, based on significance tests, to evaluate the input fields at
a node. For selection purposes, as little as a single test may need to be performed on each
input at a node. Unlike C&R Tree, all splits are not examined, and unlike C&R Tree and
CHALID, category combinations are not tested when evaluating an input field for selection.
This speeds the analysis.

m  Splits are determined by running quadratic discriminant analysis using the selected input on
groups formed by the target categories. This method again results in a speed improvement
over exhaustive search (C&R Tree) to determine the optimal split.

Requirements. Input fields can be continuous (numeric ranges), but the target field must be
categorical. All splits are binary. Weight fields cannot be used. Any ordinal (ordered set) fields
used in the model must have numeric storage (not string). If necessary, the Reclassify node
can be used to convert them.

Strengths. Like CHAID, but unlike C&R Tree, QUEST uses statistical tests to decide whether or
not an input field is used. It also separates the issues of input selection and splitting, applying
different criteria to each. This contrasts with CHAID, in which the statistical test result that
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determines variable selection also produces the split. Similarly, C&R Tree employs the
impurity-change measure to both select the input field and to determine the split.

Decision Tree Node Fields Options

On the Fields tab, you choose whether you want to use the field role settings already defined in
upstream nodes, or make the field assignments manually.

Figure 6-24

C&R Tree node, Fields tab
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Use predefined roles. This option uses the role settings (targets, predictors and so on) from an
upstream Type node (or the Types tab of an upstream source node).

Use custom field assignments. Choose this option if you want to assign targets, predictors and
other roles manually on this screen.

Fields. Use the arrow buttons to assign items manually from this list to the various role fields on
the right of the screen. The icons indicate the valid measurement levels for each role field.
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Click the All button to select all the fields in the list, or click an individual measurement level
button to select all fields with that measurement level.

Target. Choose one field as the target for the prediction.
Predictors (Inputs). Choose one or more fields as inputs for the prediction.

Analysis Weight. (CHAID and C&RT only) To use a field as a case weight, specify the field here.
Case weights are used to account for differences in variance across levels of the output field. For
more information, see the topic [Using Frequency and Weight Fields in Chapter 3 on p. 8.

Decision Tree Node Build Options

The Build Options tab is where you set all the options for building the model. You can, of course,
just click the Run button to build a model with all the default options, but normally you will want
to customize the build for your own purposes.

You can choose here whether to build a new model or update an existing one. You also set the
main objective of the node: to build a standard model, to build one with enhanced accuracy or
stability, or to build one for use with very large datasets.
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Figure 6-25

C&R Tree node, Build Options tab
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What do you want to do?

Decision Trees

Build new model. (Default) Creates a completely new model each time you run a stream containing
this modeling node.

Continue training existing model. By default, a completely new model is created each time a
modeling node is executed. If this option is selected, training continues with the last model
successfully produced by the node. This makes it possible to update or refresh an existing model
without having to access the original data and may result in significantly faster performance since
only the new or updated records are fed into the stream. Details on the previous model are stored
with the modeling node, making it possible to use this option even if the previous model nugget is
no longer available in the stream or Models palette.

Note: This option is activated only if you select Create a model for very large datasets as the

objective.
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What is your main objective?

m  Build a single tree. Creates a single, standard decision tree model. Standard models are

generally easier to interpret, and can be faster to score, than models built using the other
objective options.

Mode. Specifies the method used to build the model. Generate model creates a model
automatically when the stream is run. Launch interactive session opens the tree builder, which
allows you to build your tree one level at a time, edit splits, and prune as desired before
creating the model nugget.

Use tree directives. Select this option to specify directives to apply when generating an
interactive tree from the node. For example, you can specify the first- and second-level splits,
and these would automatically be applied when the tree builder is launched. You can also save
directives from an interactive tree-building session in order to re-create the tree at a future
date. For more information, see the topic Updating Tree Directives on p. [I38.

Enhance model accuracy (boosting). Choose this option if you want to use a special method,
known as boosting, to improve the model accuracy rate. Boosting works by building multiple
models in a sequence. The first model is built in the usual way. Then, a second model is built
in such a way that it focuses on the records that were misclassified by the first model. Then

a third model is built to focus on the second model’s errors, and so on. Finally, cases are
classified by applying the whole set of models to them, using a weighted voting procedure

to combine the separate predictions into one overall prediction. Boosting can significantly
improve the accuracy of a decision tree model, but it also requires longer training.

Enhance model stability (bagging). Choose this option if you want to use a special method,
known as bagging (bootstrap aggregating), to improve the stability of the model and to
avoid overfitting. This option creates multiple models and combines them, in order to obtain
more reliable predictions. Models obtained using this option can take longer to build and
score than standard models.

Create a model for very large datasets. Choose this option when working with datasets that are
too large to build a model using any of the other objective options. This option divides the data
into smaller data blocks and builds a model on each block. The most accurate models are then
automatically selected and combined into a single model nugget. You can perform incremental
model updating if you select the Continue training existing model option on this screen. Note:
This option for very large datasets requires a connection to IBM® SPSS® Modeler Server.

Decision Tree Nodes - Basics

This is where you specify the basic options about how the decision tree is to be built.
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Figure 6-26
Decision tree basic options
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Tree growing algorithm. (CHAID only) Choose the type of CHAID algorithm you want to use.
Exhaustive CHAID is a modification of CHAID that does a more thorough job of examining all
possible splits for each predictor but takes longer to compute.

Maximum tree depth. Specify the maximum number of levels below the root node (the number of
times the sample will be split recursively). The default is 5; choose Custom and enter a value to
specify a different number of levels.

Pruning (C&RT and QUEST only)

Prune tree to avoid overfitting. Pruning consists of removing bottom-level splits that do not
contribute significantly to the accuracy of the tree. Pruning can help simplify the tree, making it
easier to interpret and, in some cases, improving generalization. If you want the full tree without
pruning, leave this option deselected.

®  Maximum difference in risk (in Standard Errors). Enables you to specify a more liberal pruning
rule. The standard error rule allows the algorithm to select the simplest tree whose risk
estimate is close to (but possibly greater than) that of the subtree with the smallest risk. The
value indicates the size of the allowable difference in the risk estimate between the pruned tree
and the tree with the smallest risk in terms of the risk estimate. For example, if you specify 2, a
tree whose risk estimate is (2 x standard error) larger than that of the full tree could be selected.
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Maximum surrogates. Surrogates are a method for dealing with missing values. For each split in
the tree, the algorithm identifies the input fields that are most similar to the selected split field.
Those fields are the surrogates for that split. When a record must be classified but has a missing
value for a split field, its value on a surrogate field can be used to make the split. Increasing
this setting will allow more flexibility to handle missing values but may also lead to increased
memory usage and longer training times.

Decision Tree Nodes - Stopping Rules

Figure 6-27
Options for stopping rules
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These options control how the tree is constructed. Stopping rules determine when to stop splitting
specific branches of the tree. Set the minimum branch sizes to prevent splits that would create
very small subgroups. Minimum records in parent branch will prevent a split if the number of
records in the node to be split (the parent) is less than the specified value. Minimum records in
child branch will prevent a split if the number of records in any branch created by the split (the
child) would be less than the specified value.

m  Use percentage. Allows you to specify sizes in terms of percentage of overall training data.

m Use absolute value. Allows you to specify sizes as the absolute numbers of records.
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Decision Tree Nodes - Ensembles

Figure 6-28
Options for ensembling
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These settings determine the behavior of ensembling that occurs when boosting, bagging, or very

large datasets are requested in Objectives. Options that do not apply to the selected objective
are ignored.

Bagging and Very Large Datasets. When scoring an ensemble, this is the rule used to combine the
predicted values from the base models to compute the ensemble score value.

m  Default combining rule for categorical targets. Ensemble predicted values for categorical targets
can be combined using voting, highest probability, or highest mean probability. Voting selects
the category that has the highest probability most often across the base models. Highest
probability selects the category that achieves the single highest probability across all base
models. Highest mean probability selects the category with the highest value when the
category probabilities are averaged across base models.

m  Default combining rule for continuous targets. Ensemble predicted values for continuous targets
can be combined using the mean or median of the predicted values from the base models.
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Note that when the objective is to enhance model accuracy, the combining rule selections are
ignored. Boosting always uses a weighted majority vote to score categorical targets and a
weighted median to score continuous targets.

Boosting and Bagging. Specify the number of base models to build when the objective is to
enhance model accuracy or stability; for bagging, this is the number of bootstrap samples. It
should be a positive integer.

C&R Tree and QUEST Nodes - Costs & Priors

Figure 6-29
Setting misclassification costs and prior probabilities
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Misclassification Costs

In some contexts, certain kinds of errors are more costly than others. For example, it may be more
costly to classify a high-risk credit applicant as low risk (one kind of error) than it is to classify a
low-risk applicant as high risk (a different kind of error). Misclassification costs allow you to
specify the relative importance of different kinds of prediction errors.
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Misclassification costs are basically weights applied to specific outcomes. These weights are
factored into the model and may actually change the prediction (as a way of protecting against
costly mistakes).

With the exception of C5.0 models, misclassification costs are not applied when scoring a model
and are not taken into account when ranking or comparing models using an Auto Classifier node,
evaluation chart, or Analysis node. A model that includes costs may not produce fewer errors
than one that doesn’t and may not rank any higher in terms of overall accuracy, but it is likely to
perform better in practical terms because it has a built-in bias in favor of less expensive errors.

The cost matrix shows the cost for each possible combination of predicted category and actual
category. By default, all misclassification costs are set to 1.0. To enter custom cost values, select
Use misclassification costs and enter your custom values into the cost matrix.

To change a misclassification cost, select the cell corresponding to the desired combination
of predicted and actual values, delete the existing contents of the cell, and enter the desired
cost for the cell. Costs are not automatically symmetrical. For example, if you set the cost of
misclassifying A as B to be 2.0, the cost of misclassifying B as A will still have the default value
of 1.0 unless you explicitly change it as well.

Priors

These options allow you to specify prior probabilities for categories when predicting a categorical
target field. Prior probabilities are estimates of the overall relative frequency for each target
category in the population from which the training data are drawn. In other words, they are

the probability estimates that you would make for each possible target value prior to knowing
anything about predictor values. There are three methods of setting priors:

m Based on training data. This is the default. Prior probabilities are based on the relative
frequencies of the categories in the training data.

m  Equal for all classes. Prior probabilities for all categories are defined as 1/k, where k is the
number of target categories.

m  Custom. You can specify your own prior probabilities. Starting values for prior probabilities
are set as equal for all classes. You can adjust the probabilities for individual categories to
user-defined values. To adjust a specific category’s probability, select the probability cell in
the table corresponding to the desired category, delete the contents of the cell, and enter the
desired value.

The prior probabilities for all categories should sum to 1.0 (the probability constraint). If they do
not sum to 1.0, a warning is displayed, with an option to automatically normalize the values. This
automatic adjustment preserves the proportions across categories while enforcing the probability
constraint. You can perform this adjustment at any time by clicking the Normalize button. To reset
the table to equal values for all categories, click the Equalize button.

Adjust priors using misclassification costs. This option allows you to adjust the priors, based

on misclassification costs (specified on the Costs tab). This enables you to incorporate cost
information directly into the tree-growing process for trees that use the Twoing impurity measure.
(When this option is not selected, cost information is used only in classifying records and
calculating risk estimates for trees based on the Twoing measure.)
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CHAID Node - Costs

Figure 6-30
Misclassification costs in the CHAID node
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In some contexts, certain kinds of errors are more costly than others. For example, it may be more
costly to classify a high-risk credit applicant as low risk (one kind of error) than it is to classify a
low-risk applicant as high risk (a different kind of error). Misclassification costs allow you to
specify the relative importance of different kinds of prediction errors.

Misclassification costs are basically weights applied to specific outcomes. These weights are
factored into the model and may actually change the prediction (as a way of protecting against
costly mistakes).

With the exception of C5.0 models, misclassification costs are not applied when scoring a model
and are not taken into account when ranking or comparing models using an Auto Classifier node,
evaluation chart, or Analysis node. A model that includes costs may not produce fewer errors
than one that doesn’t and may not rank any higher in terms of overall accuracy, but it is likely to
perform better in practical terms because it has a built-in bias in favor of less expensive errors.

The cost matrix shows the cost for each possible combination of predicted category and actual
category. By default, all misclassification costs are set to 1.0. To enter custom cost values, select
Use misclassification costs and enter your custom values into the cost matrix.

To change a misclassification cost, select the cell corresponding to the desired combination
of predicted and actual values, delete the existing contents of the cell, and enter the desired
cost for the cell. Costs are not automatically symmetrical. For example, if you set the cost of
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misclassifying A as B to be 2.0, the cost of misclassifying B as A will still have the default value
of 1.0 unless you explicitly change it as well.

C&R Tree Node - Advanced

The advanced options enable you to fine-tune the tree-building process.

Figure 6-31
Setting advanced options for the C&R Tree node
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Minimum change in impurity. Specify the minimum change in impurity to create a new split in the
tree. Impurity refers to the extent to which subgroups defined by the tree have a wide range of
output field values within each group. For categorical targets, a node is considered “pure” if 100%
of cases in the node fall into a specific category of the target field. The goal of tree building is to
create subgroups with similar output values—in other words, to minimize the impurity within
each node. If the best split for a branch reduces the impurity by less than the specified amount,
the split will not be made.

Impurity measure for categorical targets. For categorical target fields, specify the method used to
measure the impurity of the tree. (For continuous targets, this option is ignored, and the least
squared deviation impurity measure is always used.)

B Gini is a general impurity measure based on probabilities of category membership for the
branch.
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B Twoing is an impurity measure that emphasizes the binary split and is more likely to lead to
approximately equal-sized branches from a split.

B Ordered adds the additional constraint that only contiguous target classes can be grouped
together, as is applicable only with ordinal targets. If this option is selected for a nominal
target, the standard twoing measure is used by default.

Overfit prevention set. The algorithm internally separates records into a model building set and
an overfit prevention set, which is an independent set of data records used to track errors during
training in order to prevent the method from modeling chance variation in the data. Specify a
percentage of records. The default is 30.

Replicate results. Setting a random seed allows you to replicate analyses. Specify an integer or
click Generate, which will create a pseudo-random integer between 1 and 2147483647, inclusive.

QUEST Node - Advanced

The advanced options enable you to fine-tune the tree-building process.

Figure 6-32
Setting advanced options for the QUEST node
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Significance level for splitting. Specifies the significance level (alpha) for splitting nodes. The
value must be between 0 and 1. Lower values tend to produce trees with fewer nodes.

Overfit prevention set. The algorithm internally separates records into a model building set and
an overfit prevention set, which is an independent set of data records used to track errors during
training in order to prevent the method from modeling chance variation in the data. Specify a
percentage of records. The default is 30.

Replicate results. Setting a random seed allows you to replicate analyses. Specify an integer or
click Generate, which will create a pseudo-random integer between 1 and 2147483647, inclusive.

CHAID Node - Advanced

The advanced options enable you to fine-tune the tree-building process.

Figure 6-33

Setting advanced options for the CHAID node
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Significance level for splitting. Specifies the significance level (alpha) for splitting nodes. The
value must be between 0 and 1. Lower values tend to produce trees with fewer nodes.
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Significance level for merging. Specifies the significance level (alpha) for merging categories. The
value must be greater than 0 and less than or equal to 1. To prevent any merging of categories,
specify a value of 1. For continuous targets, this means the number of categories for the variable
in the final tree matches the specified number of intervals. This option is not available for
Exhaustive CHAID.

Adjust significance values using Bonferroni method. Adjusts significance values when testing the
various category combinations of a predictor. Values are adjusted based on the number of tests,
which directly relates to the number of categories and measurement level of a predictor. This is
generally desirable because it better controls the false-positive error rate. Disabling this option
will increase the power of your analysis to find true differences, but at the cost of an increased
false-positive rate. In particular, disabling this option may be recommended for small samples.

Allow resplitting of merged categories within a node. The CHAID algorithm attempts to merge
categories in order to produce the simplest tree that describes the model. If selected, this option
allows merged categories to be resplit if that results in a better solution.

Chi-square for categorical targets. For categorical targets, you can specify the method used
to calculate the chi-square statistic.

m  Pearson. This method provides faster calculations but should be used with caution on small
samples.

m Likelihood ratio. This method is more robust than Pearson but takes longer to calculate. For
small samples, this is the preferred method. For continuous targets, this method is always used.

Minimum change in expected cell frequencies. When estimating cell frequencies (for both the
nominal model and the row effects ordinal model), an iterative procedure (epsilon) is used to
converge on the optimal estimate used in the chi-square test for a specific split. Epsilon determines
how much change must occur for iterations to continue; if the change from the last iteration is
smaller than the specified value, iterations stop. If you are having problems with the algorithm
not converging, you can increase this value or increase the maximum number of iterations until
convergence occurs.

Maximum iterations for convergence. Specifies the maximum number of iterations before stopping,

whether convergence has taken place or not.

Replicate results. Setting a random seed allows you to replicate analyses. Specify an integer or
click Generate, which will create a pseudo-random integer between 1 and 2147483647, inclusive.

Decision Tree Node Model Options

On the Model Options tab, you can choose whether to specify a name for the model, or generate a
name automatically. You can also choose to obtain predictor importance information, as well as
raw and adjusted propensity scores for flag targets.
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Figure 6-34
Setting the model options for a decision tree node
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Model name. You can generate the model name automatically based on the target or ID field (or
model type in cases where no such field is specified) or specify a custom name.

Model Evaluation

Calculate predictor importance. For models that produce an appropriate measure of importance,
you can display a chart that indicates the relative importance of each predictor in estimating the
model. Typically you will want to focus your modeling efforts on the predictors that matter most,
and consider dropping or ignoring those that matter least. Note that predictor importance may take
longer to calculate for some models, particularly when working with large datasets, and is off by
default for some models as a result. Predictor importance is not available for decision list models.
For more information, see the topic [Predictor Importance in Chapter 3 on p. [51].
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Propensity Scores

Propensity scores can be enabled in the modeling node, and on the Settings tab in the model
nugget. This functionality is available only when the selected target is a flag field. For more
information, see the topic [Propensity Scores in Chapter 3 on p. {1].

Calculate raw propensity scores. Raw propensity scores are derived from the model based on the
training data only. If the model predicts the true value (will respond), then the propensity is the
same as P, where P is the probability of the prediction. If the model predicts the false value,
then the propensity is calculated as (1 — P).

®  If you choose this option when building the model, propensity scores will be enabled in the
model nugget by default. However, you can always choose to enable raw propensity scores in
the model nugget whether or not you select them in the modeling node.

B When scoring the model, raw propensity scores will be added in a field with the letters RP
appended to the standard prefix. For example, if the predictions are in a field named $R-churn,
the name of the propensity score field will be $RRP-churn.

Calculate adjusted propensity scores. Raw propensities are based purely on estimates given by

the model, which may be overfitted, leading to over-optimistic estimates of propensity. Adjusted
propensities attempt to compensate by looking at how the model performs on the test or validation
partitions and adjusting the propensities to give a better estimate accordingly.

m  This setting requires that a valid partition field is present in the stream.

m  Unlike raw confidence scores, adjusted propensity scores must be calculated when building
the model; otherwise, they will not be available when scoring the model nugget.

B When scoring the model, adjusted propensity scores will be added in a field with the letters AP
appended to the standard prefix. For example, if the predictions are in a field named $R-churn,
the name of the propensity score field will be $RAP-churn. Adjusted propensity scores are
not available for logistic regression models.

B When calculating the adjusted propensity scores, the test or validation partition used for the
calculation must not have been balanced. To avoid this, be sure the Only balance training data
option is selected in any upstream Balance nodes. In addition, if a complex sample has been
taken upstream this will invalidate the adjusted propensity scores.

®  Adjusted propensity scores are not available for “boosted” tree and rule set models. For more
information, see the topic Boosted C5.0 Models on p. [171].

Based on. For adjusted propensity scores to be computed, a partition field must be present
in the stream. You can specify whether to use the testing or validation partition for this
computation. For best results, the testing or validation partition should include at least as
many records as the partition used to train the original model.

C5.0 Node

Note: This feature is available in SPSS Modeler Professional and SPSS Modeler Premium.
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This node uses the C5.0 algorithm to build either a decision tree or a rule set. A C5.0 model
works by splitting the sample based on the field that provides the maximum information gain.
Each subsample defined by the first split is then split again, usually based on a different field, and
the process repeats until the subsamples cannot be split any further. Finally, the lowest-level
splits are reexamined, and those that do not contribute significantly to the value of the model are
removed or pruned.

Note: The C5.0 node can predict only a categorical target. When analyzing data with categorical
(nominal or ordinal) fields, the node is more likely to group categories together than versions of
C5.0 prior to release 11.0.

C5.0 can produce two kinds of models. A decision tree is a straightforward description of the
splits found by the algorithm. Each terminal (or “leaf”’) node describes a particular subset of the
training data, and each case in the training data belongs to exactly one terminal node in the tree.
In other words, exactly one prediction is possible for any particular data record presented to

a decision tree.

In contrast, a rule set is a set of rules that tries to make predictions for individual records. Rule
sets are derived from decision trees and, in a way, represent a simplified or distilled version of the
information found in the decision tree. Rule sets can often retain most of the important information
from a full decision tree but with a less complex model. Because of the way rule sets work, they
do not have the same properties as decision trees. The most important difference is that with a
rule set, more than one rule may apply for any particular record, or no rules at all may apply. If
multiple rules apply, each rule gets a weighted “vote” based on the confidence associated with that
rule, and the final prediction is decided by combining the weighted votes of all of the rules that
apply to the record in question. If no rule applies, a default prediction is assigned to the record.

Example. A medical researcher has collected data about a set of patients, all of whom suffered
from the same illness. During their course of treatment, each patient responded to one of five
medications. You can use a C5.0 model, in conjunction with other nodes, to help find out which
drug might be appropriate for a future patient with the same illness.

Requirements. To train a C5.0 model, there must be one categorical (i.e., nominal or ordinal) Target
field, and one or more Input fields of any type. Fields set to Both or None are ignored. Fields used
in the model must have their types fully instantiated. A weight field can also be specified.

Strengths. C5.0 models are quite robust in the presence of problems such as missing data and large
numbers of input fields. They usually do not require long training times to estimate. In addition,
C5.0 models tend to be easier to understand than some other model types, since the rules derived
from the model have a very straightforward interpretation. C5.0 also offers the powerful boosting
method to increase accuracy of classification.

Note: C5.0 model building speed may benefit from enabling parallel processing.
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C5.0 Node Model Options

Figure 6-35
C5.0 node model options
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Model name. Specify the name of the model to be produced.

®  Auto. With this option selected, the model name will be generated automatically, based on
the target field name(s). This is the default.

m  Custom. Select this option to specify your own name for the model nugget that will be created
by this node.

Use partitioned data. If a partition field is defined, this option ensures that data from only the
training partition is used to build the model.

Create split models. Builds a separate model for each possible value of input fields that are specified
as split fields. For more information, see the topic [Building Split Models in Chapter 3 on p. 30|

Output type. Specify here whether you want the resulting model nugget to be a Decision tree or
a Rule set.

Group symbolics. If this option is selected, C5.0 will attempt to combine symbolic values that have
similar patterns with respect to the output field. If this option is not selected, C5.0 will create a
child node for every value of the symbolic field used to split the parent node. For example, if
C5.0 splits on a COLOR field (with values RED, GREEN, and BLUE), it will create a three-way
split by default. However, if this option is selected, and the records where COLOR = RED are
very similar to records where COLOR = BLUE, it will create a two-way split, with the GREENs
in one group and the BLUESs and REDs together in the other.
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Use boosting. The C5.0 algorithm has a special method for improving its accuracy rate, called
boosting. It works by building multiple models in a sequence. The first model is built in the
usual way. Then, a second model is built in such a way that it focuses on the records that were
misclassified by the first model. Then a third model is built to focus on the second model’s errors,
and so on. Finally, cases are classified by applying the whole set of models to them, using a
weighted voting procedure to combine the separate predictions into one overall prediction.
Boosting can significantly improve the accuracy of a C5.0 model, but it also requires longer
training. The Number of trials option allows you to control how many models are used for the
boosted model. This feature is based on the research of Freund & Schapire, with some proprietary
improvements to handle noisy data better.

Cross-validate. If this option is selected, C5.0 will use a set of models built on subsets of the
training data to estimate the accuracy of a model built on the full dataset. This is useful if your
dataset is too small to split into traditional training and testing sets. The cross-validation models
are discarded after the accuracy estimate is calculated. You can specify the number of folds, or
the number of models used for cross-validation. Note that in previous versions of IBM® SPSS®
Modeler, building the model and cross-validating it were two separate operations. In the current
version, no separate model-building step is required. Model building and cross-validation are
performed at the same time.

Mode. For Simple training, most of the C5.0 parameters are set automatically. Expert training
allows more direct control over the training parameters.

Simple Mode Options

Favor. By default, C5.0 will try to produce the most accurate tree possible. In some instances, this
can lead to overfitting, which can result in poor performance when the model is applied to new
data. Select Generality to use algorithm settings that are less susceptible to this problem.

Note: Models built with the Generality option selected are not guaranteed to generalize better
than other models. When generality is a critical issue, always validate your model against a
held-out test sample.

Expected noise (%). Specify the expected proportion of noisy or erroneous data in the training set.

Expert Mode Options

Pruning severity. Determines the extent to which the decision tree or rule set will be pruned.
Increase this value to obtain a smaller, more concise tree. Decrease it to obtain a more accurate
tree. This setting affects local pruning only (see “Use global pruning” below).

Minimum records per child branch. The size of subgroups can be used to limit the number of splits
in any branch of the tree. A branch of the tree will be split only if two or more of the resulting
subbranches would contain at least this many records from the training set. The default value is 2.
Increase this value to help prevent overtraining with noisy data.

Use global pruning. Trees are pruned in two stages: First, a local pruning stage, which examines
subtrees and collapses branches to increase the accuracy of the model. Second, a global pruning
stage considers the tree as a whole, and weak subtrees may be collapsed. Global pruning is
performed by default. To omit the global pruning stage, deselect this option.
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Winnow attributes. If this option is selected, C5.0 will examine the usefulness of the predictors
before starting to build the model. Predictors that are found to be irrelevant are then excluded
from the model-building process. This option can be helpful for models with many predictor
fields and can help prevent overfitting.

Note: C5.0 model building speed may benefit from enabling parallel processing.

Decision Tree Model Nuggets

Decision tree model nuggets represent the tree structures for predicting a particular output

field discovered by one of the decision tree modeling nodes (C&R Tree, CHAID, QUEST or
C5.0). Tree models can be generated directly from the tree-building node, or indirectly from the
interactive tree builder. For more information, see the topic The Interactive Tree Builder on p. [T19.

Scoring Tree Models

When you run a stream containing a tree model nugget, the specific result depends on the type
of tree.

m  For classification trees (categorical target), two new fields, containing the predicted value and
the confidence for each record, are added to the data. The prediction is based on the most
frequent category for the terminal node to which the record is assigned; if a majority of
respondents in a given node is yes, the prediction for all records assigned to that node is yes.

For regression trees, only predicted values are generated; confidences are not assigned.

®  Optionally, for CHAID, QUEST, and C&R Tree models, an additional field can be added that
indicates the ID for the node to which each record is assigned.

The new field names are derived from the model name by adding prefixes. For C&R Tree, CHAID,
and QUEST, the prefixes are $R- for the prediction field, $RC- for the confidence field, and $RI-
for the node identifier field. For C5.0 trees, the prefixes are $C- for the prediction field and $CC-
for the confidence field. If multiple tree model nodes are present, the new field names will include
numbers in the prefix to distinguish them if necessary—for example, $R7- and SRCI-, and $R2-.

Working with Tree Model Nuggets

You can save or export information related to the model in a number of ways.
Note: Many of these options are also available from the tree builder window.

From either the tree builder or a tree model nugget, you can:

B Generate a Filter or Select node based on the current tree. For more information, see the
topic [Generating Filter and Select Nodes on p. [139.

m  Generate a Rule Set nugget that represents the tree structure as a set of rules defining the
terminal branches of the tree. For more information, see the topic (Generating a Rule Sef
from a Decision Tree| on p. [139.

®m In addition, for tree model nuggets only, you can export the model in PMML format. For more
information, see the topic The Models Palette in Chapter 3 on p. 47. If the model includes any
custom splits, this information is not preserved in the exported PMML. (The split is preserved,
but the fact that it is custom rather than chosen by the algorithm is not.)
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B Generate a graph based on a selected part of the current tree. Note: this only works for
a nugget when it is attached to other nodes in a stream. For more information, see the
topic [Generating Graphs on p. [172,

®  For boosted C5.0 models only, you can choose Single Decision Tree (Canvas) or Single Decision
Tree (GM Palette) to create a new single rule set derived from the currently selected rule. For

more information, see the topic [Boosted C5.0 Models on p. [I71].

Note: Although the Build Rule node was replaced by the C&R Tree node, decision tree nodes in
existing streams that were originally created using a Build Rule node will still function properly.

Single Tree Model Nuggets

If you select Build a single tree as the main objective on the modeling node, the resulting model
nugget contains the following tabs.

Tab Description Further Information
Model Displays the rules that define the model. |For more information, see the
topic Decision Tree Model Rules on p.
165.
Viewer Displays the tree view of the model. For more information, see the
topic Decision Tree Model Viewer on
p- [168.
Summary Displays information about the fields, For more information, see the
build settings, and model estimation topic Model Nugget Summary /
process. [nformation in Chapter 3 on p. [50.
Settings Enables you to specify options for For more information, see the
confidences and for SQL generation topic [Decision Tree/Rule Set Model
during model scoring. Nugget Settings on p. 170,
Annotation Enables you to add descriptive
annotations, specify a custom name, add
tooltip text and specify search keywords
for the model.

Decision Tree Model Rules

The Model tab for a decision tree nugget displays the rules that define the model. Optionally, a
graph of predictor importance and a third panel with information about history, frequencies,
and surrogates can also be displayed.

Note: If you select the Create a model for very large datasets option on the CHAID node Build
Options tab (Objective panel), the Model tab displays the tree rule details only.
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Figure 6-36
Decision tree model nugget
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Tree Rules

The left pane displays a list of conditions defining the partitioning of data discovered by the
algorithm—essentially a series of rules that can be used to assign individual records to child
nodes based on the values of different predictors.

Decision trees work by recursively partitioning the data based on input field values. The data
partitions are called branches. The initial branch (sometimes called the root) encompasses all
data records. The root is split into subsets, or child branches, based on the value of a particular
input field. Each child branch can be further split into sub-branches, which can in turn be split
again, and so on. At the lowest level of the tree are branches that have no more splits. Such
branches are known as terminal branches (or leaves).

The rule browser shows the input values that define each partition or branch and a summary
of output field values for the records in that split. For general information on using the model
browser, see Browsing Model Nuggets|.

For splits based on numeric fields, the branch is shown by a line of the form:

fieldname relation value [summary]
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where relation is a numeric relation. For example, a branch defined by values greater than 100 for
the revenue field would be shown as:

revenue > 100 [summary]

For splits based on symbolic fields, the branch is shown by a line of the form:

fieldname = value [summary] or fieldname in [values] [summary]

where values represents the field values that define the branch. For example, a branch that includes
records where the value of region can be North, West, or South would be represented as:

region in ['North" "West" "South"] [summary]

For terminal branches, a prediction is also given, adding an arrow and the predicted value to the
end of the rule condition. For example, a leaf defined by revenue > 100 that predicts a value of
high for the output field would be displayed as:

revenue > 100 [Mode: high] — high

The summary for the branch is defined differently for symbolic and numeric output fields. For
trees with numeric output fields, the summary is the average value for the branch, and the effect
of the branch is the difference between the average for the branch and the average of its parent
branch. For trees with symbolic output fields, the summary is the mode, or the most frequent
value, for records in the branch.

To fully describe a branch, you need to include the condition that defines the branch, plus the
conditions that define the splits further up the tree. For example, in the tree:

revenue > 100
region = "North"
region in ["South" "East" "West']
revenue <= 200

the branch represented by the second line is defined by the conditions revenue > 100 and region =
“North”.

If you click Show Instances/Confidence on the toolbar, each rule will also show information
about the number of records to which the rule applies (Instances) and the proportion of those
records for which the rule is true (Confidence).

Predictor Importance

Optionally, a chart that indicates the relative importance of each predictor in estimating the model
may also be displayed on the Model tab. Typically you will want to focus your modeling efforts
on the predictors that matter most and consider dropping or ignoring those that matter least. Note
this chart is only available if Calculate predictor importance is selected on the Analyze tab before
generating the model. For more information, see the topic [Predictor Importance in Chapter 3

onp. 51.
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Additional Model Information

If you click Show Additional Information Panel on the toolbar, you will see a panel at the bottom
of the window displaying detailed information for the selected rule. The information panel
contains three tabs.

Figure 6-37
Surrogates displayed in the Information panel
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History. This tab traces the split conditions from the root node down to the selected node. This
provides a list of conditions that determine when a record is assigned to the selected node. Records
for which all of the conditions are true will be assigned to this node.

Frequencies. For models with symbolic target fields, this tab shows, for each possible target value,
the number of records assigned to this node (in the training data) that have that target value. The
frequency figure, expressed as a percentage (shown to a maximum of three decimal places) is also
displayed. For models with numeric targets, this tab is empty.

Surrogates. Where applicable, any surrogates for the primary split field are shown for the
selected node. Surrogates are alternate fields used if the primary predictor value is missing for a
given record. The maximum number of surrogates allowed for a given split is specified in the
tree-building node, but the actual number depends on the training data. In general, the more
missing data, the more surrogates are likely to be used. For other decision tree models, this tab
is empty.

Note: To be included in the model, surrogates must be identified during the training phase. If the
training sample has no missing values, then no surrogates will be identified, and any records with
missing values encountered during testing or scoring will automatically fall into the child node
with the largest number of records. If missing values are expected during testing or scoring,

be sure that values are missing from the training sample, as well. Surrogates are not available
for CHAID trees.

Decision Tree Model Viewer

The Viewer tab for a decision tree model nugget resembles the display in the tree builder. The
main difference is that when browsing the model nugget, you can not grow or modify the tree.
Other options for viewing and customizing the display are similar between the two components.
For more information, see the topic Customizing the Tree View on p. [124]

Note: The Viewer tab is not displayed for CHAID model nuggets built if you select the Create a
model for very large datasets option on the Build Options tab - Objective panel.
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Figure 6-38
Decision tree Viewer tab with tree map window
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When viewing split rules on the Viewer tab, square brackets mean that the adjacent value is
included in the range whereas parentheses indicate that the adjacent value is excluded from the
range. The expression (23,37] therefore means from 23 exclusive to 37 inclusive, i.e. from just
above 23 to 37. On the Model tab, the same condition would be displayed as:

Age > 23 and Age <= 37
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Figure 6-39
Split rules displayed on the Viewer tab
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Decision Tree/Rule Set Model Nugget Settings

The Settings tab for a decision tree or Rule Set model nugget allows you to specify options
for confidences and for SQL generation during model scoring. This tab is available only after
the model nugget has been added to a stream.

Figure 6-40
Example of decision tree model nugget settings
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Calculate confidences. Select to include confidences in scoring operations. When scoring models
in the database, excluding confidences allows you to generate more efficient SQL. For regression
trees, confidences are not assigned.

Note: If you select the Create a model for very large datasets option on the Build Options tab
- Method panel for CHAID models, this checkbox is available only in the model nuggets for
categorical targets of nominal or flag.
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Calculate raw propensity scores. For models with a flag target (which return a yes or no
prediction), you can request propensity scores that indicate the likelihood of the true outcome
specified for the target field. These are in addition to other prediction and confidence values that
may be generated during scoring.

Note: If you select the Create a model for very large datasets option on the Build Options tab
- Method panel for CHAID models, this checkbox is available only in model nuggets with
a categorical target of flag.

Calculate adjusted propensity scores. Raw propensity scores are based only on the training data
and may be overly optimistic due to the tendency of many models to overfit this data. Adjusted
propensities attempt to compensate by evaluating model performance against a test or validation
partition. This option requires that a partition field be defined in the stream and adjusted propensity
scores be enabled in the modeling node before generating the model.

Note: Adjusted propensity scores are not available for boosted tree and rule set models. For more
information, see the topic Boosted C5.0 Models on p. [171].

Rule identifier. For CHAID, QUEST, and C&R Tree models, this option adds a field in the scoring
output that indicates the ID for the terminal node to which each record is assigned.

Note: When this option is selected, SQL generation is not available.

Generate SQL for this model. When using data from a database, SQL code can be pushed back to
the database for execution, providing superior performance for many operations.

Select one of the following options to specify how SQL generation is performed.

m Default: Score using Server Scoring Adapter (if installed) otherwise in process. If connected to a
database with a scoring adapter installed, generates SQL using the scoring adapter, otherwise
generates SQL natively inside SPSS Modeler.

m  Generate with no missing value support. Select to enable SQL generation without the overhead
of handling missing values. This option simply sets the prediction to null ($null$) when a
missing value is encountered while scoring a case.

Note: This option is not available for CHAID models. For other model types, it is only
available for decision trees (not rule sets).

m  Generate with missing value support. For CHAID, QUEST, and C&R Tree models, you can
enable SQL generation with full missing value support. This means that SQL is generated
so that missing values are handled as specified in the model. For example, C&R Trees use
surrogate rules and biggest child fallback.

Note: For C5.0 models, this option is only available for rule sets (not decision trees).

Boosted C5.0 Models

Note: This feature is available in SPSS Modeler Professional and SPSS Modeler Premium.
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Figure 6-41
Boosted C5.0 model nugget, Model tab

[] C5.0 Tree Boosted

'.;4 File ) Generate esfgiew

e 4

Model  wiewer  Summary  Seftings | Annotations

o d2dsdefs s ) ot K
E-Rule 1 - estimated accuracy 95 5% [hoost 99.5%]
B- K ==0.055 [Mode: drugy ]

- k== 0037 [Mode: drugy ] = drugy
i B K=0.037 [Made: drug¥]
E- K= 0.055 [Mode: drugs]

E- BF = HIGH [Mode: drugé ]

B BP = LOW [ Mode: drugC ]

i Cholesterol = NORMAL [Mode: drugi] = drugX
: ‘. Cholesterol = HIGH [Mode: drugC] = drugC
- BP = NORMAL [Mode: drug] = drugX
G- Rule 2 - estimated accuracy 87 83% [hoost 99.5%]
E-Rule 3 - estimated accuracy 84.129% [hoost 99.5%]
E-Rule 4 - estimated accuracy 82 657% [hoost 99.5%]
E-Rule 5 - estimated accuracy 85.16% [hoost 99.5%]
[ Rule & - estimated sccuracy 84.02% [hoost 99.5%]
B
B
E
B

H-Rule 7 - estimated accuracy 53.84% [boost 99.5%]
H-Rule 8 - estimated accuracy 50.39% [hoost 99.5%]
H-Fule 9 - estimated accuracy 75.04% [boost 99.5%]
H-Fule 10 - estimated sccuracy 50.48% [boost 99.5%)]

When you create a boosted C5.0 model (either a rule set or a decision tree), you actually create a
set of related models. The model rule browser for a boosted C5.0 model shows the list of models
at the top level of the hierarchy, along with the estimated accuracy of each model and the overall
accuracy of the ensemble of boosted models. To examine the rules or splits for a particular model,
select that model and expand it as you would a rule or branch in a single model.

You can also extract a particular model from the set of boosted models and create a new Rule
Set model nugget containing just that model. To create a new rule set from a boosted C5.0 model,
select the rule set or tree of interest and choose either Single Decision Tree (GM Palette) or Single
Decision Tree (Canvas) from the Generate menu.

Generating Graphs

The Tree nodes provide a lot of information; however, it may not always be in an easily accessible
format for business users. To provide the data in a way that can be easily incorporated into
business reports, presentations, and so on, you can produce graphs of selected data. For example,
from either the Model or the Viewer tabs of a model nugget, or from the Viewer tab of an
interactive tree, you can generate a graph for a selected part of the tree, thereby only creating a
graph for the cases in the selected tree or branch node.
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Note: You can only generate a graph from a nugget when it is attached to other nodes in a stream.

Generate a graph

The first step is to select the information to be shown on the graph:

B On the Model tab of a nugget, expand the list of conditions and rules in the left pane and
select the one in which you are interested.

B On the Viewer tab of a nugget, expand the list of branches and select the node in which

you are interested.

B On the Viewer tab of an interactive tree, expand the list of branches and select the node in
which you are interested.

Note: You cannot select the top node on either Viewer tab.

The way in which you create a graph is the same, regardless of how you select the data to be shown:

From the Generate menu, select Graph (from selection); alternatively, on the Viewer tab, click the
Graph (from selection) button in the bottom left corner. The Graphboard Basic tab is displayed.

Figure 6-42

Graphboard node dialog box, Basic tab
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Note: Only the Basic and Detailed tabs are available when you display the Graphboard in this way.
» Using either the Basic or Detailed tab settings, specify the details to be displayed on the graph.

» Click OK to generate the graph.

Figure 6-43
Histogram generated from Graphboard Basic tab

Graphboard of [CHILDS] from C&R Tree CF #1
dﬁiew

M=%
@)>)

\gd File |5 Edt &) Generate

Graph || snnotations

Pa Il

AGE <= "10.5"

count

T
g Eight or more

# Children

The graph heading identifies the nodes or rules that were chosen for inclusion.

Model Nuggets for Boosting, Bagging and Very Large Datasets

If you select Enhance model accuracy (boosting), Enhance model stability (bagging), or Create a
model for very large datasets as the main objective on the modeling node, IBM® SPSS® Modeler
builds an ensemble of multiple models. For more information, see the topic Models for Ensembles
in Chapter 3 on p. [53.

The resulting model nugget contains the following tabs. The Model tab provides a number of
different views of the model.

Tab View

Description

Further Information

Model Model Summary

Displays a summary of the
ensemble quality and (except
for boosted models and
continuous targets) diversity,
a measure of how much the
predictions vary across the
different models.

For more information, see

the topic Model Summary fn
Chapter 3 on p. B3|




175

Decision Trees

Tab View Description Further Information

Predictor Importance Displays a chart indicating For more information,
the relative importance of see the topic [Predictor]

each predictor (input field) in | Importance in Chapter 3 on

estimating the model. p. 6

Predictor Frequency Displays a chart showing For more information,
the relative frequency with see the topic Predictor]
which each predictor is used |[Frequency in Chapter 3 on

in the set of models. p. 7.

Component Model Plots a chart of the predictive

Accuracy accuracy of each of the
different models in the
ensemble.

Component Model Displays information on each | For more information, see

Details of the different models in the | the topic Component Model
ensemble. Details in Chapter 3 on p.

60.

Information Displays information about | For more information, see
the fields, build settings, and | the topic Model Nugget
model estimation process. Summary / Information| in

Chapter 3 on p. 50.

Settings Enables you to include For more information, see
confidences in scoring the topic Decision Tree/Rulg]
operations. Set Model Nugget Settingg

on p. 170.
Annotation Enables you to add

descriptive annotations,
specify a custom name, add
tooltip text and specify search
keywords for the model.

Rule Set Model Nuggets

A Rule Set model nugget represents the rules for predicting a particular output field discovered
by the association rule modeling node (Apriori) or by one of the tree-building nodes (C&R
Tree, CHAID, QUEST, or C5.0). For association rules, the rule set must be generated from an
unrefined Rule nugget . For trees, a rule set can be generated from the tree builder, from a C5.0
model-building node, or from any tree model nugget. Unlike unrefined Rule nuggets, Rule Set
nuggets can be placed in streams to generate predictions.

When you run a stream containing a Rule Set nugget, two new fields are added to the stream
containing the predicted value and the confidence for each record to the data. The new field names
are derived from the model name by adding prefixes. For association rule sets, the prefixes are $A-
for the prediction field and $AC- for the confidence field. For C5.0 rule sets, the prefixes are $C-
for the prediction field and $CC- for the confidence field. For C&R Tree rule sets, the prefixes are
3R- for the prediction field and $RC- for the confidence field. In a stream with multiple Rule Set
nuggets in a series predicting the same output field(s), the new field names will include numbers in
the prefix to distinguish them from each other. The first association Rule Set nugget in the stream
will use the usual names, the second node will use names starting with $A7- and $ACI-, the third
node will use names starting with $A2- and $AC2-, and so on.
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How rules are applied. Rule sets generated from association rules are unlike other model nuggets
because for any particular record, more than one prediction can be generated, and those predictions
may not all agree. There are two methods for generating predictions from rule sets.

Note: Rule sets generated from decision trees return the same results regardless of which method
is used, since the rules derived from a decision tree are mutually exclusive.

Voting. This method attempts to combine the predictions of all of the rules that apply to the
record. For each record, all rules are examined and each rule that applies to the record is used
to generate a prediction and an associated confidence. The sum of confidence figures for each
output value is computed, and the value with the greatest confidence sum is chosen as the final
prediction. The confidence for the final prediction is the confidence sum for that value divided
by the number of rules that fired for that record.

First hit. This method simply tests the rules in order, and the first rule that applies to the record
is the one used to generate the prediction.

The method used can be controlled in the stream options.

Generating nodes. The Generate menu allows you to create new nodes based on the rule set.

Filter Node. Creates a new Filter node to filter fields that are not used by rules in the rule set.

Select Node. Creates a new Select node to select records to which the selected rule applies.
The generated node will select records for which all antecedents of the rule are true. This
option requires a rule to be selected.

Rule Trace Node. Creates a new SuperNode that will compute a field indicating which rule
was used to make the prediction for each record. When a rule set is evaluated using the first
hit method, this is simply a symbol indicating the first rule that would fire. When the rule
set is evaluated using the voting method, this is a more complex string showing the input
to the voting mechanism.

Single Decision Tree (Canvas)/Single Decision Tree (GM Palette). Creates a new single Rule Set
nugget derived from the currently selected rule. Available only for boosted C5.0 models. For
more information, see the topic [Boosted C5.0 Models on p. [I71].

Model to Palette. Returns the model to the models palette. This is useful in situations where a
colleague may have sent you a stream containing the model and not the model itself.

Note: The Settings and Summary tabs in the Rule Set nugget are identical to those for decision
tree models.

Rule Set Model Tab

The Model tab for a Rule Set nugget displays a list of rules extracted from the data by the
algorithm.
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Figure 6-44
Rule Set model nugget, Model tab
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Rules are broken down by consequent (predicted category) and are presented in the following
format:

if antecedent 1
and antecedent 2

and antecedent_n
then predicted value

where consequent and antecedent_1 through antecedent_n are all conditions. The rule is
interpreted as “for records where antecedent_1 through antecedent_n are all true, consequent
is also likely to be true.” If you click the Show Instances/Confidence button on the toolbar, each
rule will also show information on the number of records to which the rule applies—that is, for
which the antecedents are true (Instances) and the proportion of those records for which the entire
rule is true (Confidence).

Note that confidence is calculated somewhat differently for C5.0 rule sets. C5.0 uses the
following formula for calculating the confidence of a rule:

(1 + number of records where rule is correct) / (2 + number of records for which the rule's antecedents are true)

This calculation of the confidence estimate adjusts for the process of generalizing rules from a
decision tree (which is what C5.0 does when it creates a rule set).
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Importing Projects from AnswerTree 3.0

IBM® SPSS® Modeler can import projects saved in AnswerTree 3.0 or 3.1 using the standard
File > Open dialog box, as follows:

» From the SPSS Modeler menus choose:
File > Open Stream

» From the Files of Type drop-down list, select AT Project Files (*.atp, *.ats).

Each imported project is converted into an SPSS Modeler stream with the following nodes:

One source node that defines the data source used (for example, an IBM® SPSS® Statistics
data file or database source).

For each tree in the project (there can be several), one Type node is created that defines
properties for each field (variable), including type, role (input or predictor field versus output
or predicted field), missing values, and other options.

For each tree in the project, a Partition node is created that partitions the data for a training or
test sample, and a tree-building node is created that defines parameters for generating the tree
(either a C&R Tree, QUEST, or CHAID node).

» To view the generated tree(s), run the stream.

Comments

Decision trees generated in SPSS Modeler cannot be exported to AnswerTree; the import from
AnswerTree to SPSS Modeler is a one-way trip.

Profits defined in AnswerTree are not preserved when the project is imported into SPSS
Modeler.
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Bayesian Network Node

The Bayesian Network node enables you to build a probability model by combining observed
and recorded evidence with “common-sense” real-world knowledge to establish the likelihood of
occurrences by using seemingly unlinked attributes. The node focuses on Tree Augmented Naive
Bayes (TAN) and Markov Blanket networks that are primarily used for classification.

Bayesian networks are used for making predictions in many varied situations; some examples are:
m  Selecting loan opportunities with low default risk.

m  Estimating when equipment will need service, parts, or replacement, based on sensor input
and existing records.

Resolving customer problems via online troubleshooting tools.
Diagnosing and troubleshooting cellular telephone networks in real-time.

Assessing the potential risks and rewards of research-and-development projects in order to
focus resources on the best opportunities.

A Bayesian network is a graphical model that displays variables (often referred to as nodes) in a
dataset and the probabilistic, or conditional, independencies between them. Causal relationships
between nodes may be represented by a Bayesian network; however, the links in the network
(also known as arcs) do not necessarily represent direct cause and effect. For example, a
Bayesian network can be used to calculate the probability of a patient having a specific disease,
given the presence or absence of certain symptoms and other relevant data, if the probabilistic
independencies between symptoms and disease as displayed on the graph hold true. Networks are
very robust where information is missing and make the best possible prediction using whatever
information is present.

A common, basic, example of a Bayesian network was created by Lauritzen and Spiegelhalter
(1988). It is often referred to as the “Asia” model and is a simplified version of a network that
may be used to diagnose a doctor’s new patients; the direction of the links roughly corresponding
to causality. Each node represents a facet that may relate to the patient’s condition; for example,
“Smoking” indicates that they are a confirmed smoker, and “VisitAsia” shows if they recently
visited Asia. Probability relationships are shown by the links between any nodes; for example,
smoking increases the chances of the patient developing both bronchitis and lung cancer, whereas
age only seems to be associated with the possibility of developing lung cancer. In the same way,
abnormalities on an x-ray of the lungs may be caused by either tuberculosis or lung cancer, while
the chances of a patient suffering from of shortness of breath (dyspnea) are increased if they also
suffer from either bronchitis or lung cancer.

© Copyright IBM Corporation 1994, 2012. 179
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Figure 7-1
Lauritzen and Spegelhalter’s Asia network example
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There are several reasons why you might decide to use a Bayesian network:

m [t helps you learn about causal relationships. From this, it enables you to understand a problem
area and to predict the consequences of any intervention.

m  The network provides an efficient approach for avoiding the overfitting of data.

A clear visualization of the relationships involved is easily observed.

Requirements. Target fields must be categorical and can have a measurement level of Nominal,
Ordinal, or Flag. Inputs can be fields of any type. Continuous (numeric range) input fields will
be automatically binned; however, if the distribution is skewed, you may obtain better results
by manually binning the fields using a Binning node before the Bayesian Network node. For
example, use Optimal Binning where the Supervisor field is the same as the Bayesian Network
node Target field.

Example. An analyst for a bank wants to be able to predict customers, or potential customers,
who are likely to default on their loan repayments. You can use a Bayesian network model to
identify the characteristics of customers most likely to default, and build several different types of
model to establish which is the best at predicting potential defaulters.

Example. A telecommunications operator wants to reduce the number of customers who leave
the business (known as “churn”), and update the model on a monthly basis using each preceding
month’s data. You can use a Bayesian network model to identify the characteristics of customers
most likely to churn, and continue training the model each month with the new data.
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Bayesian Network Node Model Options

Figure 7-2
Bayesian Network node: Model tab

[] Markov

&

Figldz Model  Expert  Analyze  Annotations

Model name: O suto @}Custom |Markov

i_o_ﬂ Use partitioned data

i_-_ﬂ Build model for each spilit

To select figlds manually, choose "Use custom settings" on the Fields tab

[ Cortinue training existing madel

Structure type: © 1AM @ Warkov Blanket

Ei Inchude festure selection preprocessing step

Parameter learning method:

@) Msimum likelihood © Eayes adustment for small cell counts

[ Ok ][b Run][Cancel]

Model name. You can generate the model name automatically based on the target or ID field (or
model type in cases where no such field is specified) or specify a custom name.

Use partitioned data. If a partition field is defined, this option ensures that data from only the
training partition is used to build the model.

Build model for each split. Builds a separate model for each possible value of input fields that are
specified as split fields. For more information, see the topic Building Split Models|in Chapter 3

on p. B0.

Partition. This field allows you to specify a field used to partition the data into separate samples for
the training, testing, and validation stages of model building. By using one sample to generate
the model and a different sample to test it, you can get a good indication of how well the model
will generalize to larger datasets that are similar to the current data. If multiple partition fields
have been defined by using Type or Partition nodes, a single partition field must be selected on
the Fields tab in each modeling node that uses partitioning. (If only one partition is present, it

is automatically used whenever partitioning is enabled.) Also note that to apply the selected
partition in your analysis, partitioning must also be enabled in the Model Options tab for the node.
(Deselecting this option makes it possible to disable partitioning without changing field settings.)
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Splits. For split models, select the split field or fields. This is similar to setting the field role to
Split in a Type node. You can designate only fields with a measurement level of Flag, Nominal,
Ordinal or Continuous as split fields. Fields chosen as split fields cannot be used as target, input,
partition, frequency or weight fields. For more information, see the topic Building Split Models in
Chapter 3 on p. B0.

Continue training existing model. If you select this option, the results shown on the model nugget
Model tab are regenerated and updated each time the model is run. For example, you would do
this when you have added a new or updated data source to an existing model.

Note: This can only update the existing network; it cannot add or remove nodes or connections.
Each time you retrain the model the network will be the same shape, only the conditional
probabilities and predictor importance will change. If your new data are broadly similar to your
old data then this does not matter since you expect the same things to be significant; however, if
you want to check or update what is significant (as opposed to how significant it is), you will need
to build a new model, that is, build a new network

Structure type. Select the structure to be used when building the Bayesian network:

®  TAN. The Tree Augmented Naive Bayes model (TAN) creates a simple Bayesian network
model that is an improvement over the standard Naive Bayes model. This is because it allows
each predictor to depend on another predictor in addition to the target variable, thereby
increasing the classification accuracy.

m  Markov Blanket. This selects the set of nodes in the dataset that contain the target variable’s
parents, its children, and its children’s parents. Essentially, a Markov blanket identifies all
the variables in the network that are needed to predict the target variable. This method of
building a network is considered to be more accurate; however, with large datasets there
maybe a processing time-penalty due to the high number of variables involved. To reduce the
amount of processing, you can use the Feature Selection options on the Expert tab to select the
variables that are significantly related to the target variable.

Include feature selection preprocessing step. Selecting this box enables you to use the Feature
Selection options on the Expert tab.

Parameter learning method. Bayesian network parameters refer to the conditional probabilities for
each node given the values of its parents. There are two possible selections that you can use to
control the task of estimating the conditional probability tables between nodes where the values
of the parents are known:

®  Maximum likelihood. Select this box when using a large dataset. This is the default selection.

m  Bayes adjustment for small cell counts. For smaller datasets there is a danger of overfitting
the model, as well as the possibility of a high number of zero-counts. Select this option
to alleviate these problems by applying smoothing to reduce the effect of any zero-counts
and any unreliable estimate effects.
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Bayesian Network Node Expert Options

Figure 7-3
Bayesian Network node: Expert tab
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The node expert options enable you to fine-tune the model-building process. To access the expert
options, set Mode to Expert on the Expert tab.

Missing values. By default, IBM® SPSS® Modeler only uses records that have valid values for all
fields used in the model. (This is sometimes called listwise deletion of missing values.) If you
have a lot of missing data, you may find that this approach eliminates too many records, leaving
you without enough data to generate a good model. In such cases, you can deselect the Use only
complete records option. SPSS Modeler then attempts to use as much information as possible to
estimate the model, including records where some of the fields have missing values. (This is
sometimes called pairwise deletion of missing values.) However, in some situations, using
incomplete records in this manner can lead to computational problems in estimating the model.

Append all probabilities. Specifies whether probabilities for each category of the output field are
added to each record processed by the node. If this option is not selected, the probability of
only the predicted category is added.
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Independence test. A test of independence assesses whether paired observations on two variables
are independent of each other. Select the type of test to be used, available options are:

m Likelihood ratio. Tests for target-predictor independence by calculating a ratio between the
maximum probability of a result under two different hypotheses.

m  Pearson chi-square. Tests for target-predictor independence by using a null hypothesis that the
relative frequencies of occurrence of observed events follow a specified frequency distribution.

Bayesian network models conduct conditional tests of independence where additional variables
are used beyond the tested pairs. In addition, the models explore not only the relations between
the target and predictors, but also the relations among the predictors themselves

Note: The Independence test options are only available if you select either Include feature
selection preprocessing step or a Structure type of Markov Blanket on the Model tab.

Significance level. Used in conjunction with the Independence test settings, this enables you to
set a cut-off value to be used when conducting the tests. The lower the value, the fewer links
remains in the network; the default level is 0.01.

Note: This option is only available if you select either Include feature selection preprocessing
step or a Structure type of Markov Blanket on the Model tab.

Maximal conditioning set size. The algorithm for creating a Markov Blanket structure uses
conditioning sets of increasing size to carry out independence testing and remove unnecessary
links from the network. Because tests involving a high number of conditioning variables require
more time and memory for processing you can limit the number of variables to be included. This
can be especially useful when processing data with strong dependencies among many variables.
Note however that the resulting network may contain some superfluous links.

Specify the maximal number of conditioning variables to be used for independence testing. The
default setting is 5.

Note: This option is only available if you select either Include feature selection preprocessing
step or a Structure type of Markov Blanket on the Model tab.

Feature selection. These options enable you to restrict the number of inputs used when processing
the model in order to speed up the model building process. This is especially useful when creating
a Markov Blanket structure due to the possible large number of potential inputs; it enables you to
select the inputs that are significantly related to the target variable.

Note: The feature selection options are only available if you select Include feature selection
preprocessing step on the Model tab.

m Inputs always selected Using the Field Chooser (button to the right of the text field), select the
fields from the dataset that are always to be used when building the Bayesian network model.
Note that the target field is always selected.

®  Maximum number of inputs. Specify the total number of inputs from the dataset to be used
when building the Bayesian network model. The highest number you can enter is the total
number of inputs in the dataset.

Note: If the number of fields selected in Inputs always selected exceeds the value of Maximum
number of inputs, an error message is displayed.
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Bayesian Network Model Nuggets

Figure 7-4
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Note: If you selected Continue training existing parameters on the modeling node Model tab, the
information shown on the model nugget Model tab is updated each time you regenerate the model.

The model nugget Model tab is split into two panels:

Left Panel

Basic. This view contains a network graph of nodes that displays the relationship between the
target and its most important predictors, as well as the relationship between the predictors.
The importance of each predictor is shown by the density of its color; a strong color shows an
important predictor, and vice versa.

The bin values for nodes representing a range are displayed in a popup ToolTip when you
hover the mouse pointer over the node.

You can use IBM® SPSS® Modeler’s graph tools to interact, edit, and save the graph. For
example, for use in other applications such as MS Word.

Tip: If the network contains a lot of nodes, you can click on a node and drag it to make the
graph more legible.

Distribution. This view displays the conditional probabilities for each node in the network as a
mini graph. Hover the mouse pointer over a graph to display its values in a popup ToolTip.



186

Chapter 7

Right Panel

Predictor Importance. This displays a chart that indicates the relative importance of each predictor
in estimating the model. For more information, see the topic [Predictor Importance] in Chapter 3
on p. BI.

Conditional Probabilities. When you select a node or mini distribution graph in the left panel the
associated conditional probabilities table is displayed in the right panel. This table contains the
conditional probability value for each node value and each combination of values in its parent
nodes. In addition, it includes the number of records observed for each record value and each
combination of values in the parent nodes.

Bayesian Network Model Settings

The Settings tab for a Bayesian Network model nugget specifies options for modifying the built
model. For example, you may use the Bayesian Network node to build several different models
using the same data and settings, then use this tab in each model to slightly modify the settings
to see how that affects the results.

Note: This tab is only available after the model nugget has been added to a stream.

Figure 7-5
Settings tab for a Bayesian Network model
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Calculate raw propensity scores. For models with a flag target (which return a yes or no
prediction), you can request propensity scores that indicate the likelihood of the true outcome
specified for the target field. These are in addition to other prediction and confidence values that
may be generated during scoring.

Calculate adjusted propensity scores. Raw propensity scores are based only on the training data
and may be overly optimistic due to the tendency of many models to overfit this data. Adjusted
propensities attempt to compensate by evaluating model performance against a test or validation
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partition. This option requires that a partition field be defined in the stream and adjusted propensity
scores be enabled in the modeling node before generating the model.

Append all probabilities. Specifies whether probabilities for each category of the output field are
added to each record processed by the node. If this option is not selected, the probability of
only the predicted category is added.

The default setting of this check box is determined by the corresponding check box on the
Expert tab of the modeling node. For more information, see the topic Bayesian Network Node|

Expert Options on p. [I83.

Bayesian Network Model Summary

Figure 7-6
Summary tab for a Bayesian Network model
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The Summary tab of a model nugget displays information about the model itself (Analysis), fields
used in the model (Fields), settings used when building the model (Build Settings), and model
training (Training Summary).

When you first browse the node, the Summary tab results are collapsed. To see the results of
interest, use the expander control to the left of an item to unfold it or click the Expand All button
to show all results. To hide the results when you have finished viewing them, use the expander
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control to collapse the specific results that you want to hide or click the Collapse All button
to collapse all results.

Analysis. Displays information about the specific model.
Fields. Lists the fields used as the target and the inputs in building the model.
Build Settings. Contains information about the settings used in building the model.

Training Summary. Shows the type of model, the stream used to create it, the user who created it,
when it was built, and the elapsed time for building the model.
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A neural network can approximate a wide range of predictive models with minimal demands on
model structure and assumption. The form of the relationships is determined during the learning
process. If a linear relationship between the target and predictors is appropriate, the results of
the neural network should closely approximate those of a traditional linear model. If a nonlinear

relationship is more appropriate, the neural network will automatically approximate the “correct”
model structure.

The trade-off for this flexibility is that the neural network is not easily interpretable. If you are
trying to explain an underlying process that produces the relationships between the target and
predictors, it would be better to use a more traditional statistical model. However, if model
interpretability is not important, you can obtain good predictions using a neural network.

Figure 8-1
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Field requirements. There must be at least one Target and one Input. Fields set to Both or None are
ignored. There are no measurement level restrictions on targets or predictors (inputs). For more
information, see the topic Modeling Node Fields Options in Chapter 3 on p. 35|

The Neural Networks Model

Neural networks are simple models of the way the nervous system operates. The basic units are
neurons, which are typically organized into layers, as shown in the following figure.

© Copyright IBM Corporation 1994, 2012. 189
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Figure 8-2
Structure of a neural network
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A neural network is a simplified model of the way the human brain processes information. It
works by simulating a large number of interconnected processing units that resemble abstract
versions of neurons.

The processing units are arranged in layers. There are typically three parts in a neural network:
an input layer, with units representing the input fields; one or more hidden layers; and an output
layer, with a unit or units representing the target field(s). The units are connected with varying
connection strengths (or weights). Input data are presented to the first layer, and values are
propagated from each neuron to every neuron in the next layer. Eventually, a result is delivered
from the output layer.

The network learns by examining individual records, generating a prediction for each record,
and making adjustments to the weights whenever it makes an incorrect prediction. This process is
repeated many times, and the network continues to improve its predictions until one or more of
the stopping criteria have been met.

Initially, all weights are random, and the answers that come out of the net are probably
nonsensical. The network learns through training. Examples for which the output is known
are repeatedly presented to the network, and the answers it gives are compared to the known
outcomes. Information from this comparison is passed back through the network, gradually
changing the weights. As training progresses, the network becomes increasingly accurate in
replicating the known outcomes. Once trained, the network can be applied to future cases where
the outcome is unknown.

Using Neural Networks with Legacy Streams

Version 14 of IBM® SPSS® Modeler introduced a new Neural Net node, supporting boosting and
bagging techniques and optimization for very large datasets. Existing streams containing the old
node will still build and score models in this release. However, this support will be removed in a
future release, so we recommend using the new version from now on.

From version 13 onwards, fields with unknown values (that is, values not present in the training
data) are no longer automatically treated as missing values, and are scored with the value $null$.
Thus if you want to score fields with unknown values as non-null using an older (pre-13) Neural
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Net model in version 13 or later, you should mark unknown values as missing values (for example,
by means of the Type node).

Note that, for compatibility, any legacy streams that still contain the old node may still be using
the Limit set size option from Tools > Stream Properties > Options; this option only applies to
Kohonen nets and K-Means nodes from version 14 onwards.

Objectives

Figure 8-3
Objectives settings

Figidz | Build Options | pocel Options | Annotations
Select an item:

Chjectives What do you want to do?

Basics ® Builed ney model

Stopping Fules
PRing @ Continue training existing maodel

Ensembles

i A TR
Advanced wWhat is your main objectives

@ creste a standard model
©) Enhance model accuracy (hoosting)
@) Enhance maodel stahility (hagging)

@ Cptimize for very large datasets (requires Server)

Description

Creates a single, standard model to explain relationships between fields.
Standard models are easier to interpret and can be faster to score than
hoosted, bagged, or large dataset ensembles. A standard model is always
used for multiple targets.

What do you want to do?
®  Build a new model. Build a completely new model. This is the usual operation of the node.

m  Continue training an existing model. Training continues with the last model successfully
produced by the node. This makes it possible to update or refresh an existing model without
having to access the original data and may result in significantly faster performance since only
the new or updated records are fed into the stream. Details on the previous model are stored
with the modeling node, making it possible to use this option even if the previous model
nugget is no longer available in the stream or Models palette.

Note: When this option is enabled, all other controls on the Fields and Build Options tabs are
disabled.

What is your main objective?
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Create a standard model. The method builds a single model to predict the target using the
predictors. Generally speaking, standard models are easier to interpret and can be faster to
score than boosted, bagged, or large dataset ensembles.

Enhance model accuracy (boosting). The method builds an ensemble model using boosting,
which generates a sequence of models to obtain more accurate predictions. Ensembles can
take longer to build and to score than a standard model.

Boosting produces a succession of “component models”, each of which is built on the entire
dataset. Prior to building each successive component model, the records are weighted based
on the previous component model’s residuals. Cases with large residuals are given relatively
higher analysis weights so that the next component model will focus on predicting these
records well. Together these component models form an ensemble model. The ensemble
model scores new records using a combining rule; the available rules depend upon the
measurement level of the target.

Enhance model stability (bagging). The method builds an ensemble model using bagging
(bootstrap aggregating), which generates multiple models to obtain more reliable predictions.
Ensembles can take longer to build and to score than a standard model.

Bootstrap aggregation (bagging) produces replicates of the training dataset by sampling

with replacement from the original dataset. This creates bootstrap samples of equal size to
the original dataset. Then a “component model” is built on each replicate. Together these
component models form an ensemble model. The ensemble model scores new records using a
combining rule; the available rules depend upon the measurement level of the target.

Create a model for very large datasets (requires IBM® SPSS® Modeler Server). The method
builds an ensemble model by splitting the dataset into separate data blocks. Choose this
option if your dataset is too large to build any of the models above, or for incremental model
building. This option can take less time to build, but can take longer to score than a standard
model. This option requires SPSS Modeler Server connectivity.

When there are multiple targets, this method will only create a standard model, regardless of
the selected objective.
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Basics

Figure 8-4
Basics settings

Figldz | Build Options || Model Options || Annctations

Select an item:

Ohjectives
Basics Meural netveork model; |Multilayer Perceptron (MLP) b o
Hidden Layers
Stopping Rules
@ Automaticaly compute number of units
Enzembles

Advanced ©) Customize number of units

AF 4B

Neural network model. The type of model determines how the network connects the predictors
to the targets through the hidden layer(s). The multilayer perceptron (MLP) allows for more
complex relationships at the possible cost of increasing the training and scoring time. The radial
basis function (RBF) may have lower training and scoring times, at the possible cost of reduced
predictive power compared to the MLP.

Hidden Layers. The hidden layer(s) of a neural network contains unobservable units. The value of
each hidden unit is some function of the predictors; the exact form of the function depends in part
upon the network type. A multilayer perceptron can have one or two hidden layers; a radial basis
function network can have one hidden layer.

m  Automatically compute number of units. This option builds a network with one hidden layer
and computes the “best” number of units in the hidden layer.

m  Customize number of units. This option allows you to specify the number of units in each
hidden layer. The first hidden layer must have at least one unit. Specifying 0 units for the
second hidden layer builds a multilayer perceptron with a single hidden layer.

Note: You should choose values so that the number of nodes does not exceed the number of
continuous predictors plus the total number of categories across all categorical (flag, nominal,
and ordinal) predictors.
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Stopping Rules

Figure 8-5
Stopping Rules settings

Figlds | Build Options || Model Options || Annctations

Select an tem:

Ohjectives
-~ 2 Y
Basics l Stopping rules are available for the Muttilayer Perceptron mocdel
and apply to training the standard maodel (or component maodels if
Stopping Rules ensembles are in effect). Cther stopping rules apply.
Ensemblas -." Use maximum training time (per component model)

; . =]
Advanced bilfiEss ﬂ

|| Customize number of maximum training cycles

i
-

|| Use minimum accuracy

i

These are the rules that determine when to stop training multilayer perceptron networks; these
settings are ignored when the radial basis function algorithm is used. Training proceeds through at
least one cycle (data pass), and can then be stopped according to the following criteria.

Use maximum training time (per component model). Choose whether to specify a maximum number
of minutes for the algorithm to run. Specify a number greater than 0. When an ensemble model
is built, this is the training time allowed for each component model of the ensemble. Note that
training may go a bit beyond the specified time limit in order to complete the current cycle.

Customize number of maximum training cycles. The maximum number of training cycles allowed. If
the maximum number of cycles is exceeded, then training stops. Specify an integer greater than 0.

Use minimum accuracy. With this option, training will continue until the specified accuracy is
attained. This may never happen, but you can interrupt training at any point and save the net with
the best accuracy achieved so far.

The training algorithm will also stop if the error in the overfit prevention set does not decrease
after each cycle, if the relative change in the training error is small, or if the ratio of the current
training error is small compared to the initial error.
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Ensembles

Figure 8-6
Ensembles settings

Figldz | Buid Options | Model Optionz | Annotations

Select an item:

Chjectives - : : : :
I Theze settings determine the behavior of ensembling that occurs
Basics = when boosting, bagaing, or very large datasets are requested in
Ohjectives.
Stopping Rules Options that do not spply are ignored.
Enzembles

Bagaing and Yery Large Datazets
Achranced

Default combining rule for categorical taraets: | wating b

Detault combining rule for continuous targets: |mean b

Eoosting and Bagging

Mumber of component models for boosting andior bagging: E

These settings determine the behavior of ensembling that occurs when boosting, bagging, or very
large datasets are requested in Objectives. Options that do not apply to the selected objective
are ignored.

Bagging and Very Large Datasets. When scoring an ensemble, this is the rule used to combine the
predicted values from the base models to compute the ensemble score value.

m  Default combining rule for categorical targets. Ensemble predicted values for categorical targets
can be combined using voting, highest probability, or highest mean probability. Voting selects
the category that has the highest probability most often across the base models. Highest
probability selects the category that achieves the single highest probability across all base
models. Highest mean probability selects the category with the highest value when the
category probabilities are averaged across base models.

m  Default combining rule for continuous targets. Ensemble predicted values for continuous targets
can be combined using the mean or median of the predicted values from the base models.

Note that when the objective is to enhance model accuracy, the combining rule selections are
ignored. Boosting always uses a weighted majority vote to score categorical targets and a
weighted median to score continuous targets.

Boosting and Bagging. Specify the number of base models to build when the objective is to
enhance model accuracy or stability; for bagging, this is the number of bootstrap samples. It
should be a positive integer.
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Advanced

Figure 8-7
Advanced settings

Figlodz | Build Option= | pocel Options | Annotations

Select an item:

Ohjectives
-
Basics " " Meural Netwark modeling internally separstes records into a madel
building set and an overfit prevention set. Specify a percentage of
Stopping Fules records for the overfit prevention set.
Enzembles Overfit prevention set (%) ﬂ
Achranced

[+ Replicate Results

Fandom seed: |229176228

Missing values in predictors:

@ Delete listwise
©) impute missing values

Advanced settings provide control over options that do not fit neatly into other groups of settings.

Overfit prevention set. The neural network method internally separates records into a model
building set and an overfit prevention set, which is an independent set of data records used to track
errors during training in order to prevent the method from modeling chance variation in the data.
Specify a percentage of records. The default is 30.

Replicate results. Setting a random seed allows you to replicate analyses. Specify an integer or
click Generate, which will create a pseudo-random integer between 1 and 2147483647, inclusive.
By default, analyses are replicated with seed 229176228.

Missing values in predictors. This specifies how to treat missing values. Delete listwise removes
records with missing values on predictors from model building. Impute missing values will
replace missing values in predictors and use those records in the analysis. Continuous fields
impute the average of the minimum and maximum observed values; categorical fields impute the
most frequently occurring category. Note that records with missing values on any other field
specified on the Fields tab are always removed from model building.
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Model Options

Figure 8-8
Model Options tab

Figlds | Build Cptions | Model Options | Annotations

Model Mame: @) Automatic © Custom
Make Available for Scoring

-
- ] . . . .

l Predicted value and confidence are always available for scoring.
—

Confidence iz bazed on;
@ The probahilty of the predicted valug
© The increase in probakility from the next mast likely value

[ Predicted probahility for categorical targets

Maximum categories to save:

[+ Propensity scores far flag targets

Model Name. You can generate the model name automatically based on the target fields or specify
a custom name. The automatically generated name is the target field name. If there are multiple
targets, then the model name is the field names in order, connected by ampersands. For example,
if fieldl field2 field3 are targets, then the model name is: fieldl & field2 & fields.

Make Available for Scoring. When the model is scored, the selected items in this group should be
produced. The predicted value (for all targets) and confidence (for categorical targets) are always
computed when the model is scored. The computed confidence can be based on the probability
of the predicted value (the highest predicted probability) or the difference between the highest
predicted probability and the second highest predicted probability.

®m  Predicted probability for categorical targets. This produces the predicted probabilities for
categorical targets. A field is created for each category.

®m  Propensity scores for flag targets. For models with a flag target (which return a yes or no
prediction), you can request propensity scores that indicate the likelihood of the true outcome
specified for the target field. The model produces raw propensity scores; if partitions are in
effect, the model also produces adjusted propensity scores based on the testing partition. For
more information, see the topic [Propensity Scores in Chapter 3 on p. @1.
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Model Summary

Figure 8-9
Neural Networks Model Summary view

Model Summary
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The Model Summary view is a snapshot, at-a-glance summary of the neural network predictive
or classification accuracy.

Model summary. The table identifies the target, the type of neural network trained, the stopping
rule that stopped training (shown if a multilayer perceptron network was trained), and the number
of neurons in each hidden layer of the network.

Neural Network Quality. The chart displays the accuracy of the final model, which is presented in
larger is better format. For a categorical target, this is simply the percentage of records for which
the predicted value matches the observed value. For a continuous target, this 1 minus the ratio
of the mean absolute error in prediction (the average of the absolute values of the predicted
values minus the observed values) to the range of predicted values (the maximum predicted
value minus the minimum predicted value).

Multiple targets. If there are multiple targets, then each target is displayed in the Target row of the
table. The accuracy displayed in the chart is the average of the individual target accuracies.
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Figure 8-10
Predictor Importance view
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Typically, you will want to focus your modeling efforts on the predictor fields that matter most
and consider dropping or ignoring those that matter least. The predictor importance chart helps
you do this by indicating the relative importance of each predictor in estimating the model. Since
the values are relative, the sum of the values for all predictors on the display is 1.0. Predictor
importance does not relate to model accuracy. It just relates to the importance of each predictor in
making a prediction, not whether or not the prediction is accurate.

Multiple targets. If there are multiple targets, then each target is displayed in a separate chart and
there is a Target dropdown list that controls which target to display.
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Predicted By Observed

Figure 8-11
Predicted By Observed view
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For continuous targets, this displays a binned scatterplot of the predicted values on the vertical
axis by the observed values on the horizontal axis.

Multiple targets. If there are multiple continuous targets, then each target is displayed in a separate
chart and there is a Target dropdown list that controls which target to display.
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Figure 8-12

Classification view, row percents style

Neural Networks
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For categorical targets, this displays the cross-classification of observed versus predicted values in
a heat map, plus the overall percent correct.

Table styles. There are several different display styles, which are accessible from the Style

dropdown list.

®  Row percents. This displays the row percentages (the cell counts expressed as a percent of the
row totals) in the cells. This is the default.

m  Cell counts. This displays the cell counts in the cells. The shading for the heat map is still
based on the row percentages.

Heat map. This displays no values in the cells, just the shading.

Compressed. This displays no row or column headings, or values in the cells. It can be useful
when the target has a lot of categories.

Missing. If any records have missing values on the target, they are displayed in a (Missing) row
under all valid rows. Records with missing values do not contribute to the overall percent correct.

Multiple targets. If there are multiple categorical targets, then each target is displayed in a separate
table and there is a Target dropdown list that controls which target to display.

Large tables. If the displayed target has more than 100 categories, no table is displayed.
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Network

Figure 8-13
Network view, inputs on the left, effects style

A

addrs N

default

2 W A Style Effects T

This displays a graphical representation of the neural network.

Chart styles. There are two different display styles, which are accessible from the Style dropdown
list.

m Effects. This displays each predictor and target as one node in the diagram irrespective of
whether the measurement scale is continuous or categorical. This is the default.

m  Coefficients. This displays multiple indicator nodes for categorical predictors and targets. The
connecting lines in the coefficients-style diagram are colored based on the estimated value of
the synaptic weight.

Diagram orientation. By default, the network diagram is arranged with the inputs on the left and the
targets on the right. Using toolbar controls, you can change the orientation so that inputs are on
top and targets on the bottom, or inputs on the bottom and targets on top.
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Predictor importance. Connecting lines in the diagram are weighted based on predictor importance,
with greater line width corresponding to greater importance. There is a Predictor Importance
slider in the toolbar that controls which predictors are shown in the network diagram. This does
not change the model, but simply allows you to focus on the most important predictors.

Multiple targets. If there are multiple targets, all targets are displayed in the chart.

Settings

Figure 8-14
Settings tab

s

Model | Settings | Annotations

’i‘ Predicted value and confidence are always available for =coring.
e

Confidence iz based on:
@ The probability of the predicted value
© e increase in probability from the next mast likely value

[T] Predicted probability for categorical targets

e
-

I__I Generate SOL for thiz model

When the model is scored, the selected items in this tab should be produced. The predicted value
(for all targets) and confidence (for categorical targets) are always computed when the model is
scored. The computed confidence can be based on the probability of the predicted value (the
highest predicted probability) or the difference between the highest predicted probability and the
second highest predicted probability.

m  Predicted probability for categorical targets. This produces the predicted probabilities for
categorical targets. A field is created for each category.

m  Propensity scores for flag targets. For models with a flag target (which return a yes or no
prediction), you can request propensity scores that indicate the likelihood of the true outcome
specified for the target field. The model produces raw propensity scores; if partitions are in
effect, the model also produces adjusted propensity scores based on the testing partition. For
more information, see the topic [Propensity Scores in Chapter 3 on p. @1.

Generate SQL for this model. When using data from a database, SQL code can be pushed back to
the database for execution, providing superior performance for many operations.

Score by converting to native SQL. If selected, generates SQL to score the model natively within
the application.
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Decision List models identify subgroups or segments that show a higher or lower likelihood of a
binary (yes or no) outcome relative to the overall sample. For example, you might look for
customers who are least likely to churn or most likely to say yes to a particular offer or campaign.
The Decision List Viewer gives you complete control over the model, allowing you to edit
segments, add your own business rules, specify how each segment is scored, and customize the
model in a number of other ways to optimize the proportion of hits across all segments. As such, it
is particularly well-suited for generating mailing lists or otherwise identifying which records to
target for a particular campaign. You can also use multiple mining tasks to combine modeling
approaches—for example, by identifying high- and low-performing segments within the same
model and including or excluding each in the scoring stage as appropriate.

Figure 9-1

Decision List model

™ [nteractive List: response[1] E]@

s cen dven e Do (B2 BE @1x)

Yiewst | Gang | Annotations

K Take Snapshot Segment Finder

Find seaments writh: High Probahility
Target field: O® response =

Max. no. of nevy segments: > [ ]
Target value: 1
] Segment Rules Score | Cowver |Cover n ‘ Freguency | Probahbility Errar _—

Al segments including Remainder 13,504 1852 14.45% 0.00%, nﬁ
[=l income, number_products
1 income = 55267.000 and 1
number_products = 1.000

a1z 795 aTAT% 2.35%

<
(= rfm_score, number_transactions
2 rim_score = 10,535 and 1
number_transactions = 3.000

725 357 48.24% 370

= aver _products, |
averagedbalancedfesddindss: = 0.000 anc
3 averagedbalancedfesddinde:x == 349.000 and 1
number_products <= 2.000 and
rim_score » 9239

738 196 26.56% 3.34%

Remainder 1,129 B04 543% 0.44%

e 6 GG@e

Model Sumimary; Cover 2,375: Freguency 1,348 Probabilty S6.76%
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Segments, Rules, and Conditions

A model consists of a list of segments, each of which is defined by a rule that selects matching
records. A given rule may have multiple conditions; for example:

RFM_SCORE > 10 and
MONTHS_CURRENT <=9

Rules are applied in the order listed, with the first matching rule determining the outcome for a
given record. Taken independently, rules or conditions may overlap, but the order of rules resolves
ambiguity. If no rule matches, the record is assigned to the remainder rule.

Complete Control over Scoring

The Decision List Viewer allows you to view, modify, and reorganize segments and to choose
which to include or exclude for purposes of scoring. For example, you can choose to exclude one
group of customers from future offers and include others and immediately see how this affects
your overall hit rate. Decision List models return a score of Yes for included segments and $null$
for everything else, including the remainder. This direct control over scoring makes Decision List
models ideal for generating mailing lists, and they are widely used in customer relationship
management, including call center or marketing applications.
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Figure 9-2
Decision List model
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Mining Tasks, Measures, and Selections

The modeling process is driven by mining tasks. Each mining task effectively initiates a new
modeling run and returns a new set of alternative models to choose from. The default task is based
on your initial specifications in the Decision List node, but you can define any number of custom
tasks. You can also apply tasks iteratively—for example, you can run a high probability search
on the entire training set and then run a low probability search on the remainder to weed out
low-performing segments.
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Figure 9-3
Creating a mining task
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Data Selections

You can define data selections and custom model measures for model building and evaluation.
For example, you can specify a data selection in a mining task to tailor the model to a specific
region and create a custom measure to evaluate how well that model performs on the whole
country. Unlike mining tasks, measures don’t change the underlying model but provide another
lens to assess how well it performs.
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Figure 9-4
Creating a data selection

Crganize Data Selections

@ Hint: Use this dialog to define and rename the Data Selections which are used as build data
for Mining Tasks and to generate Model Measures,

Mame Partttion |Cond'rtion |
@ Al Data Al Data Al Records
Al hales Al Data pender = "h"

Define a custom Data Selection by specifying a Partition and & logical Condition which will be
used to select records from the Partition.

Custom Data selections may be edited, renamed or deleted.

Adding Your Business Knowledge

By fine-tuning or extending the segments identified by the algorithm, the Decision List Viewer
allows you to incorporate your business knowledge right into the model. You can edit the
segments generated by the model or add additional segments based on rules that you specify. You
can then apply the changes and preview the results.

Figure 9-5
Specifying a rule

Edit Segment Rule

Hirt: & segment rule defines which records are placed in a segment. Define the
rule by adding or editing ane ar mare conditions.

Conditian | >€'f:l Insert

income = 55 267
number _products = 1.000 ﬁ

For further insight, a dynamic link with Excel allows you to export your data to Excel, where it
can be used to create presentation charts and to calculate custom measures, such as complex profit
and ROI, which can be viewed in the Decision List Viewer while you are building the model.

Example. The marketing department of a financial institution wants to achieve more profitable
results in future campaigns by matching the right offer to each customer. You can use a Decision
List model to identify the characteristics of customers most likely to respond favorably based on
previous promotions and to generate a mailing list based on the results.
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Requirements. A single categorical target field with a measurement level of type Flag or Nominal
that indicates the binary outcome you want to predict (yes/no), and at least one input field. When
the target field type is Nominal, you must manually choose a single value to be treated as a hit, or
response; all the other values are lumped together as not hit. An optional frequency field may
also be specified. Continuous date/time fields are ignored. Continuous numeric range inputs

are automatically binned by the algorithm as specified on the Expert tab in the modeling node.
For finer control over binning, add an upstream binning node and use the binned field as input
with a measurement level of Ordinal.

Decision List Model Options

Figure 9-6
Decision List node: Model tab
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Model name. You can generate the model name automatically based on the target or ID field (or
model type in cases where no such field is specified) or specify a custom name.

Use partitioned data. If a partition field is defined, this option ensures that data from only the
training partition is used to build the model.



210

Chapter 9

Create split models. Builds a separate model for each possible value of input fields that are specified
as split fields. For more information, see the topic [Building Split Models in Chapter 3 on p. 30|

Mode. Specifies the method used to build the model.

m  Generate model. Automatically generates a model on the models palette when the node is
executed. The resulting model can be added to streams for purposes of scoring but cannot be
further edited.

®m Launch interactive session. Opens the interactive Decision List Viewer modeling (output)
window, allowing you to pick from multiple alternatives and repeatedly apply the algorithm
with different settings to progressively grow or modify the model. For more information, see
the topic [Decision List Viewer on p. 213

m Use saved interactive session information. Launches an interactive session using previously
saved settings. Interactive settings can be saved from the Decision List Viewer using the
Generate menu (to create a model or modeling node) or the File menu (to update the node
from which the session was launched).

Target value. Specifies the value of the target field that indicates the outcome you want to model.
For example, if the target field churn is coded 0 = no and 1 = yes, specify 1 to identify rules
that indicate which records are likely to churn.

Find segments with. Indicates whether the search for the target variable should look for a High
probability or Low probability of occurrence. Finding and excluding them can be a useful way to
improve your model and can be particularly useful when the remainder has a low probability.

Maximum number of segments. Specifies the maximum number of segments to return. The top N
segments are created, where the best segment is the one with the highest probability or, if more
than one model has the same probability, the highest coverage. The minimum allowed setting
is 1; there is no maximum setting.

Minimum segment size. The two settings below dictate the minimum segment size. The larger of
the two values takes precedence. For example, if the percentage value equates to a number higher
than the absolute value, the percentage setting takes precedence.

m  As percentage of previous segment (%). Specifies the minimum group size as a percentage of
records. The minimum allowed setting is 0; the maximum allowed setting is 99.9.

®m  As absolute value (N). Specifies the minimum group size as an absolute number of records. The
minimum allowed setting is 1; there is no maximum setting.

Segment rules.

Maximum number of attributes. Specifies the maximum number of conditions per segment rule.
The minimum allowed setting is 1; there is no maximum setting.

m  Allow attribute re-use. When enabled, each cycle can consider all attributes, even those that
have been used in previous cycles. The conditions for a segment are built up in cycles, where
each cycle adds a new condition. The number of cycles is defined using the Maximum number
of attributes setting.
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Confidence interval for new conditions (%). Specifies the confidence level for testing segment
significance. This setting plays a significant role in the number of segments (if any) that are
returned as well as the number-of-conditions-per-segment rule. The higher the value, the smaller
the returned result set. The minimum allowed setting is 50; the maximum allowed setting is 99.9.

Decision List Node Expert Options

Figure 9-7
Decision List node: Expert tab
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Expert options allow you to fine-tune the model-building process.
Binning method. The method used for binning continuous fields (equal count or equal width).

Number of bins. The number of bins to create for continuous fields. The minimum allowed setting
is 2; there is no maximum setting.

Model search width. The maximum number of model results per cycle that can be used for the
next cycle. The minimum allowed setting is 1; there is no maximum setting.

Rule search width. The maximum number of rule results per cycle that can be used for the next
cycle. The minimum allowed setting is 1; there is no maximum setting.

Bin merging factor. The minimum amount by which a segment must grow when merged with its
neighbor. The minimum allowed setting is 1.01; there is no maximum setting.
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Allow missing values in conditions. True to allow the IS MISSING test in rules.

Discard intermediate results. When True, only the final results of the search process are
returned. A final result is a result that is not refined any further in the search process. When
False, intermediate results are also returned.

Maximum number of alternatives. Specifies the maximum number of alternatives that can be
returned upon running the mining task. The minimum allowed setting is 1; there is no maximum
setting.

Note that the mining task will only return the actual number of alternatives, up to the
maximum specified. For example, if the maximum is set to 100 and only 3 alternatives are
found, only those 3 are shown.

Decision List Model Nugget

A model consists of a list of segments, each of which is defined by a rule that selects matching
records. You can easily view or modify the segments before generating the model and choose
which ones to include or exclude. When used in scoring, Decision List models return Yes for
included segments and $null$ for everything else, including the remainder. This direct control
over scoring makes Decision List models ideal for generating mailing lists, and they are widely
used in customer relationship management, including call center or marketing applications.

Figure 9-8
Decision List model nugget
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When you run a stream containing a Decision List model, the node adds three new fields

containing the score, either / (meaning Yes) for included fields or $null$ for excluded fields,

the probability (hit rate) for the segment within which the record falls, and the ID number for

the segment. The names of the new fields are derived from the name of the output field being

predicted, prefixed with $D- for the score, $DP- for the probability, and $DI- for the segment ID.
The model is scored based on the target value specified when the model was built. You can

manually exclude segments so that they score as $null$. For example, if you run a low probability

search to find segments with lower than average hit rates, these “low” segments will be scored as

Yes unless you manually exclude them. If necessary, nulls can be recoded as No using a Derive

or Filler node.

PMML

A Decision List model can be stored as a PMML RuleSetModel with a “first hit” selection
criterion. However, all of the rules are expected to have the same score. To allow for changes to
the target field or the target value, multiple rule set models can be stored in one file to be applied in
order, cases not matched by the first model being passed to the second, and so on. The algorithm
name DecisionList is used to indicate this non-standard behavior, and only rule set models with
this name are recognized as Decision List models and scored as such.

Decision List Model Nugget Settings

The Settings tab for a Decision List model nugget allows you to obtain propensity scores and to
enable or disable SQL optimization. This tab is available only after adding the model nugget to
a stream.

Calculate raw propensity scores. For models with a flag target (which return a yes or no
prediction), you can request propensity scores that indicate the likelihood of the true outcome
specified for the target field. These are in addition to other prediction and confidence values that
may be generated during scoring.

Calculate adjusted propensity scores. Raw propensity scores are based only on the training data
and may be overly optimistic due to the tendency of many models to overfit this data. Adjusted
propensities attempt to compensate by evaluating model performance against a test or validation
partition. This option requires that a partition field be defined in the stream and adjusted propensity
scores be enabled in the modeling node before generating the model.

Score by converting to native SQL. If selected, generates SQL to score the model natively within
the application.

Decision List Viewer

The easy-to-use, task-based Decision List Viewer graphical interface takes the complexity out of
the model building process, freeing you from the low-level details of data mining techniques and
allowing you to devote your full attention to those parts of the analysis requiring user intervention,
such as setting objectives, choosing target groups, analyzing the results, and selecting the optimal
model.
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Figure 9-9
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Working Model Pane

The working model pane displays the current model, including mining tasks and other actions that
apply to the working model.
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Figure 9-10
Working model pane
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ID. Identifies the sequential segment order. Model segments are calculated, in sequence, according
to their ID number.

Segment Rules. Provides the segment name and defined segment conditions. By default, the
segment name is the field name or concatenated field names used in the conditions, with a comma
as a separator.

Score. Represents the field that you want to predict, whose value is assumed to be related to the
values of other fields (the predictors).

Note: The following options can be toggled to display via the [Organizing Model Measures| dialog.
Cover. The pie chart visually identifies the coverage each segment has in relation to the entire cover.
Cover (n). Lists the coverage for each segment in relation to the entire cover.

Frequency. Lists the number of hits received in relation to the cover. For example, when the cover
is 79 and the frequency is 50, that means that 50 out of 79 responded for the selected segment.

Probability. Indicates the segment probability. For example, when the cover is 79 and the
frequency is 50, that means that the probability for the segment is 63.29% (50 divided by 79).

Error. Indicates the segment error.

The information at the bottom of the pane indicates the cover, frequency, and probability for
the entire model.

Working Model Toolbar
The working model pane provides the following functions via a toolbar.

Note: Some functions are also available by right-clicking a model segment.
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Table 9-1
Working model toolbar buttons

Launches the Generate New Model dialog, which provides options for creating
a new model nugget.

Saves the current state of the interactive session. The Decision List modeling
node is updated with the current settings, including mining tasks, model
snapshots, data selections, and custom measures. To restore a session to this
state, check the Use saved session information box on the Model tab of the
modeling node and click Run.

Displays the Organize Model Measures dialog. For more information, see the
topic [Organizing Model Measures| on p. 230.

Displays the Organize Data Selections dialog. For more information, see the
topic [Organizing Data Selections on p. 224,

Displays the Snapshots tab. For more information, see the topic Snapshots

[Tab on p. R18.

Displays the Alternatives tab. For more information, see the topic [Alternatives

[Tab on p. 216.

Take Snapshot Takes a snapshot of the current model structure. Snapshots display on the
= Snapshots tab and are commonly used for model comparison purposes.

Launches the [[nserting Segments dialog, which provides options for creating
new model segments.

Launches the Editing Segment Rules dialog, which provides options for adding
conditions to model segments or changing previously defined model segment
conditions.

Moves the selected segment up in the model hierarchy.

Moves the selected segment down in the model hierarchy.

Deletes the selected segment.

Toggles whether the selected segment is included in the model. When excluded,
the segment results are added to the remainder. This differs from deleting a
segment in that you have the option of reactivating the segment.

FNEE D i@ﬂﬁﬂ =Sl

Alternatives Tab

Generated when you click Find Segments, the Alternatives tab lists all alternative mining results
for the selected model or segment on the working model pane.

» To promote an alternative to be the working model, highlight the required alternative and click
Load; the alternative model is displayed in the working model pane.

Note: The Alternatives tab is only displayed if you have set Maximum number of alternatives on the
Decision List modeling node Expert tab to create more than one alternative.
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Figure 9-11
Alternatives tab

Decision List
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Each generated model alternative displays specific model information:

Name. Each alternative is sequentially numbered. The first alternative usually contains the best

results.

Target. Indicates the target value. For example: 1, which equals “true”.

No. of Segments. The number of segment rules used in the alternative model.

Cover. The coverage of the alternative model.

Freq. The number of hits in relation to the cover.

Prob. Indicates the probability percentage of the alternative model.

Note: Alternative results are not saved with the model; results are valid only during the active

session.
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Snapshots Tab
A snapshot is a view of a model at a specific point in time. For example, you could take a model
snapshot when you want to load a different alternative model into the working model pane but
do not want to lose the work on the current model. The Snapshots tab lists all model snapshots
manually taken for any number of working model states.
Note: Snapshots are saved with the model. We recommend that you take a snapshot when you
load the first model. This snapshot will then preserve the original model structure, ensuring that
you can always return to the original model state. The generated snapshot name displays as a
timestamp, indicating when it was generated.
Create a Model Snapshot
» Select an appropriate model/alternative to display in the working model pane.
» Make any necessary changes to the working model.
» Click Take Snapshot. A new snapshot is displayed on the Snapshots tab.

Figure 9-12
Snapshots tab
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Name. The snapshot name. You can change a snapshot name by double-clicking the snapshot
name.

Target. Indicates the target value. For example: 1, which equals “true”.
No. of Segments. The number of segment rules used in the model.
Cover. The coverage of the model.

Freq. The number of hits in relation to the cover.

Prob. Indicates the probability percentage of the model.

» To promote a snapshot to be the working model, highlight the required snapshot and click Load;
the snapshot model is displayed in the working model pane.

» You can delete a snapshot by clicking Delete or by right-clicking the snapshot and choosing
Delete from the menu.

Working with Decision List Viewer

A model that will best predict customer response and behavior is built in various stages. When
Decision List Viewer launches, the working model is populated with the defined model segments
and measures, ready for you start a mining task, modify the segments/measures as required,
and generate a new model or modeling node.

You can add one or more segment rules until you have developed a satisfactory model. You can
add segment rules to the model by running mining tasks or by using the Edit Segment Rule function.

In the model building process, you can assess the performance of the model by validating the
model against measure data, by visualizing the model in a chart, or by generating custom Excel
measures.

When you feel certain about the model’s quality, you can generate a new model and place it on
the IBM® SPSS® Modeler canvas or Model palette.

Mining Tasks

A mining task is a collection of parameters that determines the way new rules are generated.
Some of these parameters are selectable to provide you with the flexibility to adapt models to new
situations. A task consists of a task template (type), a target, and a build selection (mining dataset).

The following sections detail the various mining task operations:

®  Running Mining Tasks

B  [Creating and Editing a Mining Task

B Organizing Data Selections
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Running Mining Tasks

>

Decision List Viewer allows you to manually add segment rules to a model by running mining
tasks or by copying and pasting segment rules between models. A mining task holds information
on how to generate new segment rules (the data mining parameter settings, such as the search
strategy, source attributes, search width, confidence level, and so on), the customer behavior to
predict, and the data to investigate. The goal of a mining task is to search for the best possible
segment rules.

To generate a model segment rule by running a mining task:

Click the Remainder row. If there are already segments displayed on the working model pane,
you can also select one of the segments to find additional rules based on the selected segment.
After selecting the remainder or segment, use one of the following methods to generate the model,
or alternative models:

®  From the Tools menu, choose Find Segments.
m  Right-click the Remainder row/segment and choose Find Segments.

m  Click the Find Segments button on the working model pane.

While the task is processing, the progress is displayed at the bottom of the workspace and informs
you when the task has completed. Precisely how long a task takes to complete depends on the
complexity of the mining task and the size of the dataset. If there is only a single model in the
results it is displayed on the working model pane as soon as the task completes; however, where
the results contain more than one model they are displayed on the Alternatives tab.

Note: A task result will either complete with models, complete with no models, or fail.

The process of finding new segment rules can be repeated until no new rules are added to the
model. This means that all significant groups of customers have been found.

It is possible to run a mining task on any existing model segment. If the result of a task is not
what you are looking for, you can choose to start another mining task on the same segment. This
will provide additional found rules based on the selected segment. Segments that are “below” the
selected segment (that is, added to the model later than the selected segment) are replaced by the
new segments because each segment depends on its predecessors.

Creating and Editing a Mining Task

>

A mining task is the mechanism that searches for the collection of rules that make up a data
model. Alongside the search criteria defined in the selected template, a task also defines the
target (the actual question that motivated the analysis, such as how many customers are likely to
respond to a mailing), and it identifies the datasets to be used. The goal of a mining task is to
search for the best possible models.

Create a mining task

To create a mining task:

Select the segment from which you want to mine additional segment conditions.



221

Decision List

» Click Settings. The Create/Edit Mining Task dialog opens. This dialog provides options for

defining the mining task.

» Make any necessary changes and click OK to return to the working model pane. Decision List
Viewer uses the settings as the defaults to run for each task until an alternative task or settings

is selected.

» Click Find Segments to start the mining task on the selected segment.

Edit a mining task

The Create/Edit Mining Task dialog provides options for defining a new mining task or editing

an existing one.

Most parameters available for mining tasks are similar to those offered in the Decision List
node. The exceptions are shown below. For more information, see the topic Decision List

Model Options on p. 209,

Figure 9-13
Create/Edit Mining Task dialog
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Load Settings: When you have created more than one mining task, select the required task.

New... Click to create a new mining task based on the settings of the task currently displayed.

Target

Target Field: Represents the field that you want to predict, whose value is assumed to be related
to the values of other fields (the predictors).

Target value. Specifies the value of the target field that indicates the outcome you want to model.
For example, if the target field churn is coded 0 = no and 1 = yes, specify 1 to identify rules
that indicate which records are likely to churn.

Simple Settings

Maximum number of alternatives. Specifies the number of alternatives that will be displayed upon
running the mining task. The minimum allowed setting is 1; there is no maximum setting.

Expert Settings

Edit... Opens the Edit Advanced Parameters dialog that allows you to define the advanced settings.
For more information, see the topic [Edit Advanced Parameters on p. 222.

Data

Build selection. Provides options for specifying the evaluation measure that Decision List
Viewer should analyze to find new rules. The listed evaluation measures are created/edited in
the Organize Data Selections dialog.

Available fields. Provides options for displaying all fields or manually selecting which fields
to display.

Edit... If the Custom option is selected, this opens the Customize Available Fields dialog that allows
you to select which fields are available as segment attributes found by the mining task. For more
information, see the topic Customize Available Fieldg on p. 223

Edit Advanced Parameters

Figure 9-14
Advanced Parameters
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The Edit Advanced Parameters dialog provides the following configuration options.
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Binning method. The method used for binning continuous fields (equal count or equal width).

Number of bins. The number of bins to create for continuous fields. The minimum allowed setting
is 2; there is no maximum setting.

Model search width. The maximum number of model results per cycle that can be used for the
next cycle. The minimum allowed setting is 1; there is no maximum setting.

Rule search width. The maximum number of rule results per cycle that can be used for the next
cycle. The minimum allowed setting is 1; there is no maximum setting.

Bin merging factor. The minimum amount by which a segment must grow when merged with its
neighbor. The minimum allowed setting is 1.01; there is no maximum setting.

m  Allow missing values in conditions. True to allow the IS MISSING test in rules.

m Discard intermediate results. When True, only the final results of the search process are
returned. A final result is a result that is not refined any further in the search process. When
False, intermediate results are also returned.

Customize Available Fields

Figure 9-15
Customize Available Fields dialog

Customize Available Fields: response[1]

Hirt: Uze this dislog to select which fislds will be available to be used as sttributes in
segments found by this mining task.

Available Mot Available

Field | Field!

& loan_sccounts bz Remove == f age_youngest_child
a marital non_worker_percentans

ﬁ members_in_household
ﬁ months_currert_account
é manths_customer

& numbet _grociucts

& number_transactions
D@ penzion_plan

& rfm_score
& poabibn melloy ewesedocas

-

The Customize Available Fields dialog allows you to select which fields are available as segment
attributes found by the mining task.

Available. Lists the fields that are currently available as segment attributes. To remove fields from
the list, select the appropriate fields and click Remove >>. The selected fields move from the
Available list to the Not Available list.

Not Available. Lists the fields that are not available as segment attributes. To include the fields
in the available list, select the appropriate fields and click << Add. The selected fields move
from the Not Available list to the Available list.
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Organizing Data Selections

>

vV v v Y

By organizing data selections (a mining dataset), you can specify which evaluation measures
Decision List Viewer should analyze to find new rules and select which data selections are used
as the basis for measures.

To organize data selections:
From the Tools menu, choose Organize Data Selections, or right-click a segment and choose the
option. The Organize Data Selections dialog opens.

Figure 9-16
Organize Data Selections dialog

Organize Data Selections

@ Hint: Use this dialog to define and rename the Data Selections which are used as build data
for Mining Tasks and to generate Model Measures.
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Define a custom Data Selection by specifying a Partition and = logical Condition which will be
used to zelect records: fram the Partition.

Custom Data selections may be edited, renamed or deleted.

Note: The Organize Data Selections dialog also allows you to edit or delete existing data
selections.

Click the Add new data selection button. A new data selection entry is added to the existing table.
Click Name and enter an appropriate selection name.
Click Partition and select an appropriate partition type.

Click Condition and select an appropriate condition option. When Specify is selected, the Specify
Selection Condition dialog opens, providing options for defining specific field conditions.
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Figure 9-17
Specify Selection Condition dialog
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Hint: U=e this dislog to define a selection condition. Choose
the sttribute (input field), and operator (such as "IN"Y and one
or more values to complete the condition.
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» Define the appropriate condition and click OK.

The data selections are available from the Build Selection drop-down list in the Create/Edit
Mining Task dialog. The list allows you to select which evaluation measure is used for a particular
mining task.

Segment Rules

You find model segment rules by running a mining task based on a task template. You can
manually add segment rules to a model using the Insert Segment or Edit Segment Rule functions.

If you choose to mine for new segment rules, the results, if any, are displayed on the Viewer
tab of the Interactive List dialog. You can quickly refine your model by selecting one of the
alternative results from the Model Albums dialog and clicking Load. In this way, you can
experiment with differing results until you are ready to build a model that accurately describes
your optimum target group.

Inserting Segments
You can manually add segment rules to a model using the Insert Segment function.

To add a segment rule condition to a model:

» In the Interactive List dialog, select a location where you want to add a new segment. The new
segment will be inserted directly above the selected segment.

» From the Edit menu, choose Insert Segment, or access this selection by right-clicking a segment.

The Insert Segment dialog opens, allowing you to insert new segment rule conditions.

» Click Insert. The Insert Condition dialog opens, allowing you to define the attributes for the
new rule condition.



226

Chapter 9

>

Select a field and an operator from the drop-down lists.

Note: If you select the Not in operator, the selected condition will function as an exclusion
condition and displays in red in the Insert Rule dialog. For example, when the condition region =
‘TOWN' displays in red, it means that TOWN is excluded from the result set.

Enter one or more values or click the Insert Value icon to display the Insert Value dialog. The
dialog allows you to choose a value defined for the selected field. For example, the field married
will provide the values yes and no.

Click OK to return to the Insert Segment dialog. Click OK a second time to add the created
segment to the model.

The new segment will display in the specified model location.

Editing Segment Rules

The Edit Segment Rule functionality allows you to add, change, or delete segment rule conditions.

To change a segment rule condition:

Select the model segment that you want to edit.

From the Edit menu, choose Edit Segment Rule, or right-click on the rule to access this selection.
The Edit Segment Rule dialog opens.

Select the appropriate condition and click Edit.

The Edit Condition dialog opens, allowing you to define the attributes for the selected rule
condition.

Select a field and an operator from the drop-down lists.

Note: If you select the Not in operator, the selected condition will function as an exclusion
condition and displays in red in the Edit Segment Rule dialog. For example, when the condition
region = ' TOWN' displays in red, it means that TOWN is excluded from the result set.

Enter one or more values or click the Insert Value button to display the Insert Value dialog. The
dialog allows you to choose a value defined for the selected field. For example, the field married
will provide the values yes and no.

Click OK to return to the Edit Segment Rule dialog. Click OK a second time to return to the
working model.

The selected segment will display with the updated rule conditions.

Deleting Segment Rule Conditions

>

To delete a segment rule condition:

Select the model segment containing the rule conditions that you want to delete.
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» From the Edit menu, choose Edit Segment Rule, or right-click on the segment to access this
selection.

The Edit Segment Rule dialog opens, allowing you to delete one or more segment rule conditions.
» Select the appropriate rule condition and click Delete.

» Click OK.

Deleting one or more segment rule conditions causes the working model pane to refresh its
measure metrics.

Copying Segments

Decision List Viewer provides you with a convenient way to copy model segments. When you
want to apply a segment from one model to another model, simply copy (or cut) the segment from
one model and paste it into another model. You can also copy a segment from a model displayed
in the Alternative Preview panel and paste it into the model displayed in the working model pane.
These cut, copy, and paste functions use a system clipboard to store or retrieve temporary data.
This means that in the clipboard the conditions and target are copied. The clipboard contents are
not solely reserved to be used in Decision List Viewer but can also be pasted in other applications.
For example, when the clipboard contents are pasted in a text editor, the conditions and target

are pasted in XML-format.

To copy or cut model segments:
» Select the model segment that you want to use in another model.

» From the Edit menu, choose Copy (or Cut), or right-click on the model segment and select
Copy or Cut.

» Open the appropriate model (where the model segment will be pasted).

» Select one of the model segments, and click Paste.

Note: Instead of the Cut, Copy, and Paste commands you can also use the key combinations:
Ctrl+X, Ctrl+C, and Ctrl+V.

The copied (or cut) segment is inserted above the previously selected model segment. The
measures of the pasted segment and segments below are recalculated.

Note: Both models in this procedure must be based on the same underlying model template and
contain the same target, otherwise an error message is displayed.

Alternative Models

Where there is more than one result, the Alternatives tab displays the results of each mining task.
Each result consists of the conditions in the selected data that most closely match the target, as
well as any “good enough” alternatives. The total number of alternatives shown depends on the
search criteria used in the analysis process.
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To view alternative models:

Click on an alternative model on the Alternatives tab. The alternative model segments display, or
replace the current model segments, in the Alternative Preview panel.

To work with an alternative model in the working model pane, select the model and click Load
in the Alternative Preview panel or right-click an alternative name on the Alternatives tab and
choose Load.

Note: Alternative models are not saved when you generate a new model.

Customizing a Model

Data are not static. Customers move, get matried, and change jobs. Products lose market focus
and become obsolete.

Decision List Viewer offers business users the flexibility to adapt models to new situations
easily and quickly. You can change a model by editing, prioritizing, deleting, or inactivating
specific model segments.

Prioritizing Segments

>

>

You can rank model rules in any order you choose. By default, model segments are displayed in
order of priority, the first segment having the highest priority. When you assign a different priority
to one or more of the segments, the model is changed accordingly. You may alter the model as
required by moving segments to a higher or lower priority position.

To prioritize model segments:
Select the model segment to which you want to assign a different priority.

Click one of the two arrow buttons on the working model pane toolbar to move the selected
model segment up or down the list.

After prioritization, all previous assessment results are recalculated and the new values are
displayed.

Deleting Segments

>

To delete one or more segments:

Select a model segment.

» From the Edit menu, choose Delete Segment, or click the delete button on the toolbar of the

working model pane.

The measures are recalculated for the modified model, and the model is changed accordingly.
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Excluding Segments

As you are searching for particular groups, you will probably base business actions on a selection
of the model segments. When deploying a model, you may choose to exclude segments within a
model. Excluded segments are scored as null values. Excluding a segment does not mean the
segment is not used; it means that all records matching this rule are excluded from the mailing
list. The rule is still applied but differently.

To exclude specific model segments:
» Select a segment from the working model pane.

» Click the Toggle Segment Exclusion button on the toolbar of the working model pane. Excluded is
now displayed in the selected Target column of the selected segment.

Note: Unlike deleted segments, excluded segments remain available for reuse in the final model.
Excluded segments affect chart results.

Change Target Value
The Change Target Value dialog allows you to change the target value for the current target field.

Snapshots and session results with a different target value than the Working Model are identified
by changing the table background for that row to yellow. This indicates that snapshot/session
result is outdated.

The Create/Edit Mining Task dialog displays the target value for the current working model. The
target value is not saved with the mining task. It is instead taken from the Working Model value.

When you promote a saved model to the Working Model that has a different target value from
the current working model (for example, by editing an alternative result or editing a copy of a
snapshot), the target value of the saved model is changed to be the same as the working model
(the target value shown in the Working Model pane is not changed). The model metrics are
reevaluated with the new target.

Generate New Model

The Generate New Model dialog provides options for naming the model and selecting where the
new node is created.

Model name. Select Custom to adjust the auto-generated name or to create a unique name for
the node as displayed on the stream canvas.

Create node on. Selecting Canvas places the new model on the working canvas; selecting GM
Palette places the new model on the Models palette; selecting Both places the new model on both
the working canvas and the Models palette.

Include interactive session state. When enabled, the interactive session state is preserved in the
generated model. When you later generate a modeling node from the model, the state is carried
over and used to initialize the interactive session. Regardless of whether the option is selected, the
model itself scores new data identically. When the option is not selected, the model is still able to
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create a build node, but it will be a more generic build node that starts a new interactive session
rather than pick up where the old session left off. If you change the node settings but execute with a
saved state, the settings you have changed are ignored in favor of the settings from the saved state.

Note: The standard metrics are the only metrics that remain with the model. Additional metrics
are preserved with the interactive state. The generated model does not represent the saved
interactive mining task state. Once you launch the Decision List Viewer, it displays the settings
originally made through the Viewer.

For more information, see the topic Regenerating a Modeling Node| in Chapter 3 on p. [64.

Model Assessment

Successful modeling requires the careful assessment of the model before implementation in the
production environment takes place. Decision List Viewer provides a number of statistical and
business measures that can be used to assess the impact of a model in the real world. These
include gains charts and full interoperability with Excel, thus enabling cost/benefit scenarios to be
simulated for assessing the impact of deployment.

You can assess your model in the following ways:

m  Using the predefined statistical and business model measures available in Decision List
Viewer (probability, frequency).

Evaluating measures imported from Microsoft Excel.

Visualizing the model using a gains chart.

Organizing Model Measures

Decision List Viewer provides options for defining the measures that are calculated and displayed
as columns. Each segment can include the default cover, frequency, probability, and error measures
represented as columns. You can also create new measures that will be displayed as columns.

Defining Model Measures

To add a measure to your model or to define an existing measure:

» From the Tools menu, choose Organize Model Measures, or right-click the model to make this

selection. The Organize Model Measures dialog opens.



231

Decision List

Figure 9-18
Organize Model Measures dialog
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» Click the Add new model measure button (to the right of the Show column). A new measure is
displayed in the table.

» Provide a measure name and select an appropriate type, display option, and selection. The Show
column indicates whether the measure will display for the working model. When defining an
existing measure, select an appropriate metric and selection and indicate if the measure will
display for the working model.

» Click OK to return to the Decision List Viewer workspace. If the Show column for the new
measure was checked, the new measure will display for the working model.

Custom Metrics in Excel

For more information, see the topic [Assessment in Excel on p. 232,

Refreshing Measures

In certain cases, it may be necessary to recalculate the model measures, such as when you apply
an existing model to a new set of customers.

To recalculate (refresh) the model measures:

B  From the Edit menu, choose Refresh All Measures.



232

Chapter 9

or
B Press F5.

All measures are recalculated, and the new values are shown for the working model.

Assessment in Excel

Decision List Viewer can be integrated with Microsoft Excel, allowing you to use your own value
calculations and profit formulas directly within the model building process to simulate cost/benefit
scenarios. The link with Excel allows you to export data to Excel, where it can be used to create
presentation charts, calculate custom measures, such as complex profit and ROI measures, and
view them in Decision List Viewer while building the model.

Note: In order for you to work with an Excel spreadsheet, the analytical CRM expert has to define
configuration information for the synchronization of Decision List Viewer with Microsoft Excel.
The configuration is contained in an Excel spreadsheet file and indicates which information is
transferred from Decision List Viewer to Excel, and vice versa.

The following steps are valid only when MS Excel is installed. If Excel is not installed, the
options for synchronizing models with Excel are not displayed.

To synchronize models with MS Excel:

» Open the model, run an interactive session, and choose Organize Model Measures from the Tools
menu.

» Select Yes for the Calculate custom measures in Excel option. The Workbook field activates,
allowing you to select a preconfigured Excel workbook template.

» Click the Connect to Excel button. The Open dialog opens, allowing you to navigate to the
preconfigured template location on your local or network file system.

» Select the appropriate Excel template and click Open. The selected Excel template launches;
use the Windows taskbar (or press Alt-Tab) to navigate back to the Choose Inputs for Custom
Measures dialog.

» Select the appropriate mappings between the metric names defined in the Excel template and the
model metric names and click OK.

Once the link is established, Excel starts with the preconfigured Excel template that displays the
model rules in the spreadsheet. The results calculated in Excel are displayed as new columns in
Decision List Viewer.

Note: Excel metrics do not remain when the model is saved; the metrics are valid only during
the active session. However, you can create snapshots that include Excel metrics. The Excel
metrics saved in the snapshot views are valid only for historical comparison purposes and do not
refresh when reopened. For more information, see the topic Snapshots Tab on p. 218. The Excel
metrics will not display in the snapshots until you reestablish a connection to the Excel template.
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MS Excel Integration Setup

The integration between Decision List Viewer and Microsoft Excel is accomplished through the
use of a preconfigured Excel spreadsheet template. The template consists of three worksheets:

Model Measures. Displays the imported Decision List Viewer measures, the custom Excel
measures, and the calculation totals (defined on the Settings worksheet).

Settings. Provides the variables to generate calculations based on the imported Decision List
Viewer measures and the custom Excel measures.

Configuration. Provides options for specifying which measures are imported from Decision List
Viewer and for defining the custom Excel measures.

WARNING: The structure of the Configuration worksheet is rigidly defined. Do NOT edit any
cells in the green shaded area.

®  Metrics From Model. Indicates which Decision List Viewer metrics are used in the calculations.

m  Metrics To Model. Indicates which Excel-generated metric(s) will be returned to Decision
List Viewer. The Excel-generated metrics display as new measure columns in Decision
List Viewer.

Note: Excel metrics do not remain with the model when you generate a new model; the metrics
are valid only during the active session.

Changing the Model Measures

The following examples explain how to change Model Measures in several ways:
®  Change an existing measure.
B Import an additional standard measure from the model.
m  Export an additional custom measure to the model.
Change an existing measure
» Open the template and select the Configuration worksheet.
» Edit any Name or Description by highlighting and typing over them.

Note that if you want to change a measure—for example, to prompt the user for Probability
instead of Frequency—you only need to change the name and description in Metrics From Model —
this is then displayed in the model and the user can choose the appropriate measure to map.

Import an additional standard measure from the model
» Open the template and select the Configuration worksheet.

» From the menus choose:
Tools > Protection > Unprotect Sheet

» Select cell AS, which is shaded yellow and contains the word End.
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From the menus choose:
Insert > Rows

Type in the Name and Description of the new measure. For example, Error and Error associated
with segment.

In cell C5, enter the formula =COLUMN(‘Model Measures’IN3).
In cell D5, enter the formula =ROW(‘Model Measures’IN3)+1.

These formulae will cause the new measure to be displayed in column N of the Model Measures
worksheet, which is currently empty.

From the menus choose:
Tools > Protection > Protect Sheet

Click OK.
On the Model Measures worksheet, ensure that cell N3 has Error as a title for the new column.
Select all of column N.

From the menus choose:
Format > Cells

By default, all of the cells have a General number category. Click Percentage to change how the
figures are displayed. This helps you check your figures in Excel; in addition, it enables you to
utilize the data in other ways, for example, as an output to a graph.

Click OK.

Save the spreadsheet as an Excel 2003 template, with a unique name and the file extension .x/z.
For ease of locating the new template, we recommend you save it in the preconfigured template
location on your local or network file system.

Export an additional custom measure to the model

Open the template to which you added the Error column in the previous example; select the
Configuration worksheet.

From the menus choose:
Tools > Protection > Unprotect Sheet

Select cell A14, which is shaded yellow and contains the word End.

From the menus choose:
Insert > Rows

Type in the Name and Description of the new measure. For example, Scaled Error and Scaling
applied to error from Excel.

In cell C14, enter the formula =COLUMN(‘Model Measures’!O3).

In cell D14, enter the formula =ROW(‘Model Measures’!O3)+1.
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These formulae specify that the column O will supply the new measure to the model.
Select the Settings worksheet.
In cell A17, enter the description ’- Scaled Error.

In cell B17, enter the scaling factor of 10.

vV v v Vv

On the Model Measures worksheet, enter the description Scaled Error in cell O3 as a title for
the new column.

v

In cell O4, enter the formula =N4*Settings!$B$17.
» Select the corner of cell O4 and drag it down to cell O22 to copy the formula into each cell.

» From the menus choose:
Tools > Protection > Protect Sheet

» Click OK.

» Save the spreadsheet as an Excel 2003 template, with a unique name and the file extension .x/r.
For ease of locating the new template, we recommend you save it in the preconfigured template
location on your local or network file system.

When you connect to Excel using this template, the Error value is available as a new custom
measure.

Visualizing Models

The best way to understand the impact of a model is to visualize it. Using a gains chart, you

can obtain valuable day-to-day insight into the business and technical benefit of your model by
studying the effect of multiple alternatives in real time. The section shows the benefit
of a model over randomized decision-making and allows the direct comparison of multiple charts
when there are alternative models.

Gains Chart

The gains chart plots the values in the Gains % column from the table. Gains are defined as the
proportion of hits in each increment relative to the total number of hits in the tree, using the
equation:

(hits in increment / total number of hits) x 100%

Gains charts effectively illustrate how widely you need to cast the net to capture a given
percentage of all of the hits in the tree. The diagonal line plots the expected response for the entire
sample if the model is not used. In this case, the response rate would be constant, since one person
is just as likely to respond as another. To double your yield, you would need to ask twice as many
people. The curved line indicates how much you can improve your response by including only
those who rank in the higher percentiles based on gain. For example, including the top 50% might
net you more than 70% of the positive responses. The steeper the curve, the higher the gain.
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To view a gains chart:

» Open a stream that contains a Decision List node and launch an interactive session from the node.

» Click the Gains tab. Depending on which partitions are specified, you may see one or two charts

(two charts would display, for example, when both the training and testing partitions are defined
for the model measures).

By default, the charts display as segments. You can switch the charts to display as quantiles by
selecting Quantiles and then selecting the appropriate quantile method from the drop-down menu.

Note: See for information on working with graphs.

Chart Options

The Chart Options feature provides options for selecting which models and snapshots are charted,
which partitions are plotted, and whether or not segment labels display.
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Figure 9-20
Chart Options dialog

Chart Options
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Models to Plot

Current Models. Allows you to select which models to chart. You can select the working model or
any created snapshot models.

Partitions to Plot
Partitions for left-hand chart. The drop-down list provides options for displaying all defined
partitions or all data.

Partitions for right-hand chart. The drop-down list provides options for displaying all defined
partitions, all data, or only the left-hand chart. When Graph only left is selected, only the left
chart is displayed.

Display Segment Labels. When enabled, each segment label is displayed on the charts.
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Statistical models use mathematical equations to encode information extracted from the data. In
some cases, statistical modeling techniques can provide adequate models very quickly. Even for
problems in which more flexible machine-learning techniques (such as neural networks) can
ultimately give better results, you can use some statistical models as baseline predictive models to
judge the performance of more advanced techniques.

The following statistical modeling nodes are available.

Linear regression models predict a continuous target based on linear relationships
: between the target and one or more predictors. For more information, see the

topic [Linear models on p. 239.

Logistic regression is a statistical technique for classifying records based on values
|.£ of input fields. It is analogous to linear regression but takes a categorical target field
instead of a numeric range. For more information, see the topic [Logistic Node on p.

259.

The PCA/Factor node provides powerful data-reduction techniques to reduce

g., the complexity of your data. Principal components analysis (PCA) finds linear
combinations of the input fields that do the best job of capturing the variance in the
entire set of fields, where the components are orthogonal (perpendicular) to each
other. Factor analysis attempts to identify underlying factors that explain the pattern
of correlations within a set of observed fields. For both approaches, the goal is to find
a small number of derived fields that effectively summarizes the information in the
original set of fields. For more information, see the topic PCA/Factor Node on p. 277

Discriminant analysis makes more stringent assumptions than logistic regression but
[ can be a valuable alternative or supplement to a logistic regression analysis when
; those assumptions are met. For more information, see the topic Discriminant Node

on p. 285

The Generalized Linear model expands the general linear model so that the dependent
EK variable is linearly related to the factors and covariates through a specified link
function. Moreover, the model allows for the dependent variable to have a non-normal
distribution. It covers the functionality of a wide number of statistical models,
including linear regression, logistic regression, loglinear models for count data, and
interval-censored survival models. For more information, see the topic [GenLin Nod¢|

on p. 294,

A generalized linear mixed model (GLMM) extends the linear model so that the target
can have a non-normal distribution, is linearly related to the factors and covariates via
a specified link function, and so that the observations can be correlated. Generalized
linear mixed models cover a wide variety of models, from simple linear regression to
complex multilevel models for non-normal longitudinal data. For more information,

see the topic GLMM Node| on p. 307.

[E

© Copyright IBM Corporation 1994, 2012. 238
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The Cox regression node enables you to build a survival model for time-to-event data
in the presence of censored records. The model produces a survival function that

(¥ predicts the probability that the event of interest has occurred at a given time (7) for
given values of the input variables. For more information, see the topic
on p. 336
Linear Node

Linear regression is a common statistical technique for classifying records based on the values
of numeric input fields. Linear regression fits a straight line or surface that minimizes the
discrepancies between predicted and actual output values.

Figure 10-1
Simple linear regression graph
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Requirements. Only numeric fields can be used in a linear regression model. You must have
exactly one target field (with the role set to Target) and one or more predictors (with the role set to
Input). Fields with a role of Both or None are ignored, as are non-numeric fields. (If necessary,
non-numeric fields can be recoded using a Derive node. )

Strengths. Linear regression models are relatively simple and give an easily interpreted
mathematical formula for generating predictions. Because linear regression is a long-established
statistical procedure, the properties of these models are well understood. Linear models are also
typically very fast to train. The Linear node provides methods for automatic field selection in
order to eliminate nonsignificant input fields from the equation.

Note: In cases where the target field is categorical rather than a continuous range, such as yes/no
or churn/don’t churn, logistic regression can be used as an alternative. Logistic regression also
provides support for non-numeric inputs, removing the need to recode these fields. For more

information, see the topic [Logistic Node| on p. 259.

Linear models

Linear models predict a continuous target based on linear relationships between the target and
one or more predictors.
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Linear models are relatively simple and give an easily interpreted mathematical formula for
scoring. The properties of these models are well understood and can typically be built very quickly
compared to other model types (such as neural networks or decision trees) on the same dataset.

Example. An insurance company with limited resources to investigate homeowners’ insurance
claims wants to build a model for estimating claims costs. By deploying this model to service
centers, representatives can enter claim information while on the phone with a customer and
immediately obtain the “expected” cost of the claim based on past data.

Figure 10-2
Fields tab
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Field requirements. There must be a Target and at least one Input. By default, fields with
predefined roles of Both or None are not used. The target must be continuous (scale). There are
no measurement level restrictions on predictors (inputs); categorical (flag, nominal, and ordinal)
fields are used as factors in the model and continuous fields are used as covariates.For more
information, see the topic Modeling Node Fields Options in Chapter 3 on p. 35|
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Figure 10-4
Objectives settings
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Description

Crestes a single, standard model to explain relationships betvween fields. Standard models are
easzier to interpret and can be faster to score than boosted, bagged, or large dataset ensembles.

What do you want to do?

Build a new model. Build a completely new model. This is the usual operation of the node.

Continue training an existing model. Training continues with the last model successfully
produced by the node. This makes it possible to update or refresh an existing model without
having to access the original data and may result in significantly faster performance since only
the new or updated records are fed into the stream. Details on the previous model are stored
with the modeling node, making it possible to use this option even if the previous model
nugget is no longer available in the stream or Models palette.

Note: When this option is enabled, all other controls on the Fields and Build Options tabs are
disabled.

What is your main objective?

Create a standard model. The method builds a single model to predict the target using the
predictors. Generally speaking, standard models are easier to interpret and can be faster to
score than boosted, bagged, or large dataset ensembles.

Enhance model accuracy (boosting). The method builds an ensemble model using boosting,
which generates a sequence of models to obtain more accurate predictions. Ensembles can
take longer to build and to score than a standard model.

Boosting produces a succession of “component models”, each of which is built on the entire
dataset. Prior to building each successive component model, the records are weighted based
on the previous component model’s residuals. Cases with large residuals are given relatively
higher analysis weights so that the next component model will focus on predicting these
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records well. Together these component models form an ensemble model. The ensemble
model scores new records using a combining rule; the available rules depend upon the
measurement level of the target.

®  Enhance model stability (bagging). The method builds an ensemble model using bagging
(bootstrap aggregating), which generates multiple models to obtain more reliable predictions.
Ensembles can take longer to build and to score than a standard model.

Bootstrap aggregation (bagging) produces replicates of the training dataset by sampling

with replacement from the original dataset. This creates bootstrap samples of equal size to
the original dataset. Then a “component model” is built on each replicate. Together these
component models form an ensemble model. The ensemble model scores new records using a
combining rule; the available rules depend upon the measurement level of the target.

m  Create a model for very large datasets (requires IBM® SPSS® Modeler Server). The method
builds an ensemble model by splitting the dataset into separate data blocks. Choose this
option if your dataset is too large to build any of the models above, or for incremental model
building. This option can take less time to build, but can take longer to score than a standard
model. This option requires SPSS Modeler Server connectivity.

See Ensembles jon p. 245 for settings related to boosting, bagging, and very large datasets.

Basics

Figure 10-5
Basics settings
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Model Selection datasetz is selected as the objective.

Enzembles po,i 4, Automatic Data Preparation steps include the following:

S
Advanced 4 Date and time handling

4 Adjustment of measurement level
% Qutlier and migzing value handling

4 Supervised merging

Confidence level (%) ma
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Automatically prepare data. This option allows the procedure to internally transform the target and
predictors in order to maximize the predictive power of the model; any transformations are saved

with the model and applied to new data for scoring. The original versions of transformed fields are
excluded from the model. By default, the following automatic data preparation are performed.

m  Date and Time handling. Each date predictor is transformed into new a continuous predictor
containing the elapsed time since a reference date (1970-01-01). Each time predictor is
transformed into a new continuous predictor containing the time elapsed since a reference
time (00:00:00).

®  Adjust measurement level. Continuous predictors with less than 5 distinct values are recast
as ordinal predictors. Ordinal predictors with greater than 10 distinct values are recast
as continuous predictors.

®  Qutlier handling. Values of continuous predictors that lie beyond a cutoff value (3 standard
deviations from the mean) are set to the cutoff value.

m  Missing value handling. Missing values of nominal predictors are replaced with the mode of
the training partition. Missing values of ordinal predictors are replaced with the median of
the training partition. Missing values of continuous predictors are replaced with the mean of
the training partition.

m  Supervised merging. This makes a more parsimonious model by reducing the number of
fields to be processed in association with the target. Similar categories are identified based
upon the relationship between the input and the target. Categories that are not significantly
different (that is, having a p-value greater than 0.1) are merged. If all categories are merged
into one, the original and derived versions of the field are excluded from the model because
they have no value as a predictor.

Confidence level. This is the level of confidence used to compute interval estimates of the model
coefficients in the [Coefficients view. Specify a value greater than O and less than 100. The default
is 95.
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Model Selection

Figure 10-6
Model Selection settings
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Femove effects with p-values greater than: E

[T] Customize maximum number of effects in the final model
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Model selection method. Choose one of the model selection methods (details below) or Include all
predictors, which simply enters all available predictors as main effects model terms. By default,
Forward stepwise is used.

Forward Stepwise Selection. This starts with no effects in the model and adds and removes effects
one step at a time until no more can be added or removed according to the stepwise criteria.

m  Criteria for entry/removal. This is the statistic used to determine whether an effect should be
added to or removed from the model. Information Criterion (AICC) is based on the likelihood
of the training set given the model, and is adjusted to penalize overly complex models. F
Statistics is based on a statistical test of the improvement in model error. Adjusted R-squared is
based on the fit of the training set, and is adjusted to penalize overly complex models. Overfit
Prevention Criterion (ASE) is based on the fit (average squared error, or ASE) of the overfit
prevention set. The overfit prevention set is a random subsample of approximately 30% of the
original dataset that is not used to train the model.

If any criterion other than F Statistics is chosen, then at each step the effect that corresponds to
the greatest positive increase in the criterion is added to the model. Any effects in the model
that correspond to a decrease in the criterion are removed.
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If F Statistics is chosen as the criterion, then at each step the effect that has the smallest
p-value less than the specified threshold, Include effects with p-values less than, is added to the
model. The default is 0.05. Any effects in the model with a p-value greater than the specified
threshold, Remove effects with p-values greater than, are removed. The default is 0.10.

m  Customize maximum number of effects in the final model. By default, all available effects can be
entered into the model. Alternatively, if the stepwise algorithm ends a step with the specified
maximum number of effects, the algorithm stops with the current set of effects.

®  Customize maximum number of steps. The stepwise algorithm stops after a certain number of
steps. By default, this is 3 times the number of available effects. Alternatively, specify a
positive integer maximum number of steps.

Best Subsets Selection. This checks “all possible” models, or at least a larger subset of the possible
models than forward stepwise, to choose the best according to the best subsets criterion. Information
Criterion (AICC) is based on the likelihood of the training set given the model, and is adjusted to
penalize overly complex models. Adjusted R-squared is based on the fit of the training set, and

is adjusted to penalize overly complex models. Overfit Prevention Criterion (ASE) is based on the
fit (average squared error, or ASE) of the overfit prevention set. The overfit prevention set is a
random subsample of approximately 30% of the original dataset that is not used to train the model.

The model with the greatest value of the criterion is chosen as the best model.

Note: Best subsets selection is more computationally intensive than forward stepwise selection.
When best subsets is performed in conjunction with boosting, bagging, or very large datasets, it
can take considerably longer to build than a standard model built using forward stepwise selection.

Ensembles

Figure 10-7
Ensembles settings

Figdz | Build Options || Madel Cptions
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Eoosting and Bagging

Mumber of component madelks for boosting andior bagging: E

These settings determine the behavior of ensembling that occurs when boosting, bagging, or very
large datasets are requested in Objectives. Options that do not apply to the selected objective
are ignored.
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Bagging and Very Large Datasets. When scoring an ensemble, this is the rule used to combine the
predicted values from the base models to compute the ensemble score value.

m  Default combining rule for continuous targets. Ensemble predicted values for continuous targets
can be combined using the mean or median of the predicted values from the base models.

Note that when the objective is to enhance model accuracy, the combining rule selections are
ignored. Boosting always uses a weighted majority vote to score categorical targets and a
weighted median to score continuous targets.

Boosting and Bagging. Specify the number of base models to build when the objective is to
enhance model accuracy or stability; for bagging, this is the number of bootstrap samples. It
should be a positive integer.

Advanced

Figure 10-8
Advanced settings

Figlds | Build Options || Madel Options

Select an tetn:

Ohjectives J Replicate results

Model Selection Random zeed. |54752075

Ensembles

Acvanced

Replicate results. Setting a random seed allows you to replicate analyses. The random number
generator is used to choose which records are in the overfit prevention set. Specify an integer or
click Generate, which will create a pseudo-random integer between 1 and 2147483647, inclusive.
The default is 54752075.
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Model Options

Figure 10-9
Model Options tab

Figlds | Build Options || Model Optians

Model Mame: @ automatic © Custom

-
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options are available.

Model Name. You can generate the model name automatically based on the target fields or specify
a custom name. The automatically generated name is the target field name.

Note that the predicted value is always computed when the model is scored. The name of the new
field is the name of the target field, prefixed with $L-. For example, for a target field named
sales, the new field would be named $L-sales.
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Model Summary

Figure 10-10
Model Summary view

Model Summary

Target Total sales
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The Model Summary view is a snapshot, at-a-glance summary of the model and its fit.

Table. The table identifies some high-level model settings, including:
B The name of the target specified on the [Fields tab,
B Whether automatic data preparation was performed as specified on the [Basics [settings,

B The model selection method and selection criterion specified on the Model Selection settings.
The value of the selection criterion for the final model is also displayed, and is presented
in smaller is better format.

Chart. The chart displays the accuracy of the final model, which is presented in larger is better
format. The value is 100 x the adjusted R? for the final model.
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Automatic Data Preparation

Figure 10-11
Automatic Data Preparation view

Automatic Data Preparation

Target: Total sales

Field Role Actions Taken

Merge categories to maximize

Age category Predictor  osqariation with target

Merge categories to maximize

Primary keyword set Predictor association with target

Predictor Change measurement level from

Promotion continuous to ordinal

Merge categories to maximize

Secondary keyword set Predictor association with target

If the original field name is X, then the transformed field name is
¥_transformed. The original field is excluded from the analysis and the
transformed field is included instead.

This view shows information about which fields were excluded and how transformed fields were
derived in the automatic data preparation (ADP) step. For each field that was transformed or
excluded, the table lists the field name, its role in the analysis, and the action taken by the ADP
step. Fields are sorted by ascending alphabetical order of field names. The possible actions
taken for each field include:

Derive duration: months computes the elapsed time in months from the values in a field
containing dates to the current system date.

Derive duration: hours computes the elapsed time in hours from the values in a field containing
times to the current system time.

Change measurement level from continuous to ordinal recasts continuous fields with less than
5 unique values as ordinal fields.

Change measurement level from ordinal to continuous recasts ordinal fields with more than 10
unique values as continuous fields.

Trim outliers sets values of continuous predictors that lie beyond a cutoff value (3 standard
deviations from the mean) to the cutoff value.

Replace missing values replaces missing values of nominal fields with the mode, ordinal fields
with the median, and continuous fields with the mean.

Merge categories to maximize association with target identifies “similar” predictor categories
based upon the relationship between the input and the target. Categories that are not
significantly different (that is, having a p-value greater than 0.05) are merged.

Exclude constant predictor / after outlier handling / after merging of categories removes predictors
that have a single value, possibly after other ADP actions have been taken.
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Predictor Importance

Figure 10-12
Predictor Importance view

Predictor Importance
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Typically, you will want to focus your modeling efforts on the predictor fields that matter most
and consider dropping or ignoring those that matter least. The predictor importance chart helps
you do this by indicating the relative importance of each predictor in estimating the model. Since
the values are relative, the sum of the values for all predictors on the display is 1.0. Predictor
importance does not relate to model accuracy. It just relates to the importance of each predictor in
making a prediction, not whether or not the prediction is accurate.
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Predicted By Observed

Figure 10-13
Predicted By Observed view

Predicted by Observed
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This displays a binned scatterplot of the predicted values on the vertical axis by the observed
values on the horizontal axis. Ideally, the points should lie on a 45-degree line; this view can tell
you whether any records are predicted particularly badly by the model.
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Residuals

Figure 10-14
Residuals view, histogram style
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The histogram of Studentized residuals compares the distribution of the residuals to a
normal distribution. The smooth line represents the normal distribution. The closer the
frequencies of the residuals are to this line, the closer the distribution of the residuals is to
the normal distribution.

Style: |Histogram =

This displays a diagnostic chart of model residuals.

Chart styles. There are different display styles, which are accessible from the Style dropdown list.

m  Histogram. This is a binned histogram of the studentized residuals with an overlay of the
normal distribution. Linear models assume that the residuals have a normal distribution, so
the histogram should ideally closely approximate the smooth line.

m  P-P Plot. This is a binned probability-probability plot comparing the studentized residuals to
a normal distribution. If the slope of the plotted points is less steep than the normal line,
the residuals show greater variability than a normal distribution; if the slope is steeper, the
residuals show less variability than a normal distribution. If the plotted points have an
S-shaped curve, then the distribution of residuals is skewed.
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Figure 10-15
Outliers view

Outliers

Target: Total sales

Total sales Cook’s Distance
560.04 0.026
5B6.44 0.025
548.99 0.018
5359.63 0.018
4B85.43 0.014
54324 0.014

Statistical Models

This table lists records that exert undue influence upon the model, and displays the record ID (if
specified on the Fields tab), target value, and Cook’s distance. Cook’s distance is a measure of
how much the residuals of all records would change if a particular record were excluded from the
calculation of the model coefficients. A large Cook’s distance indicates that excluding a record
from changes the coefficients substantially, and should therefore be considered influential.

Influential records should be examined carefully to determine whether you can give them less
weight in estimating the model, or truncate the outlying values to some acceptable threshold,

or remove the influential records completely.
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Effects

Figure 10-16
Effects view, diagram style
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This view displays the size of each effect in the model.

Styles. There are different display styles, which are accessible from the Style dropdown list.

Diagram. This is a chart in which effects are sorted from top to bottom by decreasing predictor
importance. Connecting lines in the diagram are weighted based on effect significance, with
greater line width corresponding to more significant effects (smaller p-values). Hovering
over a connecting line reveals a tooltip that shows the p-value and importance of the effect.
This is the default.

Table. This is an ANOVA table for the overall model and the individual model effects. The
individual effects are sorted from top to bottom by decreasing predictor importance. Note that
by default, the table is collapsed to only show the results for the overall model. To see the
results for the individual model effects, click the Corrected Model cell in the table.

Predictor importance. There is a Predictor Importance slider that controls which predictors are
shown in the view. This does not change the model, but simply allows you to focus on the most
important predictors. By default, the top 10 effects are displayed.

Significance. There is a Significance slider that further controls which effects are shown in the
view, beyond those shown based on predictor importance. Effects with significance values greater
than the slider value are hidden. This does not change the model, but simply allows you to focus
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on the most important effects. By default the value is 1.00, so that no effects are filtered based
on significance.

Coefficients

Figure 10-17
Coefficients view, diagram style
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This view displays the value of each coefficient in the model. Note that factors (categorical
predictors) are indicator-coded within the model, so that effects containing factors will generally
have multiple associated coefficients; one for each category except the category corresponding to
the redundant (reference) parameter.
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Styles. There are different display styles, which are accessible from the Style dropdown list.

Diagram. This is a chart which displays the intercept first, and then sorts effects from top to
bottom by decreasing predictor importance. Within effects containing factors, coefficients
are sorted by ascending order of data values. Connecting lines in the diagram are colored
based on the sign of the coefficient (see the diagram key) and weighted based on coefficient
significance, with greater line width corresponding to more significant coefficients (smaller
p-values). Hovering over a connecting line reveals a tooltip that shows the value of the
coefficient, its p-value, and the importance of the effect the parameter is associated with.
This is the default style.

Table. This shows the values, significance tests, and confidence intervals for the individual
model coefficients. After the intercept, the effects are sorted from top to bottom by decreasing
predictor importance. Within effects containing factors, coefficients are sorted by ascending
order of data values. Note that by default the table is collapsed to only show the coefficient,
significance, and importance of each model parameter. To see the standard error, ¢ statistic,
and confidence interval, click the Coefficient cell in the table. Hovering over the name of a
model parameter in the table reveals a tooltip that shows the name of the parameter, the effect
the parameter is associated with, and (for categorical predictors), the value labels associated
with the model parameter. This can be particularly useful to see the new categories created
when automatic data preparation merges similar categories of a categorical predictor.

Predictor importance. There is a Predictor Importance slider that controls which predictors are
shown in the view. This does not change the model, but simply allows you to focus on the most
important predictors. By default, the top 10 effects are displayed.

Significance. There is a Significance slider that further controls which coefficients are shown in
the view, beyond those shown based on predictor importance. Coefficients with significance
values greater than the slider value are hidden. This does not change the model, but simply
allows you to focus on the most important coefficients. By default the value is 1.00, so that no
coefficients are filtered based on significance.
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Estimated Means

Figure 10-18
Estimated Means view
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These are charts displayed for significant predictors. The chart displays the model-estimated value
of the target on the vertical axis for each value of the predictor on the horizontal axis, holding
all other predictors constant. It provides a useful visualization of the effects of each predictor’s

coefficients on the target.

Note: if no predictors are significant, no estimated means are produced.
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Model Building Summary

Figure 10-19
Model Building Summary view, forward stepwise algorithm

Model Building Summary

Target: Total sales
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The model building method is Forward Stepwise using the Information Criterion.
A checkmark means the effect is in the model at this step.

When a model selection algorithm other than None is chosen on the Model Selection settings, this
provides some details of the model building process.

Forward stepwise. When forward stepwise is the selection algorithm, the table displays the last 10
steps in the stepwise algorithm. For each step, the value of the selection criterion and the effects
in the model at that step are shown. This gives you a sense of how much each step contributes

to the model. Each column allows you to sort the rows so that you can more easily see which
effects are in the model at a given step.

Best subsets. When best subsets is the selection algorithm, the table displays the top 10 models.
For each model, the value of the selection criterion and the effects in the model are shown. This
gives you a sense of the stability of the top models; if they tend to have many similar effects
with a few differences, then you can be fairly confident in the “top” model; if they tend to have
very different effects, then some of the effects may be too similar and should be combined (or
one removed). Each column allows you to sort the rows so that you can more easily see which
effects are in the model at a given step.
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Statistical Models

Figure 10-20
Settings tab
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Note that the predicted value is always computed when the model is scored. The name of the new
field is the name of the target field, prefixed with $L-. For example, for a target field named
sales, the new field would be named $L-sales.

Generate SQL for this model. When using data from a database, SQL code can be pushed back to

the database for execution, providing superior performance for many operations.

Score by converting to native SQL. If selected, generates SQL to score the model natively within
the application.

Logistic Node

Logistic regression, also known as nominal regression, is a statistical technique for classifying
records based on values of input fields. It is analogous to linear regression but takes a categorical
target field instead of a numeric one. Both binomial models (for targets with two discrete
categories) and multinomial models (for targets with more than two categories) are supported.

Logistic regression works by building a set of equations that relate the input field values to the
probabilities associated with each of the output field categories. Once the model is generated, it
can be used to estimate probabilities for new data. For each record, a probability of membership is
computed for each possible output category. The target category with the highest probability is
assigned as the predicted output value for that record.

Binomial example. A telecommunications provider is concerned about the number of customers it
is losing to competitors. Using service usage data, you can create a binomial model to predict
which customers are liable to transfer to another provider and customize offers so as to retain

as many customers as possible. A binomial model is used because the target has two distinct
categories (likely to transfer or not).

Note: For binomial models only, string fields must be limited to eight characters. If necessary,
longer strings can be recoded using a Reclassify node.
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Multinomial example. A telecommunications provider has segmented its customer base by service
usage patterns, categorizing the customers into four groups. Using demographic data to predict
group membership, you can create a multinomial model to classify prospective customers into
groups and then customize offers for individual customers.

Requirements. One or more input fields and exactly one categorical target field with two or
more categories. For a binomial model the target must have a measurement level of Flag. For
a multinomial model the target can have a measurement level of Flag, or of Nominal with two
or more categories. Fields set to Both or None are ignored. Fields used in the model must have
their types fully instantiated.

Strengths. Logistic regression models are often quite accurate. They can handle symbolic and
numeric input fields. They can give predicted probabilities for all target categories so that a
second-best guess can easily be identified. Logistic models are most effective when group
membership is a truly categorical field; if group membership is based on values of a continuous
range field (for example, high IQ versus low 1Q), you should consider using linear regression to
take advantage of the richer information offered by the full range of values. Logistic models can
also perform automatic field selection, although other approaches such as tree models or Feature
Selection may do this more quickly on large datasets. Finally, since logistic models are well
understood by many analysts and data miners, they may be used by some as a baseline against
which other modeling techniques can be compared.

When processing large datasets, you can improve performance noticeably by disabling the
likelihood-ratio test, an advanced output option. For more information, see the topic Logistic
Regression Advanced Outpuf on p. 268.

Logistic Node Model Options

Model name. You can generate the model name automatically based on the target or ID field (or
model type in cases where no such field is specified) or specify a custom name.

Use partitioned data. If a partition field is defined, this option ensures that data from only the

training partition is used to build the model.

Create split models. Builds a separate model for each possible value of input fields that are specified
as split fields. For more information, see the topic [Building Split Models in Chapter 3 on p. 30|

Procedure. Specifies whether a binomial or multinomial model is created. The options available in
the dialog box vary depending on which type of modeling procedure is selected.

®  Binomial. Used when the target field is a flag or nominal field with two discrete values
(dichotomous), such as yes/no, on/off, male/female.

®  Multinomial. Used when the target field is a nominal field with more than two values. You can
specify Main effects, Full factorial, or Custom.

Include constant in equation. This option determines whether the resulting equations will include a
constant term. In most situations, you should leave this option selected.
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Figure 10-21
Logistic node, binomial model options
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For binomial models, the following methods and options are available:

Method. Specify the method to be used in building the logistic regression model.

Statistical Models

m  Enter. This is the default method, which enters all of the terms into the equation directly. No

field selection is performed in building the model.

m  Forwards. The Forwards method of field selection builds the model by moving forward step
by step. With this method, the initial model is the simplest model, and only the constant and
terms can be added to the model. At each step, terms not yet in the model are tested based
on how much they would improve the model, and the best of those terms is added to the
model. When no more terms can be added, or the best candidate term does not produce a

large-enough improvement in the model, the final model is generated.

m  Backwards. The Backwards method is essentially the opposite of the Forwards method. With
this method, the initial model contains all of the terms as predictors, and terms can only
be removed from the model. Model terms that contribute little to the model are removed
one by one until no more terms can be removed without significantly worsening the model,

yielding the final model.

Categorical inputs. Lists the fields that are identified as categorical, that is, those with a
measurement level of flag, nominal, or ordinal. You can specify the contrast and base category

for each categorical field.
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m  Field Name. This column contains the field names of the categorical inputs and is prepopulated
with all flag and nominal values in the data. To add continuous or numerical inputs into this
column, click the Add Fields icon to the right of the list and select the required inputs.

m  Contrast. The interpretation of the regression coefficients for a categorical field depends on the
contrasts that are used. The contrast determines how hypothesis tests are set up to compare the
estimated means. For example, if you know that a categorical field has implicit order, such as
a pattern or grouping, you can use the contrast to model that order. The available contrasts are:

Indicator. Contrasts indicate the presence or absence of category membership. This is the
default method.

Simple. Each category of the predictor field, except the reference category, is compared to the
reference category.

Difference. Each category of the predictor field, except the first category, is compared to the
average effect of previous categories. Also known as reverse Helmert contrasts.

Helmert. Each category of the predictor field, except the last category, is compared to the
average effect of subsequent categories.

Repeated. Each category of the predictor field, except the first category, is compared to the
category that precedes it.

Polynomial. Orthogonal polynomial contrasts. Categories are assumed to be equally spaced.
Polynomial contrasts are available for numeric fields only.

Deviation. Each category of the predictor field, except the reference category, is compared
to the overall effect.

m Base Category. Specifies how the reference category is determined for the selected contrast
type. Select First to use the first category for the input field—sorted alphabetically—or select
Last to use the last category. The default value is First.

Note: This field is unavailable if the contrast setting is Difference, Helmert, Repeated, or
Polynomial.

The estimate of each field’s effect on the overall response is computed as an increase or decrease
in the likelihood of each of the other categories relative to the reference category. This can help
you identify the fields and values that are more likely to give a specific response.

The base category is shown in the output as 0.0. This is because comparing it to itself produces an
empty result. All other categories are shown as equations relevant to the base category. For more
information, see the topic [Logistic Nugget Model Details on p. 272,
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Multinomial Models

Figure 10-22
Logistic node, multinomial model options
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For multinomial models the following methods and options are available:

Method. Specify the method to be used in building the logistic regression model.

®m  Enter. This is the default method, which enters all of the terms into the equation directly. No
field selection is performed in building the model.

m  Stepwise. The Stepwise method of field selection builds the equation in steps, as the name
implies. The initial model is the simplest model possible, with no model terms (except the
constant) in the equation. At each step, terms that have not yet been added to the model
are evaluated, and if the best of those terms adds significantly to the predictive power of
the model, it is added. In addition, terms that are currently in the model are reevaluated to
determine if any of them can be removed without significantly detracting from the model.

If so, they are removed. The process repeats, and other terms are added and/or removed.
When no more terms can be added to improve the model, and no more terms can be removed
without detracting from the model, the final model is generated.

m  Forwards. The Forwards method of field selection is similar to the Stepwise method in that the
model is built in steps. However, with this method, the initial model is the simplest model,
and only the constant and terms can be added to the model. At each step, terms not yet in the
model are tested based on how much they would improve the model, and the best of those
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terms is added to the model. When no more terms can be added, or the best candidate term
does not produce a large-enough improvement in the model, the final model is generated.

m  Backwards. The Backwards method is essentially the opposite of the Forwards method. With
this method, the initial model contains all of the terms as predictors, and terms can only
be removed from the model. Model terms that contribute little to the model are removed
one by one until no more terms can be removed without significantly worsening the model,
yielding the final model.

m  Backwards Stepwise. The Backwards Stepwise method is essentially the opposite of the
Stepwise method. With this method, the initial model contains all of the terms as predictors.
At each step, terms in the model are evaluated, and any terms that can be removed without
significantly detracting from the model are removed. In addition, previously removed terms
are reevaluated to determine if the best of those terms adds significantly to the predictive
power of the model. If so, it is added back into the model. When no more terms can be
removed without significantly detracting from the model, and no more terms can be added to
improve the model, the final model is generated.

Note: The automatic methods, including Stepwise, Forwards, and Backwards, are highly adaptable
learning methods and have a strong tendency to overfit the training data. When using these
methods, it is especially important to verify the validity of the resulting model either with new
data or a hold-out test sample created using the Partition node.

Base category for target. Specifies how the reference category is determined. This is used as the
baseline against which the regression equations for all other categories in the target are estimated.
Select First to use the first category for the current target field—sorted alphabetically—or select
Last to use the last category. Alternatively, you can select Specify to choose a specific category and
select the desired value from the list. Available values can be defined for each field in a Type node.

Often you would specify the category in which you are least interested to be the base category, for
example, a loss-leader product. The other categories are then related to this base category in a
relative fashion to identify what makes them more likely to be in their own category. This can
help you identify the fields and values that are more likely to give a specific response.

The base category is shown in the output as 0.0. This is because comparing it to itself produces an
empty result. All other categories are shown as equations relevant to the base category. For more
information, see the topic [Logistic Nugget Model Details on p. 272,

Model type. There are three options for defining the terms in the model. Main Effects models
include only the input fields individually and do not test interactions (multiplicative effects)
between input fields. Full Factorial models include all interactions as well as the input field
main effects. Full factorial models are better able to capture complex relationships but are also
much more difficult to interpret and are more likely to suffer from overfitting. Because of the
potentially large number of possible combinations, automatic field selection methods (methods
other than Enter) are disabled for full factorial models. Custom models include only the terms
(main effects and interactions) that you specify. When selecting this option, use the Model Terms
list to add or remove terms in the model.

Model Terms. When building a Custom model, you will need to explicitly specify the terms in the
model. The list shows the current set of terms for the model. The buttons on the right side of the
Model Terms list allow you to add and remove model terms.
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» To add terms to the model, click the Add new model terms button.

» To delete terms, select the desired terms and click the Delete selected model terms button.

Adding Terms to a Logistic Regression Model

When requesting a custom logistic regression model, you can add terms to the model by clicking
the Add new model terms button on the Logistic Regression Model tab. A new dialog box opens in
which you can specify terms.

Figure 10-23
Logistic Regression New Terms dialog box
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Type of term to add. There are several ways to add terms to the model, based on the selection of
input fields in the Available fields list.

Single interaction. Inserts the term representing the interaction of all selected fields.
Main effects. Inserts one main effect term (the field itself) for each selected input field.

All 2-way interactions. Inserts a 2-way interaction term (the product of the input fields) for
each possible pair of selected input fields. For example, if you have selected input fields A, B,
and C in the Available fields list, this method will insert the terms A * B, A * C, and B * C.

All 3-way interactions. Inserts a 3-way interaction term (the product of the input fields) for
each possible combination of selected input fields, taken three at a time. For example, if you
have selected input fields A, B, C, and D in the Available fields list, this method will insert
theterms A *B *C,A *B*D,A*C *D,and B * C * D.

All 4-way interactions. Inserts a 4-way interaction term (the product of the input fields) for
each possible combination of selected input fields, taken four at a time. For example, if you
have selected input fields A, B, C, D, and E in the Available fields list, this method will insert
theterms A *B*C *D,A*B*C*E,A*B*D*E,A*C*D*E andB *C *D *E.
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Available fields. Lists the available input fields to be used in constructing model terms.

Preview. Shows the terms that will be added to the model if you click Insert, based on the selected
fields and term type.

Insert. Inserts terms in the model (based on the current selection of fields and term type) and
closes the dialog box.

Logistic Node Expert Options

If you have detailed knowledge of logistic regression, expert options allow you to fine-tune the
training process. To access expert options, set Mode to Expert on the Expert tab.

Figure 10-24
Logistic Regression Expert tab
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Scale (Multinomial models only). You can specify a dispersion scaling value that will be used to
correct the estimate of the parameter covariance matrix. Pearson estimates the scaling value by
using the Pearson chi-square statistic. Deviance estimates the scaling value by using the deviance
function (likelihood-ratio chi-square) statistic. You can also specify your own user-defined scaling
value. It must be a positive numeric value.

Append all probabilities. If this option is selected, probabilities for each category of the output field
will be added to each record processed by the node. If this option is not selected, the probability of
only the predicted category is added.

For example, a table containing the results of a multinomial model with three categories will
include five new columns. One column will list the probability of the outcome being correctly
predicted, the next column will show the probability that this prediction is a hit or miss, and a
further three columns will show the probability that each category’s prediction is a miss or hit. For
more information, see the topic [Logistic Model Nuggef on p. 271.
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Note: This option is always selected for binomial models.
Singularity tolerance. Specify the tolerance used in checking for singularities.

Convergence. These options allow you to control the parameters for model convergence. When
you execute the model, the convergence settings control how many times the different parameters
are repeatedly run through to see how well they fit. The more often the parameters are tried,

the closer the results will be (that is, the results will converge). For more information, see the
topic [Logistic Regression Convergence Options on p. 267,

Output. These options allow you to request additional statistics that will be displayed in
the advanced output of the model nugget built by the node. For more information, see the
topic [Logistic Regression Advanced Outpuf on p. 268].

Stepping. These options allow you to control the criteria for adding and removing fields with the
Stepwise, Forwards, Backwards, or Backwards Stepwise estimation methods. (The button is
disabled if the Enter method is selected.) For more information, see the topic [Logistic Regression

Stepping Options on p. 270,

Logistic Regression Convergence Options
You can set the convergence parameters for logistic regression model estimation.

Figure 10-25
Logistic Regression Convergence options
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Maximum iterations. Specify the maximum number of iterations for estimating the model.

Maximum step-halving. Step-halving is a technique used by logistic regression to deal with
complexities in the estimation process. Under normal circumstances, you should use the default
setting.

Log-likelihood convergence. Iterations stop if the relative change in the log-likelihood is less than
this value. The criterion is not used if the value is 0.

Parameter convergence. Iterations stop if the absolute change or relative change in the parameter
estimates is less than this value. The criterion is not used if the value is 0.

Delta (Multinomial models only). You can specify a value between 0 and 1 to be added to each
empty cell (combination of input field and output field values). This can help the estimation
algorithm deal with data where there are many possible combinations of field values relative to the
number of records in the data. The default is 0.
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Logistic Regression Advanced Output

Select the optional output you want to display in the advanced output of the Regression model
nugget. To view the advanced output, browse the model nugget and click the Advanced tab. For
more information, see the topic [Logistic Model Nugget Advanced Outpuf on p. 276.

Binomial Options

Figure 10-26

Logistic Regression, Binomial output options
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Select the types of output to be generated for the model. For more information, see the
topic Logistic Model Nugget Advanced Output on p. 276

Display. Select whether to display the results at each step, or to wait until all steps have been
worked through.

Cl for exp(B). Select the confidence intervals for each coefficient (shown as Beta) in the expression.
Specify the level of the confidence interval (the default is 95%).

Residual Diagnesis. Requests a Casewise Diagnostics table of residuals.

m  Outliers outside (std. dev.). List only residual cases for which the absolute standardized value
of the listed variable is at least as large as the value you specify. The default value is 2.

m  All cases. Include all cases in the Casewise Diagnostic table of residuals.

Note: Because this option lists each of the input records, it may result in an exceptionally large
table in the report, with one line for every record.

Classification cutoff. This allows you to determine the cutpoint for classifying cases. Cases with
predicted values that exceed the classification cutoff are classified as positive, while those with
predicted values smaller than the cutoff are classified as negative. To change the default, enter a
value between 0.01 and 0.99.
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Multinomial Options

Figure 10-27
Logistic Regression, Multinomial output options
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Select the types of output to be generated for the model. For more information, see the
topic [Logistic Model Nugget Advanced Output on p. 276,

Note: Selecting the Likelihood ratio tests option greatly increases the processing time required to
build a logistic regression model. If your model is taking too long to build, consider disabling this
option or utilize the Wald and Score statistics instead. For more information, see the topic [Logistic
Regression Stepping Options| on p. 270,

Iteration history for every. Select the step interval for printing iteration status in the advanced output.

Confidence Interval. The confidence intervals for coefficients in the equations. Specify the level of
the confidence interval (the default is 95%).
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Logistic Regression Stepping Options

Figure 10-28
Logistic Regression Stepping Criteria
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Number of terms in model (Multinomial models only). You can specify the minimum number of
terms in the model for Backwards and Backwards Stepwise models and the maximum number

of terms for Forwards and Stepwise models. If you specify a minimum value greater than 0,

the model will include that many terms, even if some of the terms would have been removed
based on statistical criteria. The minimum setting is ignored for Forwards, Stepwise, and Enter
models. If you specify a maximum, some terms may be omitted from the model, even though they
would have been selected based on statistical criteria. The Specify Maximum setting is ignored for
Backwards, Backwards Stepwise, and Enter models.

Entry criterion (Multinomial models only). Select Score to maximize speed of processing. The
Likelihood Ratio option may provide somewhat more robust estimates but take longer to compute.
The default setting is to use the Score statistic.

Removal criterion. Select Likelihood Ratio for a more robust model. To shorten the time required to
build the model, you can try selecting Wald. However, if you have complete or quasi-complete
separation in the data (which you can determine by using the Advanced tab on the model nugget),
the Wald statistic becomes particularly unreliable and should not be used. The default setting is to
use the likelihood-ratio statistic. For binomial models, there is the additional option Conditional.
This provides removal testing based on the probability of the likelihood-ratio statistic based

on conditional parameter estimates.

Significance thresholds for criteria. This option allows you to specify selection criteria based on the
statistical probability (the p value) associated with each field. Fields will be added to the model
only if the associated p value is smaller than the Entry value and will be removed only if the p
value is larger than the Removal value. The Entry value must be smaller than the Removal value.
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Requirements for entry or removal (Multinomial models only). For some applications, it doesn’t make
mathematical sense to add interaction terms to the model unless the model also contains the
lower-order terms for the fields involved in the interaction term. For example, it may not make
sense to include A * B in the model unless A and B are also included in the model. These options
let you determine how such dependencies are handled during stepwise term selection.

m  Hierarchy for discrete effects. Higher-order effects (interactions involving more fields) will
enter the model only if all lower-order effects (main effects or interactions involving fewer
fields) for the relevant fields are already in the model, and lower-order effects will not
be removed if higher-order effects involving the same fields are in the model. This option
applies only to categorical fields.

m  Hierarchy for all effects. This option works in the same way as the previous option, except
that it applies to all input fields.

m  Containment for all effects. Effects can be included in the model only if all of the effects
contained in the effect are also included in the model. This option is similar to the Hierarchy for
all effects option except that continuous fields are treated somewhat differently. For an effect
to contain another effect, the contained (lower-order) effect must include all of the continuous
fields involved in the containing (higher-order) effect, and the contained effect’s categorical
fields must be a subset of those in the containing effect. For example, if A and B are categorical
fields and X is a continuous field, the term A * B * X contains the terms A * X and B * X.

®  None. No relationships are enforced; terms are added to and removed from the model
independently.

Logistic Model Nugget

A Logistic model nugget represents the equation estimated by a Logistic node. It contains all of
the information captured by the logistic regression model, as well as information about the model
structure and performance. This type of equation may also be generated by other models such
as Oracle SVM.

When you run a stream containing a Logistic model nugget, the node adds two new fields
containing the model’s prediction and the associated probability. The names of the new fields
are derived from the name of the output field being predicted, prefixed with $L- for the predicted
category and $LP- for the associated probability. For example, for an output field named colorpref,
the new fields would be named $L-colorpref and $LP-colorpref. In addition, if you have selected
the Append all probabilities option in the Logistic node, an additional field will be added for each
category of the output field, containing the probability belonging to the corresponding category
for each record. These additional fields are named based on the values of the output field, prefixed
by $LP-. For example, if the legal values of colorpref are Red, Green, and Blue, three new fields
will be added: $LP-Red, $LP-Green, and $LP-Blue.

Generating a Filter node. The Generate menu allows you to create a new Filter node to pass
input fields based on the results of the model. Fields that are dropped from the model due to
multicollinearity will be filtered by the generated node, as well as fields not used in the model.
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Logistic Nugget Model Details

For multinomial models, the Model tab in a Logistic model nugget has a split display with model
equations in the left pane, and predictor importance on the right. For binomial models, the tab
displays predictor importance only. For more information, see the topic Predictor Importance in
Chapter 3 on p. BI.

Model Equations

For multinomial models, the left pane displays the actual equations estimated for the logistic
regression model. There is one equation for each category in the target field, except the baseline
category. The equations are displayed in a tree format. This type of equation may also be
generated by certain other models such as Oracle SVM.

Figure 10-29
Logistic nugget model details with predictor importance displayed
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Equation For. Shows the regression equations used to derive the target category probabilities, given
a set of predictor values. The last category of the target field is considered the baseline category;
the equations shown give the log-odds for the other target categories relative to the baseline
category for a particular set of predictor values. The predicted probability for each category of the
given predictor pattern is derived from these log-odds values.

How Probabilities Are Calculated

Each equation calculates the log-odds for a particular target category, relative to the baseline
category. The log-odds, also called the logit, is the ratio of the probability for the specified target
category to that of the baseline category, with the natural logarithm function applied to the result.
For the baseline category, the odds of the category relative to itself is 1.0, and thus the log-odds is 0.
You can think of this as an implicit equation for the baseline category where all coefficients are 0.

To derive the probability from the log-odds for a particular target category, you take the logit value
calculated by the equation for that category and apply the following formula:

P(group;) = exp(g;) / Zx exp(gk)

where g is the calculated log-odds, i is the category index, and k goes from 1 to the number
of target categories.

Predictor Importance

Optionally, a chart that indicates the relative importance of each predictor in estimating the model
may also be displayed on the Model tab. Typically you will want to focus your modeling efforts
on the predictors that matter most and consider dropping or ignoring those that matter least. Note
this chart is only available if Calculate predictor importance is selected on the Analyze tab before
generating the model. For more information, see the topic [Predictor Importance in Chapter 3

on p. 51.

Note: Predictor importance may take longer to calculate for logistic regression than for other
types of models, and is not selected on the Analyze tab by default. Selecting this option may slow
performance, particularly with large datasets.

Logistic Model Nugget Summary

The summary for a logistic regression model displays the fields and settings used to generate
the model. In addition, if you have executed an Analysis node attached to this modeling node,
information from that analysis will also be displayed in this section. For general information on
using the model browser, see Browsing Model Nuggets on p. 49,
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Figure 10-30
Logistic Regression model nugget Summary tab

U(:ustcat

Mocel | Summary || Advanced | Seftings | Annotations

[8: Collapse AII] [% Expand AII]

o AnElysis o
El-Fields
E"Target
&3 custcat
E|--Inpu‘t3
'f address
:EI ed
'& employ
& resice
E-Build Settings
--Uze partitioned data: false
- Calculste variable importance; true
- Calculste raww propensity scores: false
--Procedure: Muttinomizl
~-Base category:
~-Model type: Main Effects
- Inchude constart in eguation: true
- Made: Expert E

=

Logistic Model Nugget Settings

The Settings tab in a Logistic model nugget specifies options for confidences, probabilities,
propensity scores, and SQL generation during model scoring. This tab is only available after the
model nugget has been added to a stream and displays different options depending on the type
of model and target.

Multinomial Models

For multinomial models, the following options are available:
Calculate confidences. Specifies whether confidences are calculated during scoring.

Calculate raw propensity scores (flag targets only). For models with flag targets only, you can
request raw propensity scores that indicate the likelihood of the true outcome specified for

the target field. These are in addition to standard prediction and confidence values. Adjusted
propensity scores are not available. For more information, see the topic Modeling Node Analyze]

Options in Chapter 3 on p. [39.

Append all probabilities. Specifies whether probabilities for each category of the output field are
added to each record processed by the node. If this option is not selected, the probability of
only the predicted category is added. For a nominal target with three categories, for example,
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the scoring output will include a column for each of the three categories, plus a fourth column
indicating the probability for whichever category is predicted. For example if the probabilities for
categories Red, Green, and Blue are 0.6, 0.3, and 0.1 respectively, the predicted category would
be Red, with a probability of 0.6.

Score by converting to native SQL. If selected, generates SQL to score the model natively within
the application.

Note: For multinomial models, SQL generation unavailable if Append all probabilities has been
selected, or—for models with nominal targets—if Calculate confidences has been selected. SQL
generation with confidence calculations is supported for multinomial models with flag targets
only. SQL generation is not available for binomial models.

Binomial Models

For binomial models, confidences and probabilities are always enabled, and the settings that would
allow you to disable these options are not available. SQL generation is not available for binomial
models. The only setting that can be changed for binomial models is the ability to calculate raw
propensity scores. As noted earlier for multinomial models, this applies to models with flag targets
only. For more information, see the topic Modeling Node Analyze Options in Chapter 3 on p. 39.
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Logistic Model Nugget Advanced Output

Figure 10-31
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The advanced output for logistic regression (also known as nominal regression) gives detailed
information about the estimated model and its performance. Most of the information contained in
the advanced output is quite technical, and extensive knowledge of logistic regression analysis

is required to properly interpret this output.

Warnings. Indicates any warnings or potential problems with the results.

Case processing summary. Lists the number of records processed, broken down by each symbolic

field in the model.

Step summary (optional). Lists the effects added or removed at each step of model creation, when
using automatic field selection.

Note: Only shown for the Stepwise, Forwards, Backwards, or Backwards Stepwise methods.
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Iteration history (optional). Shows the iteration history of parameter estimates for every n iterations
beginning with the initial estimates, where 7 is the value of the print interval. The default is to
print every iteration (n=1).

Model fitting information (Multinomial models). Shows the likelihood-ratio test of your model
(Final) against one in which all of the parameter coefficients are O (Intercept Only).

Classification (optional). Shows the matrix of predicted and actual output field values with
percentages.

Goodness-of-fit chi-square statistics (optional). Shows Pearson’s and likelihood-ratio chi-square
statistics. These statistics test the overall fit of the model to the training data.

Hosmer and Lemeshow goodness-of-fit (optional). Shows the results of grouping cases into deciles
of risk and comparing the observed probability with the expected probability within each decile.
This goodness-of-fit statistic is more robust than the traditional goodness-of-fit statistic used in
multinomial models, particularly for models with continuous covariates and studies with small
sample sizes.

Pseudo R-square (optional). Shows the Cox and Snell, Nagelkerke, and McFadden R-square
measures of model fit. These statistics are in some ways analogous to the R-square statistic
in linear regression.

Monotonicity measures (optional). Shows the number of concordant pairs, discordant pairs, and
tied pairs in the data, as well as the percentage of the total number of pairs that each represents.
The Somers’ D, Goodman and Kruskal’s Gamma, Kendall’s tau-a, and Concordance Index C are
also displayed in this table.

Information criteria (optional). Shows Akaike’s information criterion (AIC) and Schwarz’s
Bayesian information criterion (BIC).

Likelihood ratio tests (optional). Shows statistics testing of whether the coefficients of the mod